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Summary
The use of energy in the world today and in the future is important for
governments and citizens alike due to its central role in everyday life. Without access to affordable and highly concentrated sources of energy much
of today’s economic and innovation progress could be severely affected. As
a result, there are concerns related to the increasing shortage of resources
presently used for meeting the energy demands of the world’s economies. In
addition, CO2 emissions targets are legislated with the goal of reducing the
amount of CO2 and other greenhouse gases emitted. Nevertheless, the world’s
economies require energy to meet the everyday needs of citizens and provide
opportunities for new innovation and economic growth in both western and
developing nations. One of the keys to meeting this challenge is to improve
energy efficiency throughout the industrial infrastructure. This approach has
the combined effect of reducing energy demand as well as CO2 emissions.
The Swiss Federal Office of Energy (SFOE) has estimated that a 30 - 50%
reduction in energy needs of domestic industrial processes can be achieved
through improved efficiency and energy utilization. Better energy efficiency
is a way to the future.
A common method used for improving industrial energy efficiency is pinch
analysis method which is part of the more generalized and broader area of
process integration. It plays a central role in the integrated or holistic approach in process synthesis and design and has been shown to provide significant improvements in the energy utilization of industrial facilities of various
levels of complexity and size. The method is based on a relatively practical
interpretation of the second law of thermodynamics and places a considerable amount of responsibility on the user to fully understand the process they
are trying to optimize. This action in itself provides a strong basis for the
adoption of such a technology as the design engineer speaks in terms of his or
her process on a practical concrete level of understanding. The results from a
pinch analysis study provide the thermodynamically feasible targets for the
industrial process being studied. The method seeks to distinguish between
avoidable and inevitable losses. Therefore, given an optimum economic and
energy trade-off the energy targets encompassing only the inevitable losses
can be calculated. These targets provide a powerful incentive in the design
or retrofitting project phase to ensure the maximum amount of energy is
recovered leading to the minimum amount of required external energy at the
most economic constraint.
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Due to the large amount of information and details that can arise during an
analysis for medium to large processes, a computer based tool is typically
needed to support a pinch analysis study. Today several commercial applications exist; however, one version of a pinch analysis tool was developed in
the Ecole Polytechnique Fédérale de Lausanne (EPFL) in the early 1990’s
(“PinchLENI”, Prof. Dr. Daniel Favrat, Laboratoire d’énergétique industrielle
LENI). This tool has allowed students and engineers to learn and apply the
method in the praxis successfully. PinchLENI has been used successfully over
the years, but the decision was made to upgrade the entire code base to new
technology and include additional new features within the field of process integration that were not developed in the original software. This new software
is called PinCH and is documented in this user manual. PinCH maintains
the user friendliness of its predecessor in allowing the design engineer to easily create the stream table for the process in question followed by targeting
analysis to determine the ∆ Tmin , pinch temperature and associated thermodynamically feasible minimum utility requirements. These targets provide
the basis for the final project stage of heat exchanger network design and
synthesis. The latest version is PinCH 3.2. This version extends upon the
previous releases PinCH by providing new support for the analysis of time
dependent processes requiring thermal heat storage. The software provides a
systematic approach to analyzing such processes to produce a cost effective
and practical conceptual design. In addition, significant enhancements and
support have been added to the direct heat recovery HEN Grid to enable the
user to design cost optimal networks for multiple operating cases or batch
processes. Finally, to help support the user in data extraction of the process heating and cooling requirements, a new Excel based E-Module (Energy
Module) tool has been added.
In conclusion, the PinCH software is a powerful simulation tool focussed on
the optimization of industrial processes as its main goal. The realization of
this goal will allow the continued promotion of the pinch analysis method
enabling progress and leadership in the area of process integration and a
more holistic system design approach to optimizing industrial energy use.
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Chapter 1
Welcome to PinCH
1.1

Introducing PinCH

Welcome to PinCH - a complete solution for energy analysis of industrial
processes. To help promote the use of the pinch analysis method, the software
tool PinCH (CH also stands for the Latin name “Confoederatio Helvetic”, i.e.
Switzerland) was developed, which provides a sound basis for the application
and support of the pinch method and process integration.
 PinCH is sophisticated analysis software that supports process integration studies focussed on the pinch analysis method.
 PinCH is a tool that supports energy optimization analysis for continuous, semi-continuous and batch processes.
 PinCH is a framework for handling multiple scenarios and process structures in targeting calculations.
 PinCH is a dynamic and powerful heat exchanger and storage network
design tool.

See “What Features are in PinCH” for a list of the features included in this
release of PinCH.
For the latest release information, please go to: www.pinch-analyse.ch
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1.2

About This Manual

This manual assumes that you know how to use Microsoft Windows operating
system, Microsoft Excel, a word processor and the computer mouse. For help
on these topics, consult the associated user manual or online help.
Within the PinCH program itself are several ways to execute commands.
Primarily the program is context menu driven based on right clicking the
mouse on specific, context-sensitive, text fields. In addition, there is an online help system as well as a main menu and standard keyboard shortcuts
available on the workbench.
Note: This user manual will be periodically updated. Please check the PinCH
website for the latest version at www.pinch-analyse.ch.

1.3

What Features Are In PinCH

PinCH provides for the following main capabilities effective for energy optimization of industrial processes:
 Analysis of continuous,and semi-continuous processes for direct heat
recovery
 Analysis of batch processes for direct as well as indirect heat recovery
 Optimization of utility systems
 Integration of heat pumps, combined heat and power (CHP) systems,
mechanical vapour recompression units, etc.
 Design of heat exchanger and storage networks

The software also provides some of the following key functionality to support
the optimization:
 Coupling of several processes (Process Management)
 Dynamic degree of freedom analysis stream table capabilities
 Flexible functions for investment and energy costs

1.3 What Features Are In PinCH
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 Technical and economic case studies (Scenario Management)
 Current state analysis of processes and heat exchanger networks
 Graphical design of heat exchanger and storage networks
 Physical property data for refrigerants, water/steam and humid air
systems based on Coolprop
 Comprehensive data import/export capabilities
 Carnot curves for exergy analysis
 E-Modules to support process understanding and data extraction of
common thermal energy unit operations or processes

And much more!
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Chapter 2
Installing And Upgrading PinCH
2.1

PinCH Program Requirements

Please read this section before proceeding with the installation.
PinCH can be installed as a trial version that will run in a limited capacity
for a short trial period. The trial can be upgraded to a fully purchased version
upon request. Please visit our website for the latest pricing information at
www.pinch-analyse.ch. In addition, information on how to obtain PinCH via
a download is available on the website.
System Requirements:
In order to use the PinCH software, the Microsoft.Net Framework 4.5 must
be installed. Administrator rights are needed in order to do so and may
require the assistance of your information technology department to complete
the install. PinCH runs under the following operating systems:
 Windows 7 (32- or 64-bit versions)
 Windows 8 (32- or 64-bit versions)
 Windows 10 (32- or 64-bit versions)

6

2. Installing And Upgrading PinCH

Hardware Requirements:
 Processor: 2.6 GHz Pentium processor or equivalent (Recommended)
 RAM: 4096 MB (Recommended)
 Hard Disk: Up to 50 MB of available space may be required
 Display: 1680 x 1050 high colour, 32-bit (Recommended)
 Internet connection (Software activation)

2.2

PinCH Local Installation

Follow these instructions to install the PinCH program locally as a standalone single seat license.
V

If you are upgrading to a newer version, please see “Upgrading To A
Newer Version”.

V

Please see “Using PinCH 3.2 on a Network” (section 2.4) for information about using PinCH on a network and the separate document
“Network Installation Guide” for details of how to install and configure the network license manager.

PinCH is available in two versions - A free trial and a full purchased version.
Note: Please ensure you have full administrator rights in order to be able to
install the PinCH software. These rights are particularly important for the
versions of the Windows operating system currently supported.
To install PinCH:
1. Login to the machine with administrator rights or as a user with program
installation privileges.
2. Ensure you have obtained the most recent version of PinCH by checking
for latest information on www.pinch-analyse.ch.
3. Unzip the compressed installer file to your computer and double click the
installer file to start the PinCH setup program.

2.2 PinCH Local Installation
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4. Follow the instructions on the screen to complete the installation. Use the
appropriate buttons on each wizard dialog as follows:
a. Licence Agreement: Review the licensing agreement and choose to accept the agreement or not. If accepted, then select Install to begin the
installation.
b. Installing PinCH 3.2: Installation will proceed and the necessary
changes will be completed. Be sure to accept the Windows security
dialog to allow installation to proceed.
c. Installation Complete: Press Finish to close the wizard.
5. After installing PinCH start the program and the Trial/Activation dialog
will appear.
6. Select Continue to begin to use the trial version of PinCH immediately.
7. To purchase a version of PinCH, please go to our website for latest pricing
information at www.pinch-analyse.ch.
8. If you have purchased a version of PinCH 3.2, then you will receive a
Product Key by E-Mail. Select the Activate button and paste a copy of
the Product Key into the entry box and select activate (see Fig. 2.1).
PinCH will automatically activate the license directly and no other action
is required.

8
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Fig. 2.1: Trial / Activation dialog

Note: Please ensure you have access to the internet to allow the automatic
activation to occur as shown in Fig. 2.2. Off-line activation is not supported.

Fig. 2.2: Standalone installation activation

2.3

Upgrading to a Newer Version

Before upgrading PinCH 3.2, back up any project files or custom layout file
that you have created. We recommend that you uninstall any previous version
of PinCH 3.2 that has been installed before upgrading. However, if during
the setup an earlier version is detected then PinCH will automatically remove
the program.
Install the upgrade just as you would a new install as detailed in section

2.4 Using PinCH 3.2 on a Network

9

2.2 “PinCH Local Installation”. The existing valid PinCH 3.2 license will be
recognized and used.

2.4

Using PinCH 3.2 on a Network

PinCH 3.2 can be used in a networked environment as shown in Fig. 2.3.
Your IT department will be responsible to install and configure the network
licenses on a dedicated license server. As a standard user you can simply start
PinCH 3.2 when connected to the local network and the licensing server will
be found automatically if in the same subnet.

Fig. 2.3: Simplified network diagram showing IT components when in same subnet

In the case of having the licensing server on a different subnet as the one
where the PinCH software is installed (e.g. multiple broadcast domains as
often seen in larger companies), the license server can be accessed by setting
the host name (or IP address) of the licensing server in the Sentinel Admin
Control Center that is automatically installed on each client installed version
of PinCH. To configure a PinCH client installation to access a network license
server on another subnet do the following:
 Obtain the license server host name or IP address from your IT department.

10
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 Select the button Activate...
 Enter the host name (License Server Name) or IP address of the LM
server in the text box (See Fig. 2.4).
 Press Activate.

Fig. 2.4: Trial / Activation dialog showing the entry of the License Server name

2.5 Update a Locally Installed Time Period License For Leasing

2.5
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Update a Locally Installed Time Period License For Leasing

When leasing the PinCH software a limited time period license is supplied
for local installations. In order to update the license once the time period has
expired or the decision is made to extend the time period, then the license
can be easily update in the PinCH software itself by doing the following:
 Option 1: If the time period license has expired then restart PinCH and
select Activate button on the Trial / Activation dialog.
 Option 2: If the time period license is still active then select menu item
File -> Settings and then the tab Licensing. Next select the button
Activate / Update License.
 Select the button Request License Update (see Fig. 2.5).
 Send the generated C2V file to pinch@hslu.ch for direct processing by
PinCH management personnel.
 Once you received the V2C license update file save it is a convenient
location on your computer.
 Select the Apply License Update (see Fig. 2.5) button and choose the
saved V2C file.
 Select the Open button to apply the update.

Note: In certain circumstances it may be required to complete the update
externally using a separate remote update service (see PinCH 3.2 Installation
User Manual for more information).

12
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Fig. 2.5: Trial / Activation dialog showing the active Request License Update and
Apply License Update buttons needed to update and active license

2.6

Uninstalling PinCH

Before uninstalling PinCH, back up any project files or the custom layout
file that you have created.
To uninstall PinCH:
1. Login to the machine with administrator rights or as a user with program
installation privileges.
2. From the Windows Start menu, select Control Panel, or choose Settings
and then Control Panel.
3. Select Uninstall a program.
4. In the list of currently installed programs, select PinCH 3.2.
5. Select the Uninstall button.
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Chapter 3
PinCH Guided Tour
3.1

PinCH Processing Steps

In order to begin the guided tour of the PinCH software several important
aspects of a pinch analysis study should be reviewed. The application of the
pinch method is manual in nature; however, it provides a systematic and
structured approach to the difficult problem of overall system design [1]. The
method places a considerable amount of responsibility on the user to fully
understand the process they are focused on optimizing. This in itself provides
a strong benefit as design engineers will develop a greater knowledge of the
process that they are optimizing.
Fig. 3.1 shows the project flow diagram for a typical pinch study in industry
[2]. The flow involves 3 major phases 1) mass and energy balance validation,
2) pinch method calculations and 3) new design change recommendations.
The PinCH software mainly focuses on supporting the second phase involving
targeting and heat exchanger network design calculations. The skills involved
in the first and third steps can only be minimally supported and require the
design engineer to develop the necessary skills in process engineering and unit
operation design through learning and experience.
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Data Analysis

Phase 1

Process Analysis Case
Studies
Energy and Mass
Balance
Data Extraction of
Process Requirements

Process
Data Ok?

Phase 2

Economic
Data

No

Yes
Pinch Calculations
Energy Target Definition

Process
Modification
Boundary
Conditions

No
New Design

Phase 3

(Constraints)
Energy Supply
Optimization

Measures and Costs

Fig. 3.1: Pinch analysis study process

Yes

3.1 PinCH Processing Steps
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However, within the context of the pinch study calculations, ten major processing steps were identified that are typically done and are directly supported
in the PinCH software. They are as follows:
1. Enter Stream Data
2. Configure Equipment
3. Define Processes
4. Apply Scheduling to Processes
5. Set Economic Data
6. Prepare Targeting Calculations
7. Analyze Energy Targets
8. Calculate Energy and Cost Targets
9. Integrate Energy Conversion Units
10. Design Heat Exchanger Networks
Note: On the PinCH menu click on Help > PinCH Process Guide to view
a dynamic diagram of the 10 steps. The first step is clearly focussed on
supporting phase 1 of the pinch study process in order to allow easy inputting
of stream data and process requirements. However, steps 2, 3, 4 and 5 are
unique in that they allow the complete definition of the process(es) from a
static perspective. This definition allows the flexibility to manage different
scenarios and variability studies involved in the pinch analysis calculations.
Steps 6, 7, 8 and 9 allow the configuration of result scenarios used in performing heat integration Targeting calculations. Finally, step 10 encapsulates
the detailed design requirement for the HEN exchanger network based on the
targeting results. The transition from 1 - 10 supports one of the golden rules
of pinch analysis, which is:
Targets Before Design
The structured set of steps and the support given in the PinCH software
eases the challenge of analyzing the many different scenarios possible. Each
of these options requires repeating the targeting and then constructing new
HEN designs. PinCH manages each of these steps through the use of graphical user interface object visualizers. The key features include the ability to
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create complex plant design scenarios for the analysis of single continuous,
multiple base case and single product batch processes. Once standard targeting calculations are complete, detailed heat exchanger network grid diagrams
can be created to produce minimum energy or relaxed designs. Some of these
features will be introduced next.

3.2

Major Graphical Components of PinCH

When you open PinCH the application Workbench will be displayed. Fig. 3.2
shows a calculated result. In order to view these major graphical components
shown please open a project case as follows:
1. Select File > Open Project on the main menu (see Fig. 3.2 point 1).
2. In the Open Project dialog navigate to (install directory) > PinCH >
Tutorials and select the project FourStreamEx2.PinCH.
3. Select to expand the New Target Group node shown in the Target Explorer.
4. Select the Results tree node and right click to bring up the context menu
and select Calculate Target Result with... > Separate Design Tool.
5. Select the check box under Costs in the OC Charts header bar of the
resulting Target Result visualizer.

17

3.2 Major Graphical Components of PinCH

The PinCH workbench should now show the target result calculated for the
given process.
1
4

5

2

6

3
Fig. 3.2: PinCH Workbench and the major graphical components

Referring to Fig. 3.2 the major components included are the following:
1. Main menu bar.
2. Project Explorer - used to define static information related to processes
and their scheduling as well as global economic data.
3. Target Explorer - used to configure and manage the generation of results
that are based on the information supplied in the project explorer.
4. Process Stream Table - data grid used to hold all stream related information derived from the data extraction process and used in calculating the
targets and building HEN designs.
5. Utility Stream Table - data grid to hold all utility stream related information used in designing and optimizing the utility systems for a given
target result.
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6. Target Result Visualizer - used to encapsulate all results related to a
particular targeting calculation. Results include the following for direct
heat recovery analysis for heat exchanger networks:
a. Overall Gantt chart.
b. Batch Gantt chart or Weekly Operating Case (OC) Gantt chart.
c. Composite curves.
d. Grand composite curve.
e. Balanced composite curve.
f. Balanced grand composite curve.
g. Cost curves.
h. Carnot factor curve
i. Split grand composite curve.
j. OC or Time Slice (TS) data grid to view targeting results. Here you
can set the targets for a specific ∆ Tmin and size utilities.
k. OC or TS Selector.
l. Perspectives combo-box selector to change the layout of the charts,
and grids based on the simple workflow of Orientation, Optimizing and
Analyzing.
For indirect heat recovery results the following is included:
a. Indirect Source Sink Profile (ISSP).
b. Required Number of Intermediate Loop/Heat Storages vs. Heat Recovery chart.
c. Payback vs. Heat Recovery chart.
d. Loading/Unloading Thermocline profile.
e. Capacity Limitation Analysis chart.
f. Sources and Sinks Data grid.
g. Intermediate Loop/Heat Storage Energy and Cost savings data grids.
h. Heat Exchanger and Storage Network schema.
An additional base graphical component is the HEN grid as shown in Fig.
3.3.

3.3 Process Types Modeling
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Fig. 3.3: PinCH Workbench showing a HEN Grid

In order to create and view the HEN please do the following:
1. Start the PinCH software.
2. Click with the left mouse button on the number 1 shown by the PinCH
Process Steps (shown immediately below the menu items at the top of
the desktop). This will load a previously prepared demo file.
3. Open the tree view of the Continuous Scenario Group.
4. Right click on the MER HEN Grid 1 and select Show HEN.
The HEN grid for the particular minimum temperature difference will be
displayed. This heat exchanger network design was created by placing heat
exchange matches between the displayed streams to meet the minimum energy requirements defined by the three golden pinch rules. The details of
each of the components are presented in subsequent sections. In addition,
the reader is encouraged to read and learn about the principles of the pinch
method in the several references listed at the end of this document

3.3

Process Types Modeling

Industrial processes are typically distributed and dynamic in nature. As a result, a real world industrial plant often involves several production processes,

20

3. PinCH Guided Tour

possibly operated independently of each other, in one or several buildings or
areas. They can be characterized into continuous as well as batch operation
with various other scheduling opportunities spread between. In addition, even
in cases when only one process is operated, it may feature some changes in
the operating conditions over the year. This could be either due to, for example, changes in climate conditions or changes in the feed being processed and
the corresponding adjustments in the production recipes (e.g. flakes made
from corn or from wheat, different colour of paint, etc.).
PinCH has been designed to allow such real world problem specificities to
be taken into account, and modelled in a basic time scheduled manner. It
provides the user with flexible tools to define these specifications, to decide
which processes must be heat integrated together, and how to integrate them.
The following base process scheduling types are supported in PinCH:

3.3.1

Single Process Continuous
Process P1
Duration of operation DOP1 = ...h/year
0

8'760 h
(1 year)

Fig. 3.4: Diagram illustrating a single continuous process

This is the simplest process type commonly found in industry: constant process conditions of process P1 over the whole duration of operation of the
process DOP1 .
Note that since there is only one process the schedule has no influence other
than duration.

3.3.2

Multiple Processes, Continuous And Synchronous

This case includes two or more synchronous processes, e.g. linked continuous
processes contributing to the production of one or more products. A priori,
the processes are not grouped in a single overall process because typically
they are not close enough to each other in actuality to allow direct heat
integration between the streams of the different processes. As for the case
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Process P1
Duration of operation DOP1 = ...h/year
Process P2
Duration of operation DOP2 = ...h/year
0

8'760 h
(1 year)

Fig. 3.5: Diagram illustrating multiple processes, continuous and synchronous

described for singe continuous, the processes start at an arbitrary time point
of 0 and the schedule has no influence on the result as long as the processes
are synchronous.

3.3.3

Multiple Processes, Continuous, Not Overlapped
Process P1
DOP1 = ...h/year
Process P2
DOP2 = ...h/year
0

8760 h
(1 year)

Fig. 3.6: Diagram illustrating multiple processes, continuous, not overlapped

This case includes two or more continuous processes, not overlapped. The
time difference between the end of P1 and the beginning of P2 may be variable. Therefore, it is assumed that heat integration between P1 and P2 is
either not feasible, or uneconomic. As a consequence, the heat integration of
P1 and P2 may be analysed independently of each other.
However, the above reasoning does not hold anymore, if P1 and P2 are processes organised on a weekly basis (often found in food industry), i.e. P1
operated at the beginning of each week, while P2 would follow during the
second part of the week. In this case:
 heat integration through intermediate heat storage may be possible if
the process pinch of P1 is significantly different from that of P2, and
potentially profitable
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 the base period considered to define the schedule should not be one
year, but one week (to correctly account for the number of heat storage
cycles; an important issue for the profitability), and the user should
then define the number of weeks per year this schedule is repeated

As with the case described previously, this process may also start at 0. The
schedule has no influence on the results as long as the processes are not
overlapped.
Note: If the processes have different periods but are the same processes then
the opportunity to design a heat exchanger network valid for all the operating
cases must be done.

3.3.4

Multiple Processes, Continuous, Overlapped
Process P1
DOP1 = ...h/year
Process P2
DOP2 = ...h/year
OC1
0

DOOC1

OC2
DOOC2

OC3

DOOC3

8'760 h
(1 year)

Fig. 3.7: Diagram illustrating multiple processes, continuous, overlapped

This case includes two or more continuous processes that partially overlap,
which defines the operating cases (here OC1 , OC2 , and OC3 , of duration
DOOC 1 , DOOC 2 , and DOOC 3 , respectively). OC2 introduces (as far as the
heat integration between P1 and P2 is feasible and profitable) a link for
optimization possibilities based on the heat integration of both processes.
The significance of this link depends, among other things, on the duration of
DOOC 2 and the associated improvement of the heat recovery target compared
to that involving only the heat integration of P1 and P2 separately.

3.3.5

Single Process, Multiple Operating Cases

This process type scheduling can consist of several continuous processes following closely after each other sequentially. These types of Multiple Operating cases (MOC) can occur due to season changes that affect operation
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Process P1a

Process P1b
DOOC2

DOOC1
OC1
0

Process P1c

OC2

DOOC3
OC3
8'760 h
(1 year)

Fig. 3.8: Diagram illustrating a single continuous process with multiple operating
cases

even though the process is the same product. It is assumed that heat integration between P1a, P1b and P1c is either not feasible, or uneconomic. As a
consequence, the heat integration of P1a, P1b and P1c may be analysed independently of each other. However, the design goal is to find a single overall
heat exchanger network design flexible enough to handle the changing heating and cooling requirements between P1a, P1b and P1c. Investment cost
must be kept low by reusing common heat exchangers in each of the operating cases created by P1a, P1b and P1c. Combined supertargeting techniques
are used to find the required area and cost for such multiple operating cases
(MOC).
However, the above reasoning does not hold if P1a, P1b and P1c are processes
organised on a weekly basis (often found in food industry), i.e. P1a operates
at the beginning of each week, P1b operates during the middle of each week
and P1c operates at the end of each week. In this case:
 heat integration through intermediate heat storage may be possible if
the process pinch of P1a is significantly different from that of P1b and
P1c, and is also potentially profitable
 the base period considered to define the schedule should not be one year,
but one week (to correctly take the number of heat storage cycles into
account – an important issue for the profitability), and the user should
then define the number of weeks per year this schedule is repeated

Note: Indirect heat integration capabilities based on heat storage are available in PinCH by simply modelling semi-continuous streams (e.g. chiller
waste heat on a daily basis) as batch streams (see section 3.3.6).
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Batch P1a

Batch P1b
DOOC2

DOOC1
OC1

Batch P1c

OC2

DOOC3
OC3

0

8'760 h
(1 year)

Fig. 3.9: Diagram illustrating a sequential batch process

3.3.6

Single Process, Batch

This type of process consists of several batch processes following sequentially
after each other. Direct heat integration between the batches P1a, P1b and
P1c is not feasible. However, indirect heat integration would be a possible
means to exchange energy between the time slices of each batch. In this case:
 heat integration through intermediate heat storage may be possible if
the process pinch of P1a is significantly different from that of P1b and
P1c, and is also potentially profitable
 the base period considered to define the schedule should not be one year,
but one week (to correctly take the number of heat storage cycles into
account – an important issue for the profitability), and the user should
then define the number of weeks per year this schedule is repeated

Note: Indirect heat integration capabilities are fully supported in the PinCH
software using heat storage of batch and semi-continuous streams as covered
in later chapters.
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Chapter 4
Using the Process Stream Table
4.1

Importance of Proper Data Extraction

Data extraction is a very important activity in the overall pinch analysis
project process. This project phase (see Fig. 3.1) involves a large effort to
analyze an industrial process and derive the necessary stream information
needed for a pinch analysis. In this first phase, the engineer is responsible for
analyzing the entire boundary of operation of a given industrial process and
to breakdown the structure into appropriate time and space dimensions. The
assumptions made in organizing the structure is important to ensure an adequate level of modelling complexity is maintained, yet being certain to not
exceed the necessary amount of details for an adequate analysis (i.e. attain
a manageable level but still incorporate the key features for heat integration
studies). As a result, the engineer will typically have to first identify the type
of processes present, their location on the site relative to each other, any limits corresponding to the interfacing of these distinct processes, the range of
products (recipes) and their different production lines (conditions and schedule) and finally include any special side processes (e.g. HVAC). Each of these
process characteristics will generate different target results. More generally,
it is often observed in practice that these characteristics influence the manner
in which the process streams (or process requirements) are identified for use
in the pinch analysis, depending on what can be assumed to be modifiable
and what can not. This process stream analysis is a very challenging aspect
of a pinch analysis, yet it provides immediate benefits even before the pinch
calculations are performed.
Given the importance of data extraction, the PinCH program provides a
convenient data grid component to allow the easy entering or importing of
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stream data and other features to aid the engineer in ensuring the data is
complete and of high quality. The next sections provide details related to
using the functionality available in the Process and Utility Stream Tables
where the core process requirements are entered.

4.2

The Stream Table (Process Requirements)

The Process Stream Table contains the process requirements (stream data)
established during the data extraction phase. In pinch analysis, these requirements are represented through the common definition of Hot Streams to be
cooled down and Cold Streams to be heated up in a system.
It is assumed the physical properties of a stream remain relatively constant
in most circumstances. However, this is not always true (e.g. crude oil or
humid air) and a stream can be divided into one or more segments in order
to provide improved accuracy in calculating the pinch analysis target values.
Each stream and its associated segments are stored along with the specific
parameters such as temperature, pressure, mass flow, etc. in the project file.
These values are read upon opening the project file and displayed as shown
in Fig. 4.1.
This chapter focuses on using the Process Stream and Utility Stream tables
within PinCH and the various functions available to the user when entering
stream data.

4.2 The Stream Table (Process Requirements)
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2 Stream
Row
1
3 Segment
Row

5

Fig. 4.1: Process Stream Table to allow entry of the heating and cooling requirements determined during data gathering and extraction

As shown in Fig. 4.1 the major components included are the following:
1. Main Process Stream Table - A complete listing of streams and segments.
2. Stream Row - A summary of the major parameters associated with the
bulk stream properties.
3. Segment Row - The specific parameters associated with the section of the
stream where either a major change in Cp or a change in phase occurs.
4. Process Stream Table Context Sensitive Menu - The menu listing can be
shown by right clicking on a row in the Process Stream Table. This context
menu is the key entry point to execute commands against the stream table.
The commands are as follows:
a. Add Continuous Process Stream
b. Add Batch Process Stream
c. Add Process Stream Segment
d. Copy Process Stream
e. Remove Process Stream
f. Remove Process Stream Segment
g. Properties
5. Working Stream Table - This table displays the streams assigned to a
particular process grouping (please see section 6).
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In addition to the Process Stream Table, there is also the Utility Stream
Table. This table is similar to the Process Stream table, but contains only
the necessary information to calculate the required mass flowrate of a utility
for a given heat flow. Since each Target Result (see sections 7, 8 and 9)
calculates the required hot and cold duty requirements, only the physical
properties necessary to define the utility are needed. It should be noted a
stream is considered a utility if it supplies or removes energy over a system
boundary, but itself can be replaced easily with another utility stream. In
this case it is not to be considered as part of the process and should be placed
into the Utility Stream Table.
In both the Process Stream Table and Utility Stream Table, the streams
can be shifted upwards or downwards in the data grid. This can be done by
pressing Alt + up/down Arrows to reposition the streams accordingly.

4.3

Defining Streams

The definition of streams and their associated segments consist primarily of
two main types: Simple and Fluid. The most basic yet most important is a
Simple stream, which can be defined in a flexible and direct manner based
on either the streams heat capacity flowrate (CP) or the heat of vaporization/condensation (phase change). Fluid streams are based on internally calculated physical property calculations for water, common refrigerants (e.g.
R134a) and humid air. By simply choosing the required fluid under the Fluid
column (Fig. 4.1), PinCH will automatically calculate the necessary physical
property data and segment the stream according to the phases present [3 4]. The base stream parameters are defined in the following tables for both
the Process and Utility Stream Tables:
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Tab. 4.1: Process Stream Table Properties

Process Stream
Parameters
Name
Hot / Cold

Description

Stream or segment name
Designation if stream or segment is hot or
cold
Tin
Stream or segment starting temperature
Tout
Stream or segment end temperature
ṁ
Stream or segment mass flow rate
Cp
Segment specific heat capacity
Phase Change
Segment heat of vaporization, condensation
or fusion (simple streams only)
α
Segment heat transfer coefficient
p
Absolute stream pressure
CP
Heat capacity flow rate
∆Ḣ
Heat flow of a stream or segment
Fluid
A selection list to choose between simple,
water, refrigerant or humid air stream types
Humidity Ratio In The water content of an air stream at its
inlet conditions
Soft
Designation if a stream or segment can be
included optionally into the targeting
calculation
tStart
Stream existence start time (absolute)
tStop
Stream existence end time (absolute)

Units

°C
°C
kg/s
kJ/kg K
kJ/kg

W/K m2
bar
kW/K
kW

kg H2 O / kg
dry Air

hour
hour
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Tab. 4.2: Utility Stream Table Properties

Utility Stream
parameters
Name
Hot / Cold
Tin
Tout
Cp
Phase Change

Description

Stream or segment name
Designation if stream is hot or cold
The starting temperature of a stream
The ending temperature of a stream
Stream or segment specific heat capacity
Heat of vaporization or condensation
(simple streams only)
α
Heat transfer coefficient
p
Absolute stream pressure
Utility Cost
Specific cost of the utility stream
Fluid
A selection list to choose between simple,
water, refrigerant or humid air
stream types
Humidity Ratio In The water content of an air stream at its
inlet conditions

Units

°C
°C
kJ/kg K
kJ/kg

W/K m2
bar
CHF/kWh

kg H2 O / kg
dry Air

Specifying Streams (Degrees of Freedom):
In order to fully specify a stream to allow calculation of the heat flow necessary in the pinch analysis calculations, not all information must be set. The
Stream Tables automatically check the degrees of freedom to see if enough
information is already available to calculate the remaining energy related
variables ( ṁ, cp , CP, ∆Ḣ). Each stream or segment row is entirely flexible
in the combinations that can be supplied. However, the most common is to
provide the ṁ and the Cp (for sensible heat streams or segments). However,
the heat flow or the CP values can also be directly given.
The ṁ and phase change are most commonly entered for streams or segments that experience a phase change such as condensation or evaporation.
However, the heat flow can be directly entered if known.
Note: An isothermal phase change can be set to be either a hot (i.e. condensing) or cold (i.e. evaporating) stream by simply clicking on the stream
Hot/Cold arrow to manually set the type of phase change. Default is a cold
stream when first setting Tin = Tout.
Specifying Streams (Bubble and Dew Point):

4.4 Configuring Fluid Types
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Fluid streams calculated based on the steam tables (e.g. water) or based on
the equation of state in [4] (e.g. R134a, etc.) can be specified to be exactly
at their boiling or dew points. This specification can be for either the stream
inlet or outlet state and is done by using the common thermodynamic notation for quality (x0 for boiling point and x1 for dew point). To force the
calculation of the bubble or dew point condition, simply enter either of these
values for Tin or Tout . PinCH automatically determines the exact bubble
point temperature or dew point temperature based on the underlying fluid
thermodynamic model as well as the ∆Ḣ based on the given ṁ.
Note: The quality can be specified over the range from x0 to x1 to allow
partially condensed states to be modelled. Also the isothermal phase change
can be set to be either a hot (i.e. condensing) or cold (i.e. evaporating)
stream by simply clicking on the stream Hot/Cold arrow to manually set
the type of phase change.

4.4

Configuring Fluid Types

The Fluid column shown in the Stream Tables allows the user to select a specific component in order to automatically calculate the representative streams
and segments. The following table 4.3 lists the components that are available.
Tab. 4.3: Fluid Types

Fluid Type Name
Water
H2 O

Calculation Basis
Stream properties calculated using
the Steam Tables
Humid Air
Stream properties calculated for
an air stream that
undergoes partial condensation
R134a
1.1.1.2Properties calculated using the
tetrafluoroethane Lee and Kesler [4] equation of state
R404A
R125 / 143a
Properties calculated using the
134a (44/52/4)
Lee and Kesler [4] equation of state
using pseudo mixture properties
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Continuation of table:
Fluid Type Name
R245ca
1.1.2.2.3pentafluoropropane
R245fa
1.1.1.3.3tpentafluoropropane
R407C
R32 / 125
134a (23/25/52)
R410A

R600
R600a
R601
R717
R718
Water
R723

R744
Ethanol
MDM
Toluene

Calculation Basis
Properties calculated using the
Lee and Kesler [4] equation of state
Properties calculated using the
Lee and Kesler [4] equation of state
Properties calculated using the
Lee and Kesler [4] equation of state
using pseudo mixture properties
R32 / 125
Properties calculated using the
(50/50)
Lee and Kesler [4] equation of state
using pseudo mixture properties
N-Butane
Properties calculated using the
Lee and Kesler [4] equation of state
Iso-Butane
Properties calculated using the
Lee and Kesler [4] equation of state
N-Pentane
Properties calculated using the
Lee and Kesler [4] equation of state
NH3 Ammonia
Properties calculated using the
Lee and Kesler [4] equation of state
H2 O
Properties calculated using the
Lee and Kesler [4] equation of state
NH3 DimethylProperties calculated using the
ether (60/40)
Lee and Kesler [4] equation of state
using pseudo mixture properties
CO2
Properties calculated using the
Lee and Kesler [4] equation of state
C2 H6 O
Properties calculated using CoolProp
Fluid Property [18], ORC ECU Only
Octamethyltrisiloxane Properties calculated using CoolProp
Fluid Property [18], ORC ECU Only
C7 H8
Properties calculated using CoolProp
Fluid Property [18], ORC ECU Only

The calculation of the water and refrigerant components are handled internally using the listed calculation procedures.
The humid air partial condensation process is modeled by assuming ideal
conditions. In a first step, the gas is assumed to be cooled completely to the
dew point. A second step divides the remaining temperature range into equal

4.5 Configuring Utility Streams
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segments and calculates the average Cp in each interval for the combined air
and condensate mixture. The segmented stream can be calculated simply by
selecting humid air and setting appropriate pressure and temperature levels.
Note: The mass flow rate of the humid air fluid is calculated and displayed
on a dry basis as is the norm in engineering calculations.

4.5

Configuring Utility Streams

In PinCH, process streams and utility streams are considered separately. A
utility is defined as a stream that is used to provide the necessary energy
requirements for heating and cooling the process being analyzed. Most significantly these are streams that are not necessary for the process to produce
the product. A corollary to this statement is that a utility stream is one that
can be replaced by any other utility stream as it is not part of the process.
A typical site utility is steam that can be used to exchange energy in a
heat exchanger with other process streams. However, steam could be injected
directly into a distillation column to replace the function of a reboiler in
addition to providing additional stripping effects. In this case, the steam is
more commonly considered as a process stream and not a utility.
Definition of utility streams is done on a separate window from the standard
process streams. These streams are characterized by the fact that no mass
flow nor heat flow can be entered (as it is in the Process Stream Table). The
reason is that utility streams belong to a particular target result (see section
7) and the corresponding composite curve. Their heat flow is calculated directly based on the selected ∆ Tmin of the composite curves resulting in the
direct determination of the required mass flow for the given heat capacity or
phase change value. These calculations are handled internally and the user
only needs to supply the state properties of the utilities they require (see Fig.
4.2)
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Fig. 4.2: Utility Stream Table showing multiple utilities (note: the mass flow and
heat flow do not need to be given as they are determined by the targeting
result directly)

4.6

Configuring Soft Streams

The concept of a soft stream relates to the fact that some process streams
often are left on their own to equilibrate with the conditions of the environment. Examples include streams that are sent directly to tanks to cool or
exhaust air vented to atmosphere. However, it may be beneficial to use a portion of such streams for additional energy recovery. Therefore, it is of value
to assess in a process integration study if it is worthwhile to use a portion of
this energy. As a result, the Soft parameter is included with process streams
to allow the ability to easily check for energy integration possibilities with
such soft parts of streams.
Within the target result (see section 7) the part of the stream that is considered hard or soft is taken into consideration in the targeting calculation
where the soft part of the stream is excluded. On the process Stream Table
the selection of the parameter soft only indicates the stream can potentially
be used as a soft stream. The designation of how much of the stream is soft
is done in the target result window (see section 7).

4.7

Importing and Exporting

The importance of being able to import from such spread sheeting software
such as Excel is important for many engineers and technical employees as
they often use such software for storing and calculating process related information. As a result, the Process Stream Table can be imported from a simple
csv formatted file to allow easy insertion into the PinCH Process Stream Table regardless of the source. Given the prevalence of Excel in the marketplace
the following example illustrates how to export and then import to Excel.
Exporting from the Process Stream Table:
1. Select File > Open Project and then open the FourStreamEx1.PinCH
located in the Tutorials directory.

4.7 Importing and Exporting
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2. Select the Process Stream Table tab.
3. Select File > Export Stream Table to show the Export Stream Table
To... dialog.
4. Name and store the Comma Separated Values (csv) format file on to your
desktop.
5. Start Excel and select File > Open.
6. In the Open Dialog, change the file type to All Types.
7. In the Open Dialog, navigate to the desktop and select the saved csv
format file that was exported in step 3.
The Process Stream Table information should now be displayed along with
the headers showing the column names and units. Even though the data has
been saved in a csv format, the saved format can be easily changed using the
File / Save As menu item in Excel.
Note: Fluid streams are exported with only their bulk stream properties. As
a result, any custom entered segment specific properties (e.g. α) will not be
stored if there is more than one segment.
Importing to the Process Stream Table:
In order to import the Process Stream Table into PinCH from Excel, the
same format as seen after exporting will need to be used. Therefore, by
simply exporting the data to see the format, the data can be easily set up in
Excel and then Imported using the following steps.
1. Select File > New Project.
2. Select File > Import Stream Table to show the Please choose a Stream
Table to Import dialog.
3. Ensure the csv file that you wish to import is not open in another program
before proceeding.
4. Navigate to the desktop and select the saved csv that was exported previously.
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The data stored in the csv will be automatically loaded into the Process
Stream Table and ready to be used in completing the pinch analysis calculations.
Note: Importing of stream data from a csv file will be appended to the end
of existing streams already entered into the stream table.
To best understand how the fixed header structure needs to be configured,
it is recommend to simply complete a test export beforehand. By simply
setting up stream examples in PinCH first and exporting them, you will be
able to see the necessary header as well stream/segment structure that is
needed. Afterward, you will be able to manually configure streams in Excel
and import them successfully into the software.
Note: In addition to the stream table data, any assigned processes that the
stream belong to can be exported or imported. In addition, the stream specific
equipment data (equipment name, pre and post processing times) are also
included in the export and import data.
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Chapter 5
E-Modules (Energy Modules)
5.1

Introduction

E-Modules (EMs) were developed in order to facilitate the task of heat integration in energy intensive industrial processes. EMs are Excel based models
of particular processes or unit operations, such as combustion, evaporation
or drying processes. The aim of the modules is to guide the engineer through
the energy analysis and provide an idea of which parameters are required for
energy integration. Once the parameters are known they are compiled into
a stream table within the EM ready to be used in the pinch analysis; this
stream table can then be imported into the PinCH software.
EMs are sophisticated tools that can be used for process modeling and process integration, yet they have been constructed in a manner that is both
easy to use and understand. It should be noted that EMs do not completely
simulate a chosen production process, instead they represent a simplified illustration of the whole technical process in order to help the user generate
and transfer the relevant data to the PinCH software. The predefined EMs
available for users of the PinCH software provide a quick and powerful alternative for modeling and understanding processes and their energy demand
with reasonable accuracy.
In this chapter PinCH users will learn the following:
 where to obtain EMs,
 what are the defining characteristics of EMs,

38

5. E-Modules (Energy Modules)

 how they can use EMs and
 how to use the PinCH Add-In functions for Excel in order to quickly
calculate material properties.

5.1.1

System Requirements

Before starting with EMs it is imperative that the correct programs are installed on your computer. The two programs required to be able to use the
modules are:
1. PinCH version 3.2 or higher
2. Microsoft Excel 2016 or higher
Note: This user manual does not provide direct information on how to use
Microsoft Excel. Only how to use Excel in relation to PinCH E-Modules.

5.2

Obtaining E-Modules

E-Modules (EM) have already been integrated into all PinCH versions 3.2
and greater. For users of PinCH version 3.0 a free upgrade to version 3.2 (or
greater) is available - for instruction on how to upgrade to the latest PinCH
version refer to section 2.3. As older versions of EMs are being updated and
new EMs are being developed on an ongoing basis, both by the PinCH team
and by third parties, it is up to the PinCH user to check what EMs (and
versions) are currently available for use. In this section where to obtain the
latest versions of the EMs and how to download them will be discussed.
Information related to the latest/newest versions of EMs can be found on the
PinCH web site (see http://pinch-analyse.ch). However, the EMs are automatically installed alongside PinCH 3.2 in addition to automatic registering
of the necessary E-Module Excel addin for fluid properties calculations. Nevertheless, newer or adapted versions of E-Modules can be easily incorporated
into the E-Module Explorer as illustrated in Figure 5.1.

5.2 Obtaining E-Modules
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Fig. 5.1: E-Module Explorer

Please do the following to add new or adapted E-modules to the working
E-Module folder:
 Open the E-Module Explorer by selecting View -> E-Modules Explorer
 Right click on the right-hand side data grid (Working E-Module listing)
and select Open Folder
 Copy new or modified E-Modules to the folder

Table 5.1 is a short list of EMs currently available in the latest version of
PinCH. For the most up-to-date information related to E-Modules please
visit the web site.
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Tab. 5.1: Different Processes and their E-Modules

Process

Available
E-Modules
Combustion
Thermal Oxidizer
Evaporation
Batch Evaporation
Continuous Evaporation (single/Multi-stage)
Re-Evaporation
Pool Evaporation
Cold/Heat Treatment Defreezing
Steam Cooker (Batch)
Pasteurization
Reaction
Reaction Tank
Drying
Convection Dryer - Directly Heated, Fresh Air
Convection Dryer - Indirectly Heated, Fresh Air
Parallel flow dryer
Spray Dryer
Cleaning
Scrubber
Solar
Solar Thermal System
Heating
Thermal Vapor recompression

5.3 Getting Started

5.3
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This section describes the most important, core characteristics of EMs, i.e.
those characteristics that are common to all EMs. EMs are designed in a
consistent style. This should support the idea of an easy to understand and
user friendly application. When frequently using the same blocks and symbols there is for sure an advantage given by the ability of remembering and
comparing different processes with each other. The following subsections give
a detailed view of the main elements an EM is built of.

5.3.1

Brief Overview

Figure 5.2 shows the basic design of the EM. The following main elements
should be available in all EMs to give them a standardised structure:
 The header provides general information about modules. It contains a
tracking for changes, a description of the process and explains how calculations should be done. Further, hints for heat integration are given.
More information can be found in section 5.3.4.
 The legend explains the colouring and the symbols. (see section 5.3.2.)
 Processes are represented by a black frame and can contain parameters
which describe the process. (see section 5.3.5).
 Input and output streams of the process, which are linked through the
mass and enthalpy balance over the process (see Appendix A.8.7).
 A stream table which gathers the streams relevant for heat integration. The stream table can be imported directly into PinCH (see section 5.3.6).

Additional information on the different elements of EMs can also be found
in Appendix A.8.
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Fig. 5.2: E-Module Overview

5.3.2

Symbols and Coloring

The symbols and colours used in the EM have been standardised, in order
to assure comprehensibility for the user when switching from one module to
another. Table 5.2 summarizes all the colours and symbols used in the EM.
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Tab. 5.2: Symbols and Coloring Used in PinCH E-Modules

Required
Field

These fields are input values which have to be defined by
the user. Usually the values can be measured, gathered
from the process control system or estimated from the
design values.
Hint: Sometimes it is possible that a value in a green
field is known, but a value in a blue field is missing (for
example when other measurements than the proposed
measurements are available). In this case, use the solver
as described in Appendix A.7
Optional
Predefined values which can, but do not necessarily have
Modification to be modified by the user, if more appropriate values
are available. The same colour is used for names of
streams, which can be changed by the user if desired.
Calculated
Green fields are automatically calculated values, either
Value
used for further calculations or as indication for the user.
Balance
Used to highlight a cell, e.g. a cell that contains a result
Result/Title in the balance box or the title of an information box.
Constant
Constant values that should not be changed.
Product
Represents the flow of the product. This can be a solid
item, a fluid (other than water or air) or a combination
of both. The product is the stream of interest in the
process.
Humid Air
Air with or without a certain content of water vapor
Steam/Water Water in liquid or vapor state.
Heating Only Heat exchanger that adds heat to the stream
Cooling Only Heat exchanger that extracts heat from the stream.
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Heating and Heat exchanger where heating and cooling is possible,
Cooling
depending on the definition of the module/process. In
batch processes this symbol is usually found when
heating and cooling are performed in the same heat
exchanger but at a different time
The red frame indicates that the cell contains a formula
or warning that is not always visible. E.g. the
“Condensation” appears when the temperature of the air
is below dew point temperature. Cells with red
frames should not be overwritten.

5.3.3

Abbreviations

Table 5.3 is a list of the different abbreviations used in the EMs. Theses
abbreviations should also be used when developing your own EMs.
Tab. 5.3: Abbreviations Used in EM

Category
% m/m
% mol
% v/v

1
mass percentage
molar percentage
volume percentage

Category
λ
Comp.
Cp

bar(a)
pressure in bar absolute
°C
temperature
g/kg dry g per kilogram dry matter
(usa. absolute humidity)
h
hour
kg/bat
kilogram per batch
3
kg/Nm density
kg/h
mass flow rate

dry
HHV
LHV

kJ/kg

wet

specific enthalpy

Phi
ppart
Tdew
Tsat

2
excess air coefficient
component
isobaric specific heat capacity
based on dry matter
higher heating value
lower heating value
relative humidity
partial pressure
dew-point pressure
saturation
temperature
(constant pressure)
based on wet matter
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Category
kJ/kgK
kg/s
kW
mol/kg

1 Continued
Category 2
specific heat
–
mass flow rate
(thermal) power
molar composition (e.g.
number of moles/kg fuel)
3
m
operating cubic meters
3
Nm
standard cubic meters
2
W/m K heat transfer cofficient

5.3.4

–

Document Information - Header

The header of each E-Module works as a succinct package insert. Here, all
information should be documented in order to clarify possible upcoming questions of future users. The input mask is designed as seen below.
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Tab. 5.4: E-Module Header
Name
Type
Fields of applicaion
Products
Process overview
Version
printing format
Reference
Process description
Assumptions
Calculation principles
Running the
module
Energy integration
Comments

5.3.5

Short and clear name, used to identify the module in the
database. Avoid long phrases or descriptions
Type of the module: continuous or batch.
Possible industries in which the module could be useful. The
idea is to expand this library continuously
Products that result in the process which the module covers
Short description of the process. The process overview is the
description that is used in database.
Version number of the module. The same number should be
mentioned in the file name.
Paper size and
orientation
All external formulas must be quoted here with a source, so
that the calculations are transparent to the user.
Detailed description of what happens in the equipment and
how. If batch operated, describe the different process stages
Major assumption made due to simplifying the process for the
E-Module are given here.
Gives idea of how the different elements in a module are calculated (important calculation principles explained here).
Guides the user through the module and explains the order the
input values should be entered, how to use implemented macros
and which values must be modified when using the solver.
Hints and common techniques for energy integration in the
specific process.
Any additional comments from the developer.

Standard Blocks and Symbols

The process being modeled in the EM is depicted using the standard blocks.
A standard block is defined as a set of input parameters and calculated
values, usually describing the cooling or heating of a stream. Combined with
the properties library, the standard blocks allow to calculate a wide range of
thermodynamic applications in a short time. Figure 5.3 displays a standard
block as seen in the EM for an evaporation process.
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Fig. 5.3: Standard Block for Evaporation Process

Typical parameters which are contained in the standard blocks are (in brackets: units as used in the EM):
 mass flow [kg/h]
 temperature [°C]
 pressure [bar (a)]
 enthalpy [kJ/kg]
 electrical or thermal power [kW]
 water content [g/kg]

How to work with standard blocks will be discussed in section 5.4. To learn
how to build your own standard blocks refer to Appendix A.8.

5.3.6

Stream Table

A stream table is defined in every module. It contains all hot and cold streams
of the process. The data is represented such that the stream table can be
imported directly into the PinCH software. The majority of the data is automatically copied from the process into the stream table. Figure 5.4 is an
example of the stream table from the Defreezing E-Module, however, the
headings for the stream tables in all the EMs are the same - only the number
of streams and the stream names change. Table 5.5 describes the different
headings found in the stream tables.
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Fig. 5.4: PinCH E-Module Stream Table
Tab. 5.5: Stream Table Heading Description

Heading
Name
Segment
Hot/Cold
Tin
Tout
Flow
Cp
Phase
Change
Alpha
Pressure

Description
Units
The name of the stream.
–
This column is left empty - segmentation of con–
densing streams is automatically done in PinCH.
Defines if the stream is hot or cold.
–
Stream inlet temperature.
°C
Stream outlet temperature.
°C
Mass flow of the stream.
kg/s.
Specific heat of the fluid.
kJ/kgK
Specific heat of the fluid when changing phase.
kJ/kg

Heat transfer coefficient, depends on the fluid.
W/m2 K
Required when other values have to be calculated bar(a)
automatically, i.e. for steam or wet air.
Fluid
“Simple” fluid means that the fluid is defined by
–
cp , temperature and mass flow. Other fluids, such
as “Water” or “HumidAir” will be automatically
completed in PinCH with an internal properties library. See PinCH for further explanations regarding the available fluids.
Humidity Ra- Absolute humidity for humid air – ratio of water kg/kg
tio
to dry air.
TStart
Start time of the stream (for batch processes only).
h
TStop
End time of the stream (for batch processes only).
h
To be used in Tells the user if the stream will be used in the
–
PinCH
stream table that will be exported to PinCH

5.4 Using E-Modules with PinCH

5.4
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In this section how to use E-Modules together with the PinCH software will
be discussed.

5.4.1

Basics

The first step is to open the “EModule Explorer” window. To open the EModule Explorer window:
 Click View on the Menus Toolbar and select EModules Explorer

The explorer window should now appear as seen in Figure 5.1. The most
important features of the EModule Explorer window is 1. the default EMs in
the left-hand side data grid and 2. the working EMs listed in the right-hand
side data grid.
1. E-Modules in Library (Left-hand side): This is a list of all available
EMs suuplied when installing the PinCH software. They are defaults
and are not to be modified.
2. Working E-Modules Library (Right-hand side): This data grid list any
working EMs that have been either copied from the default EMs or are
customized.

5.4.2

Opening and Using E-Modules

Any EM can be opened by simply double clicking on one of the listed EMs
in either the default EM listing or the working EM listing. The EM will open
automatically in Excel to be used side by side with the PinCH software.
Any changes to the EM can be simply done by using the existing standard
Save/Save As functionality within Excel.
Default EMs are not to be editted directly but can be copied and stored in
the working EM grid listing:
1. Right click on a default E-Module listed in the left-hand side data grid.
2. Select the context menu Create local copy
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5.4.3

Saving E-Modules

To save any changes made in the EM copy, simply save the file as you would
a normal Excel file:
1. Left click on the File tab on the ribbon
2. Click Save
Alternatively, left click on the save icon as seen circled in red on 5.5:

Fig. 5.5: Save Icon

5.4.4

Exporting E-Modules Stream Table to PinCH

Once you are satisfied with the information shown in the EM stream table,
the stream table can be exported to PinCH.
To export the EM stream table to PinCH:
1. Create a new Excel file
2. Copy the cells contained within the grey area of the Import Table of
the EM (be sure to include the column headers)
3. Paste the copied cells into the new Excel file (paste values only)
4. Save the file in the csv format (File -> Save as -> Save as type ->
CSV (comma delimited))
5. In PinCH, use File -> Import Stream Table to import the csv file
(ensure you have already created a project)
The EM streams should now be a part of the Process Stream Table and ready
to use in the PinCH project!

5.5 PinCH/E-Module Fluid Calculation Interface

5.5
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PinCH/E-Module Fluid Calculation Interface

As a part of the E-Modules, an calculation interface has been developed
with the purpose of supporting fluid calculations. The interface links Excel
and PinCH via an Excel Add-In. The purpose of the Add-In functions is
to facilitate the calculations of certain values that are required for the EM
process information state.
In this section only how to use the PinCH Add-Ins will be discussed. For a
list of the available functions, the input variables and the output values refer
to Appendix A.7.

5.5.1

Uploading PinCH Add-Ins to Excel

The PinCH Add-Ins should be automatically added to Excel when PinCH
3.2 (or higher) is installed. If this is not the case then the following procedure
should help the user to upload the Add-Ins to Excel.
To Uploading PinCH Add-Ins to Excel 2016
1. Follow the Path:
Start Excel → File → Options → Add-Ins → Go... → Browse → Program
→ Microsoft Office → Office 16 → Library
2. When EModuleAddin is highlighted press enter or click the OK button
The PinCH E-Module Add-In should now be ready for use in the EM!

5.5.2

Using the Add-In Functions

1. In an empty cell within a E-Module enter =pinch
2. From the contextual menu either:
Double click with the left mouse button on the desired function name
or
Use the ↓ and ↑ keys to navigate to the desired function and press the
Tab button
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3. Enter the cell name(s) or click on the cell(s) that contain the input
variable value(s)
or
Enter the input value(s) yourself
or
A combination of cell names and values is also possible
Note: If the function requires more than three inputs then the values
should be separated by a semicolon (the Excel default setting). An
example of a PinCH Add-In function is displayed in Figure 5.6.
Calculated
Value

Input Values
(p;t;x)

=PinCH_PureFluid_h_pt(2.5;115.5;"Water")
Input
Variables

Fig. 5.6: PinCH Add-In Function in Excel

4. Press the enter key
Upon pressing the enter key the calculated value will appear in the cell in
which the Add-In function was entered.
Note: It is very important that you know the units of the input variables and
the calculated values as these are not given in the Excel sheet. For a list of
the different units used in the Add-In functions see Appendix A.7.
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Chapter 6
Configuring the Project
6.1

Introduction

During the data extraction phase (see Chap. 3.1 Fig. 3.1) a structured breakdown of individual processes within an industrial site can be identified. This
structure defines the time and space boundaries as well as any limitations to
interlinking between these boundaries and other constraints. PinCH supports
the configuration and modeling of such structures through the definition of
Processes. Processes contain the assignment of the stream requirements that
are identified to be encapsulated within a single process.
PinCH also allows the definition of equipment. Each stream can be considered
to belong to a piece of equipment that can be taken into consideration when
calculating total investment costs where multiple operating cases or batch
time slices exist (see sections 8 or 9).
Finally, scheduling on a time basis can be done in order to perform studies
such as multiple operating cases analysis. In addition, sets of global economic
data can be defined that will be applied across all groupings of processes.
These sets contain specific power law cost equation parameters for different
heat exchangers as well as general site investment and operational cost parameters. Combined together with the processes as well as the scheduling,
the energy-capital trade-off through heat recovery using a heat exchanger
network can be calculated before any detailed design (see section 7).
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How to Create and Configure Equipment

Equipment items are the locations where the streams actually exist or flow.
They are important for calculating the heat exchanger area that can be
reused between multiple operating cases or batch time slices. The mapping
of streams between multiple operating cases or batch time slices is done by
sharing the equipment. Each stream can be considered to belong to a piece
of equipment that can be taken into consideration when calculating total investment costs ensuring common heat exchanges are properly accounted for
(see sections 8 or 9).
Note: Pieces of Equipment are automatically assigned and stored under the
Individual node on the Project Explorer when a stream is created. A new
piece of equipment is only required when there is a need to share it between
two or more streams.
To Add a New Equipment:
1. Select the Project Explorer.
2. Right click on the Equipment node and select Create New Shared Equipment.
3. Select the newly created equipment listed under the Equipment node and
press F2.
4. Rename the node as required.
5. Select the Properties window to set the parameters for selected equipment.
To Share an Equipment Between Streams:
1. Select a stream in the Process Stream Table.
2. Select the Property window to show the Stream properties.
3. Change the Equipment combo-box value to the desired shared equipment.
4. Repeat steps for a second stream to complete sharing.

6.3 How to Create Processes, Multiple Operating Cases Group and Assign
Streams

6.3
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How to Create Processes, Multiple Operating
Cases Group and Assign Streams

Create a new process by using the PinCH Project Explorer dockable window. The project explorer encapsulates all the necessary functionality used
to define the necessary static information for an industrial site (Fig. 6.1). The
most critical first step is to create the processes defined as subsystems of the
site and then assign streams.

Fig. 6.1: Project Explorer

To create a Process:
1. Select and highlight the Processes node in the Project Explorer.
2. Right click on the Processes node to view the context menu and select
Add Process.
3. Select the newly created process listed under the Processes node and press
F2.
4. Rename the node as required.
To Assign Streams to a Process:
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1. Ensure to first select and highlight a created process listed under the
Processes node (see Fig. 4.1).
2. Select the Process Stream Table tab.
3. Select a stream in the upper Stream Table.
4. Click with the left mouse button on the stream and hold and drag downwards to the working Stream Table.
5. Release the mouse button to assign the stream to the process.
6. Repeat for the number of streams to be assigned to the process.
Note: More than one stream can be selected by simply holding down the
Crtl button and then selecting the streams as required. By simultaneously
pressing the Crtl and Shift button, multiple streams in a single batch can be
selected as commonly done in Windows Explorer.
As reviewed in section 3.3.5 it is possible to configure multiple operating
cases consisting of the same streams, but with different states (e.g. summer/winter). In order to use these streams at different states and therefore,
have a shared equipment, a Multiple Operating Cases (MOC) Group has to
be used. This special type of processes grouping allows for proper calculation
of area targets when using the combined supertargeting tool. In addition, the
group is needed when using the same streams in multiple processes that do
not overlap in time yet need to be assigned to the same Target Group.
To Create a Multiple Operating Cases Group:
1 Create two processes as described above.
2 Create two streams and share them in the same equipment as shown in
section 6.2.
3 Assign the two shared streams - one to each process - as described above.
4 Assign several other non-shared streams to the two processes as described
above.
5 Select and highlight the Processes node in the Project Explorer.
6 Right click on the Processes node to view the context menu and select Add
Multiple Operating Cases Group.

6.4 How to Create and Configure Operating Case Schedules
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7 Select the newly created process listed under the Processes node and press
F2.
8 Rename the node as required.
9 Right click on the newly added MOC Processes Group and select Assign
Processes... and select one of the created processes.
10 Repeat for the second process to complete the assignment of the MOC
processes group.
Note: The processes can be automatically assigned or de-assigned from the
MOC group as required. The assignment is important to ensure that streams
are never allowed to overlap in time, yet still allow the configuration of different operating states of the same process. PinCH automatically performs
the checks as needed and resets the schedule of each process if an overlap in
process times occurs.

6.4

How to Create and Configure Operating Case
Schedules

Schedules are used to configure the time dependency of either continuous or
batch processes. This step is important in ensuring the correct operational
times and the resulting operational costs are calculated.
To create a schedule or sets of schedules, the Operating Cases Schedulings
node within the Project Explorer node can be used. On this dialog are given
the fields to set the time dependent data for configuring either a continuous,
semi-continuous or batch process.
To create a New Operating Case Schedule:
1. Ensure at least one continuous or batch process has be added (see section
6.3).
2. Select and highlight the Operating Cases Schedulings node in the Project
Explorer.
3. Right click on the Operating Cases Schedules node to view the context
menu and select Add Operating Cases Scheduling.
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4. Select the newly created schedule listed under the Operating Cases Schedules node and press F2.
5. Rename the node as required.
6. For continuous processes change the TimeBase combo-box from Cont.
Yearly to Cont. Weekly or Cont. Daily to designate as semi-continuous.
Modify the time parameters as required.
7. For batch processes change the TimeBase combo-box to change between
batch schedules daily, weekly or yearly basis. Modify the time parameters
as required (see section 9.2.2 ).
On the Operating Cases Scheduling visualizer are several data grids and
graphics. The user can enter the configuration data in one data grid for either a continuous/semi-continuous process or in another data grid for batch
processes. In addition, the overall Gantt chart as well as the weekly production campaign chart can be viewed. These charts help the user to graphically
see the data configured in the two data grids to ensure correct data entry. Finally, for batch processes the equipment-wise repeat operation period Gantt
chart is also available to provide a check on the configured batch stream data
(tstart and tstop values). Fig. 6.2 illustrates the operating case scheduling
for multiple continuous processes.
As shown in Figure 6.2 a Continuous Processes data grid is shown that must
be used to configure the necessary scheduling data of each individual process
(refer to section 9.2 for how to schedule a batch process). The data shown in
the continuous scheduling grid are summarized in the following Table 6.1.

6.4 How to Create and Configure Operating Case Schedules

Fig. 6.2: OC Scheduling showing several continuous processes over one year
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Tab. 6.1: Continuous Process Operating Cases Scheduling Data Grid Values Table

Scheduling Grid Description
Units
Values
Process
The name of each process to be scheduled as
defined in the project explorer.
Time Base
The selected type of continuous process either
continuous (Cont. Year) or semi-continuous
(Cont. Weekly or Cont. Daily)
Mo
Monday - Selected day of the week to either
start a continuous process or the day of the
week a semi-continuous process is in operation.
Tu
Tuesday - Selected day of the week to either
start a continuous process or the day of the
week a semi-continuous process is in operation.
We
Wednesday - Selected day of the week to either
start a continuous process or the day of the
week a semi-continuous process is in operation.
Th
Thursday - Selected day of the week to either
start a continuous process or the day of the
week a semi-continuous process is in operation.
Fr
Friday - Selected day of the week to either
start a continuous process or the day of the
week a semi-continuous process is in operation.
Sa
Saturday - Selected day of the week to either
start a continuous process or the day of the
week a semi-continuous process is in operation.
Su
Sunday - Selected day of the week to either
start a continuous process or the day of the
week a semi-continuous process is in operation.
Daytime Start
The actual start time in the selected week
hh:mm
hh:mm
given in hours and minutes of the day.
CW Start
The calendar week in the year on which the
process starts.
No. Weeks
The number of weeks a semi-continuous processes
is in operation (Cont. Weekly or Cont. Daily).
CW Start
The calendar week in the year on which the
process starts.
Duration
Either the yearly duration of single continuous
h
process or the weekly/daily duration of a
semi-continuous process.

6.5 How to Create and Configure Global Economic Data
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Continuation of Tab. 6.1:
Scheduling Grid
Description
Values
Prod. Campaign Start The calculated absolute start time in the year
for the selected process.
Prod. Campaign End The calculated absolute end time in the year
for the selected process.
Gross Op. Time
The calculated time difference between the absolute
start and end time over the year.
Net Op. Time
The actual time in operation of the selected
selected process over the year.

6.5

How to Create and Configure Global Economic
Data

The Project Explorer can also be used to define different versions or sets of
the global economic data as shown in Figure 6.3.
On this entry dialog are given the heat exchanger power law equation parameters for process-process, cold utility-process and hot utility-process stream
matching. In addition, the global energy prices as well as general site wide
operational and investment costs are given. These cost parameters are used
together in deriving the targeting cost result based on the area and number
of units distributions as shown in Appendix A.1.
Note: The default cost base factor Cb shown in Figure 6.3 contains an installation factor of three for each of the heat exchangers shown. The value
is based on standard carbon steel construction typical of the early 1990’s.
Nevertheless, it is always an important task during a pinch analysis to determine relevant cost data for the appropriate time frame and materials of
construction.

Units
h
h
h/a
h/a
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Fig. 6.3: Global Economic Data dialog that centralizes all investment and plant related cost parameters (note: specific utility cost are on the Utility Stream
Table)

How to Create New Global Economic Data:
1. Select and highlight the Economic Data node in the Project Explorer.
2. Right click on the Economic Data node to view the context menu and
select Add Economic Data.
3. Select the newly created economic data listed under the Economic Data
node and press F2.
4. Rename the node as required.
5. Change the parameters as required.
Note: The annuity factor is calculated and updated automatically once a new
Pay off Period or Interest Rate is entered.
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Chapter 7
Analyzing Single Continuous
Processes
7.1

Introduction

Targeting calculations are a central part of a pinch analysis study. The significance of such calculations lies in the fact that a great deal of useful information can be calculated using only the stream based data established in
the data extraction and energy modeling efforts. No detailed design needs to
be completed at this part of the study which allows for rapid iterations in
evaluating heat integration possibilities.
The main goal of the targeting calculations is to establish the optimum cold
and hot utility requirements for a given set of process requirements as established during the data extraction phase (see section 4). In addition, the
area and number of units distribution can also be established. The thermal, economic and time dependence data configured in the project explorer
(see section 6) provide the foundation for these calculations and link the
thermodynamic requirements with the economic realities. The theory and
fundamental equations used in targeting calculations are not covered in the
following sections. However, the user is recommended to review the following
references for more information: [5 - 10].
In the PinCH software, several key application components are used for creating and analyzing targeting results. The first is the Target Group where
specific economic data, schedules, processes and utilities can be selected to
calculate a Target Result. These components provide the basis for creating
scenarios used in the iterative procedure often necessary for determining the
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most relevant target result. The details of these and other components are
presented in the next sections.
Note: The following sections are for a single continuous process. See section
8, 9 and 10 for information related to multiple operating cases and batch
processes.

7.2

How to Create and Configure a Target Group

A new Target Group can be created using the Target Explorer. A Target
Group represents in principle a grouping of scenarios and encapsulates all
the necessary functionality used in configuring and calculating the dynamic
information used in analysis (Fig. 7.1). The first step is to create a grouping
of processes that are to be analyzed within a Target Group. More than one
process can be selected which enables the analysis of processes that exist at
the same time (i.e. zonal targeting assessment) or that for multiple operating
cases (MOC - see section 8).
Note: Streams are not allowed to be added to the same Target Group more
than once and the user will be prevented from doing so automatically!

Fig. 7.1: Target Explorer

7.3 How to Create a Target Result
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To create a Target Group:
1. Select and highlight the BaseCase node in the Target Explorer.
2. Right click on the BaseCase node to view the context menu and select
Add Target Group.
3. Select the newly created Target Group listed under the Processes node
and press F2.
4. Rename the node as required.

7.3

How to Create a Target Result

A Target Result is the central calculation object created when calculating the
energy, area and unit targets used in performing a pinch analysis. However,
as reviewed in section 3, there can exist differences in the time dependent
nature of the underlying process streams that can result in two main result
types - continuous and batch/multiple operating case (MOC). In the following subsections only a single continuous process target result is created.
Please see sections 8 and 9 for information related to multiple operating cases
and batch processes.
Continuous target results consist primarily of a single process or a grouping
of multiple processes that are synchronized in time. All streams exist over
the same time duration resulting in the creation of a single composite curve.
Analysis is straightforward as it is assumed that each stream can potentially
exchange energy with all other streams of the opposite hot or cold designation.
Create a Target Result for a Continuous Process:
1. Create a Target Group.
2. Select and highlight the Target Group node in the Target Explorer.
3. Right click on the Target Group node to view the context menu and select
Reassign Operating Cases Schedule and re-assign a schedule as needed.
4. Right click on the Target Group node to view the context menu and select
Reassign Economic Data and re-assign an economic data as needed.
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5. Right click on the Processes node and select a process to be used in the
analysis. Repeat for any additional processes to be combined together for
the analysis.
6. Right click on the Utilities node and select a default hot and a default
cold utility (see note given below).
7. Right click on the Results node and select Calculate Target Result with...
> Separate Design to create the target result.
8. All the nodes can be renamed after pressing F2.
Note: It is critical to have created at least one hot and one cold stream in
the Utility Stream Table. Please be certain to ensure the respective temperature ranges of these utilities provide enough driving force for the given
process streams. These two utilities will need to be assigned as the default
hot and cold utility in order to allow the internal energy balance to be closed.
This is particularly important in the case of adding multiple utilities used in
optimizing such systems.
After completing the above, a window will be created and anchored on the
workbench with a tab. This window encapsulates the entire targeting result
for the selected tool (in this case the Separate Design Tool) (Fig. 7.2). By
selecting check boxes on the OC Charts header, the composite curve, grand
composite curve, balance composite curve, balanced grand composite curve,
cost curve as well as the Gantt chart can be selected. Each will display
automatically in the upper portion of the window while the specific targeting
result for a given ∆ Tmin is shown and is editable on the OC Data grid at the
bottom of the window. The results for the composite curve (only includes the
default hot and cold utility) and the balanced composite curve (includes the
default hot and cold utility as well as any additional internal sized utilities)
are shown on the Results Panel.
A summary row has been included to show the cumulative sum over all the
OCs or TSs for the area, number of units and all the costs based only on
the default utilities. If internal utilities have been assigned then two rows per
OC or TS are shown to show the difference in targets (CC and BCC). If no
internal utilities are assigned then only the composite curve (CC) result is
shown.
Heat flow values for internal utilities (i.e. non-default) can be entered directly
in a Target Result to show the effect on the composite curves. Typically this
is done to assess the cost effect of using an optimized set of utilities or to
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assess the effect of the existing utilities. See section 7.5 for more information
on how to enter heat flow values for internal utilities.

Fig. 7.2: Continuous process Separate Design tool Target Result

7.4

How to Manage Targeting Results

One of the key advantages of the Targeting Explorer is the flexibility it gives
to compare different Target Results. For any particular Target Group multiple Target Results can be created and then automatically saved under the
particular Target Group tree node. A structure of test cases can be saved
directly and easily used in comparing the results of each to find the best heat
integration option.
Creating Multiple Target Results:
1. Create a Target Result as described in subsection 7.3.
2. Right click on the Results node and select Calculate Target Result
with... > Separate Design to create a second target result.
3. All the nodes can be renamed after pressing F2.
4. Change the ∆ Tmin in the new Target result to a different value.
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5. Repeat for required number of different ∆ Tmin values.
Note: Additional target results can be created when an ECU (see section
Energy Conversion Unit), soft streams or multiple utilities (see section 4) are
included with a particular Target Result.
Comparing Multiple Target Results:
1. Create Multiple Target Results as described earlier.
2. Right click on each of the created target result nodes and select Open
Target Result with Separate Design.
3. Ensure all the target results windows are displayed as tabs in the center
docked position.
4. Left click on one of the target result tabs and hold and drag to reposition.
The dockable window anchor points (circled in red in Figure 7.3) will be
displayed on the workbench.
5. Position the cursor while dragging over the right most anchor point.
6. The target result window will be placed beside the other target results
still in the original center position (see Figure 7.4).
7. Reposition the window edges by clicking with the left button to shift the
edges.
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Fig. 7.3: Dockable window repositioning possibilities (note: Window anchor points
are shown in red squares)

Fig. 7.4: Two dockable windows positioned side-by-side to allow comparison of
Results (e.g Target Result and associated HEN Grid design)

The management of Target Results also includes the handling of changes
to the underlying data that affect a result. In PinCH any change such
as a stream table parameter change, economic data change or schedule
change will result in the previously saved Target Results no longer being
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synchronized with the changed data. In most cases open Target Results
will be automatically synchronized when a change in for example the
stream table is made. However, changing a utility stream alpha will not be
automatically updated and will require the Target Result to be manually
synchronized by closing and re-opening the Target Result.
Handling Changes to Data That Affect Target Results:
1. Create a Target Result.
2. Change a stream table parameter in the Process Stream Table for one of
the streams in the process.
3. A message box confirming the change results is displayed (Fig. 7.5). Select
Yes.
4. The HEN Grid icon is displayed in red to indicate it is no longer synchronized with the underlying stream data (also when the ∆ Tmin is changed).

Fig. 7.5: Dialog confirming change that affects all dependent Target Results

7.5

Analyzing Results

The data derived from a Target Result can be viewed either on the OC
Charts displayed or in the OC Data grid shown at the bottom of the window
containing each Target Result (see Fig. 7.2). The charts include the Composite Curve (CC), Grand Composite Curve (GCC), Balanced Composite
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Curve (BCC), Balanced Grand Composite Curve (BGCC), Cost Curves and
the Split Grand Composite Curve (Split GCC). The cost curves include a
breakdown of the annual investment cost curve into the investment cost for
internal process-process heat exchangers, CU-process heat exchangers and
HU-process heat exchangers.
Several characteristics related to the OC Data are to be noted regarding the
display. First there are two rows displayed for a single operating case or time
slice. Fig. 7.6 shows the two rows. The first row corresponds to the targeting
result information based on the CC graph where only the default hot and cold
utilities are added at the end of the composite curve. No other utilities are
allowed. The second row is optional and is based on the balanced composite
curve (BCC) that includes any internal utilities (in addition to the default
utilities) that have been included in the composite curve. This data row is
only shown when one additional utility outside of the default utilities has
been included and sized (based on the GCC).

Fig. 7.6: Result panel for a continuous process Target Result with a single operating case and two rows for CC and BCC when multiple internal utilities
are defined

Adding and Sizing Internal Utilities:
The default utilities (both hot and cold) must always be added to a Target
Group. This ensures that the energy balance for each associated Target Result
can be completed and the proper costs can be calculated. In order to include
multiple “internal” utilities, additional hot and cold utilities can be added to
the Utility Stream Table and assigned to the Target Group along with the
default hot and cold utilities. These internal utilities can then be sized. The
heat flow of each internal utility must be specifically set and can be typically
derived from the GCC.
How to Size Internal Utilities:
1. Create a Target Result as described in section 7.3.
2. Add an additional utility stream to the Utility Stream Table.
3. Assign the newly added utility stream to the Target Group.
4. Add a new Separate Design Target Result.
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5. Right click on the CC row within the OC Data or TS data grid and select
Size Utilities. Optionally, the properties window tab can be first selected
and then the CC or BCC row selected to display the Cold Utility/Hot
Utility Sizing text entry boxes.
6. Enter a heat flow value for the internal utility in the associated text entry
box. The balanced composite curve will update accordingly (the composite
curve only contains the default utilities so it will not change).
A second characteristic of the results panel is that results are shown for each
operating case or time slice determined to exist over the entire time period of
operation of all processes. Figure 7.7 illustrates the layout of results from a
batch process showing the five operating cases and their individual targeting
values. In addition, the totals for the targeting values when multiple operating
cases or time slices exist are given at the bottom of the data grid.

Fig. 7.7: Result panel for a batch process Target Result with multiple operating
cases or time slices

The targeting values listed in these panels are summarized in Table 7.1:
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Tab. 7.1: Results Panel Targeting Values Table

Results Panel
Values
Operating Case/
Time Slice
Time Schedule

Description

The time slice in which specific streams exist
at the same time
The absolute start and end time of an
operating case or time slice
∆ Tmin
The vertical distance between the hot and the
cold composite curve at the closest point
Pinch T
The pinch temperature represented by the
closest approach of the hot and the cold
composite curve
Heat Recovery
The amount of heat exchange between
process-process or internal utility-process streams
Hot Util
The minimum amount of hot utility needed for
heating based on the specified ∆ Tmin for the
given composite curves
Cold Util
The minimum amount of cold utility needed
for cooling based on the specified ∆ Tmin for
the given composite curves
Area
The amount of heat exchanger area calculated
based on the given composite curves and ∆ Tmin
assuming vertical heat transfer for the
spaghetti network [12]
Nunits
The total number of units calculated based
on the given composite curve and ∆ Tmin
Yearly Cost
The total annual cost for the given composite
curve and ∆ Tmin
Operating Cost The total annual operating cost for the given
composite curve and ∆ Tmin (Utility, ECU and
Site Electricity, maintenance and personnel)
Total Investment The total cost of the required heat exchanger
Cost
area plus any remaining ECU investment
cost (e.g. compressor cost)

Units

hour
K
°C

kW
kW

kW

m2

[-]
CHF/
year
CHF/
year
CHF
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Continuation of table 7.3:
Results Panel
Values
Heat Recovery
Investment Cost

Description

The heat exchanger investment cost
associated with process-process or internal
utility-process streams heat exchange
HU Inv. cost
The heat exchanger investment cost only
associated with the default hot utilityprocess heat exchange
CU Inv. cost
The heat exchanger investment cost only
associated with the default cold utilityprocess heat exchange
ECUs Remaining Investment cost for ECUs not including the
Inv. Cost
heat exchanger investment costs for ECUs.
(Note: ECU heat exchanger investment
costs are included directly in the Energy
Recovery Investment cost calculation)

Units
CHF

CHF

CHF

CHF

The results from a Target Result can be analyzed in two ways - i) within the
PinCH program itself or ii) exported to another program. The first method is
accomplished using the Results Panel and graphics as previously discussed.
However, all data grids and graphics can be exported to other programs.
To Export OC Data Grid Table:
1. Calculate and Show a Target Result.
2. Press the ctrl button and then select the desired rows, which will be exported (the selected rows will be highlighted).
3. Press Ctrl + C to copy the selected rows.
4. Open an editing program such as Excel.
5. Press Ctrl + V to paste the results into the program for editing.
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To Export Graphics:
1. Calculate and Show a Target Result.
2. Right-click on the composite curve graph and select Save Image As.
3. Navigate to the desired directory location, enter a name for the png file
and press save.
Note: All graphics in PinCH can be saved using the Save Image As context
menu directly on each graphic by right clicking.
To Change Scaling of Graphics:
Each graphic can be analyzed in closer detail by changing the scale of the
graphic in order to zoom closer in on a particular graph region. This can
be done simply by positioning the mouse cursor over a graph at a required
location and then using the mouse wheel to increase or decrease the scaling
in the chosen region.
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Targeting Analysis Support Tools

One support tool is the interaction tool or cross-hairs implemented for the
Grand Composite Curve (GCC). This tool provides the ability to measure
the net heat rate at a given shifted temperature or conversely the shifted
temperature for a given net heat rate (Figure 7.8). In addition, if a stream
consists of a phase change, then this segment can be directly selected. This
action allows the setting of the quality value and displays the corresponding
shifted temperature and heat rate portion. This functionality is primarily
used for sizing internal utilities heat rates when performing a utility system
optimization (see section 4).

Fig. 7.8: Grand Composite Curve interaction tools to determine accurately shifted
temperature or heat flow values

A second tool is the ability to export the internal match-wise area calculation
results for each Target Result. These results are exported based on a range
of ∆ Tmin values and are saved as a comma-separated values format file. This
file can be easily opened in any editing or mathematical program such as
Matlab.
To Export Area Matrices:
1. Create a Target Result
2. Right-click on the created Target Result node and select Export > Export
Matchwise Result Matrices
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3. Select the operating case to vary the ∆ Tmin
4. Enter a range of ∆ Tmin values to calculate the match-wise matrices
5. Select Export button and enter name and location
6. Press Save
Another support tool is the ability to Zoom in or out on most of the charts
displayed in the software by simply using the mouse wheel. This action causes
the axis to update and become more refined allowing the user to see more
precise values in the particular chart.
An interesting support tool is the Carnot Factor curves or exergy composite
curves. This diagram is based on the composite curves but with the temperature axis replaced by the Carnot factor, ηc = 1 − To /T . The area between the
two balanced exergy composite curves is the total exergy loss in the HEN.
To Display the Carnot Factor Curves:
1. Create a Target Result
2. Right-click on the created Composite Curve Graph and select Switch axis
to carnot factor
A final support tool is the ability to Zoom in or out on most of the charts
displayed in the software by simply using the mouse wheel. This action causes
the axis to update and become more refined allowing the user to see more
precise values in the particular chart.
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Chapter 8
Analyzing Multiple Operating
Cases
8.1

Introduction

As for a single continuous process, targeting calculations involving combinations of continuous or semi-continuous processes play a central role in a pinch
analysis study. However, in this case the system boundary is extended to
include combinations of continuous processes. The combinations commonly
include those processes that run at the same time but are separated (e.g.
distance, product, etc.). A second category includes those processes that are
only partially overlapped in time and form separate operating cases (OCs)
each with different groupings of the available streams. A third category are
those processes that exhibit different operating states (e.g. product changes,
seasonal changes, etc.) in the same equipment. Section 3.3 shows several options for modelling different process types and how separate operating cases
can form.
The importance of such calculations involving these processes lies in the fact
that a greater potential for heat transfer is possible given the extended system boundary. However, greater attention to the design of the heat exchanger
network is required to ensure investment cost is minimized through the re-use
of heat exchanger area between the different OCs. Nevertheless, similar to
single continuous process analysis, a great deal of useful information can be
calculated immediately using only the stream data established in the data
extraction and energy modeling step. No detailed design needs to be completed at this part of the study which allows for rapid iterations in evaluating
heat integration possibilities.
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How to Schedule Multiple Operating Cases

Multiple operating cases (MOCs) are formed by the combination of several
continuous or semi-continuous processes. In section 3.3 several options for
modelling the process types are shown and how separate operating cases can
form. PinCH provides real world scheduling capability to model most of the
process types encountered in industry.

8.2.1

Standard Multiple Operating Cases

Standard multiple operating cases (MOCs) are formed by the overlap of
single continuous processes each of which have different schedules over the
course of a year. Specifically shown in sections 3.3.2, 3.3.3 and 3.3.4 are
several common types of MOC scheduling configurations. A more complex
scheduling is as shown in Figure 8.1 which illustrates the overlap of multiple
continuous processes over an entire year based on seasonal variation.

Fig. 8.1: OC Scheduling showing multiple operating cases (MOCs) over the duration of a year and the weekly production campaign for one of the selected
processes.

In Figure 8.1 a Continuous Processes data grid is shown, which must be used
to configure the necessary scheduling data of each individual process (refer
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to section 9.2 for how to schedule a batch process). The data shown in the
continuous scheduling grid are summarized in the following table 8.1.
Tab. 8.1: Continuous Process, Operating Cases, Scheduling and Data Grid Values
Table

Scheduling Grid Description
Units
Values
Process
The name of each process to be scheduled as
defined in the project explorer.
Time Base
The selected type of continuous process
either continuous (Cont. Year) or
semi-continuous (Cont. Weekly or Cont. Daily)
Mo
Monday - Selected day of the week to either
start a continuous process or the day of the
week a semi-continuous process is in operation.
Tu
Tuesday - Selected day of the week to either
start a continuous process or the day of the
week a semi-continuous process is in operation.
We
Wednesday - Selected day of the week to either
start a continuous process or the day of the
week a semi-continuous process is in operation.
Th
Thursday - Selected day of the week to either
start a continuous process or the day of the
week a semi-continuous process is in operation.
Fr
Friday - Selected day of the week to either
start a continuous process or the day of the
week a semi-continuous process is in operation.
Sa
Saturday - Selected day of the week to either
start a continuous process or the day of the
week a semi-continuous process is in operation.
Su
Sunday - Selected day of the week to either
start a continuous process or the day of the
week a semi-continuous process is in operation.
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Continuation of table:
Scheduling Grid
Values
Daytime Start
hh:mm
CW Start

Description

The actual start time in the selected week
given in hours and minutes of the day.
The calendar week in the year at which the
process starts.
No. Weeks
The number of weeks a semi-continuous process
is in operation (Cont. Weekly or Cont. Daily).
Duration
Either the yearly duration of single continuous
process or the weekly/daily duration of a
semi-continuous process.
Prod. Campaign Start The calculated absolute start time in the year
for the selected process.
Prod. Campaign End The calculated absolute end time in the year
for the selected process.
Gross Op. Time
The calculated time difference between the absolute
start and end time over the year.
Net Op. Time
The actual operation time of the selected process
over the year.

8.2.2

Semi-Continuous Processes and Multiple Operating
Cases

As noted in Table 8.1 a semi-continuous process can be defined by selecting
a TimeBase of Continuous Weekly or Continuous Daily. The user can enter
the configuration data in the data grid for either a continuous or a semicontinuous process. The data entry fields in the continuous scheduling grid
change slightly in order that the operation of a process can be specified for
a fixed number of hours over the time period of one week or over a specific
day of the week. (see Fig. 8.2)
Several charts are available for analysis in the Operating Cases Scheduling
visualizer as shown in figure 8.1. The charts include the Overall Process Gantt
chart as well as the Weekly Production Campaign chart. These charts help
the user to graphically view the data configured in the two data grids to
ensure correct data entry.
The Weekly Production Campaign chart is particularly helpful as it graph-

Units
hh:mm

h

h
h
h/a
h/a
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Fig. 8.2: Semi-Continuous process schedule compared to continuous and batch process scheduling.

ically displays the semi-continuous schedule data, this allows the user to
double-check the data entered. Each process in the overall Gantt chart can
be individually selected and this will change what is displayed in the weekly
Gantt chart.
Scheduling Intervals:
The scheduling of semi-continuous processes is convenient as it models the
time schedule of processes often seen in small and medium sized enterprises
(SMEs). As with continuous processes, the start and end of operation of the
process itself forms a scheduling interval (SI). A continuous process exists over
the entire duration of the SI, so the operating case (OC) duration is the same
as the SI. However, for semi-continuous processes a repeated period of operation during the week forms based on the duration of the semi-continuous
process, either on a daily time base or a weekly base. This repeatable period over the course of a single week will repeat a certain number of times
throughout the year depending on the scheduling of the process. The PinCH
software accounts automatically for this smaller duration by calculating the
actual operating time of the process and then using this time period in the
calculation of operating costs.
The complexity of the OC structure increases, however, when a semicontinuous process overlaps with other processes. As a result, within the
SI not one OC, but several OCs are present (see Fig. 8.3).
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Fig. 8.3: OC Gantt chart showing multiple OCs formed by the overlap of two semicontinuous processes.

8.2.3

Multiple Operating Cases Groups

As reviewed in section 3.3.5 it is possible to configure multiple operating
cases consisting of the same streams, but with different states (e.g. summer/winter). In order to use these streams at different states and therefore,
have a shared equipment, a Multiple Operating Cases (MOC) Group has to
be used. This special type of process grouping allows for proper calculation
of area targets when using the combined supertargeting tool. An example
of the scheduling of an MOC group is shown in figure 8.4. In addition, the
group is needed when using the same streams in multiple processes that do
not overlap in time yet need to be assigned to the same Target Group. Please
see section 6.3 on how to add a MOC Group.

Fig. 8.4: MOC Group Scheduling example
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How to Create and Prepare a Target Group

To create a new Target Group, the commands on the Target Explorer tree
must be used. The target explorer encapsulates all the necessary functionality
used in configuring and calculating the dynamic information used in analysis.
The first step is to create a grouping of processes that are to be analyzed
within a Target Group. More than one process can be selected to create the
multiple operating cases as discussed in section 8.2.3.
Note: Duplicate streams are not allowed in the different processes that are
added to the same targeting group.
To create a Target Group:
1. Select and highlight the BaseCase node in the Target Explorer
2. Right click on the BaseCase node to view the context menu and select
Add Target Group
3. Select the newly created target group listed under the BaseCase node and
press F2
4. Rename the node as required

8.4

Simplify Energy Targets - Energy Target Analysis

As noted in the introduction, industrial processes often consist of more than
one logical grouping of process streams separated by the constraint of physical
location. Energy Target Analysis (ETA) provides a powerful set of tools to
analyze the entire site for the greatest opportunities for heat integration. It
is best suited for overlapping continuous and semi-continuous processes in
order to identify which combinations of processes and resulting operating
cases can provide the greatest opportunity for heat recovery.
The creation of a new Simplified Targeting-Group allows the user to pick and
choose and experiment with the processes to see which combination offers
the most benefit, from an energy perspective, using process integration. As
discussed in section 8.2.2, the overall Gantt chart is divided into scheduling
intervals (SI) created by the starting and ending of the individual processes.
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If semi-continuous processes exist, then multiple operating cases will exist
in each SI. The OC Data grid and the OC Gantt Chart show the complete
breakdown for each SI according to these composite operating cases. Figure
8.5 shows the ETA visualizer for two overlapping semi-continuous processes
and the resulting OCs within the SI.

Fig. 8.5: Energy Target Analysis (ETA) results visualizer
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The ETA provides the flexibility to analyze an entire site to find the best
heat integration potential between different overlapping processes. Several
steps are required to configure the ETA for the analysis.
How to Create a Simplified ETA Target Group:
1. Select and highlight the Energy Target Analysis node in the Target Explorer once the associated Target Group has been configured with the
required processes
2. Right click on the Energy Target Analysis node to view the context menu
and select Open Energy Target Analysis
3. As a first step, select the desired processes to be analyzed together by
selecting them in the Processes & Groups box to ensure they show on the
Overall Gantt chart (see Fig. 8.6)

Fig. 8.6: ETA Configuration Step 1 - select the desired processes to be analyzed
together to show them in the Overall Process Gantt chart

1. As a second step, create an ETA simplified target group by first selecting
and highlighting the Groups node
2. Right click on the Groups node and select Add Simplified Targeting-Group
(see Fig. 8.7)
3. Select the newly created simplified target group listed under the Groups
node and press F2
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4. Rename the node as required

Fig. 8.7: ETA Configuration Step 2 - create a simplified targeting group to allow selection of parts of processes in order to determine best integration
potentials
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1. As a third step, use the left mouse button to select the processes to be
analyzed together directly on the Overall Process Gantt chart
2. Select the parts of the processes in the SIs to be included or not included
in the analysis as shown in figure 8.8

Fig. 8.8: ETA Configuration Step 3 - select processes or part of process in a SI and
analyze the heat integration potential using the OC Data grid or charts
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The heat integration potential of each selected scheduling interval (SI) can
be easily assessed by selecting the number in the footer of the Overall Process
Gantt chart (see yellow circles in figure 8.8). The associated OC target results
for a given ∆ Tmin are shown in the lower left section of the visualizer as
shown in 8.8 on the OC Data grid. There is no cost information shown as the
ETA functionality is designed to solely focus on heat integration and best
potentials. Therefore, the ∆ Tmin will have to be set based on experience and
then optimized later when creating an actual Target Result at a later step.
How to Analyze A Simplified Target Group - Energy & Cost Targets:
1. Once an ETA simplified target group has been analyzed for energy potential select the small icon lock to the left of the node to add the ETA
group to the Target Explorer
2. Select and highlight the Energy Target Analysis node in the Target Explorer
3. Either double click the Energy Target Analysis node or click the arrow on
the node to open the listing of locked ETA simplified target groups
4. Right click on the ETA simplified target group of interest and select context menu Create Target Result from Group to add a Target Result node to
the Target Group (the name of the ETA simplified group will be appended
to the name of the Target Result)
5. Right click on the created Target Result node and select Open Target
Result with Separate Design or Open Target Result with Combined SuperTargeting (Advanced) if multiple OCs exist and you wish to do MOC
supertargeting
Note: The lock function will not work if parts of processes already exist in
a Simplified Target Group that has been already analyzed for Energy and
Costs (i.e. no duplication of a stream in Targeting is allowed!).
The results available in the ETA include the OC Data grid for displaying the energy targets (kW and MWh, see Figure 8.5 and 8.8)) and the
CC/GCC/Split GCC charts (see Figure 8.9) for a selected SI. An OC Gantt
chart is also displayed which shows the weekly production campaign schedule
for each process that exists in the select SI. This chart is very useful to see
how the particular OCs form based on the schedule.
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Fig. 8.9: ETA Charts for each operating case

In addition, the Time Average Model (TAM) results for the selected SI is also
available in the OC Data grid and as separate OC Charts. The weighting of
the stream data is based on the net operating time as well as on the scheduling
information and is done automatically for the selected SI. The result provides
an indication of the suitability for storage between adjacent OCs.

8.5

How to Create and Analyze Target Results

A powerful feature of the Target Explorer is the flexibility it gives in comparing different Target Results. As shown in figure 8.10, not only are the energy
targets displayed but the number of units targets, cost targets and area targets are shown. These results are calculated based on either a simple cost
curve analysis or the more advanced combined supertargeting cost optimizer
(for MOC processes) to ensure the best economic efficiency.
For any particular target group, multiple target results can be created and
then automatically saved under the target group tree node. A selection of
different scenarios can be saved directly and used easily for comparing the
results of each scenario in order to find the best heat integration option.
Creating Multiple Target Results:
1. Create a Target Result as described for single continuous process in
section 7.3
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Fig. 8.10: MOC Combined Supertargeting Target Result showing the results for
Conventional Design together with the summaries of the Separate Design
and the Resequence Design types

2. Right click on the same Results node and select Calculate Target Result
with... and then Separate Design to create a second target result. A new
Target Result visualizer component will be added to a dockable window
and positioned in the center of the workbench
3. All the nodes can be renamed after pressing F2
4. Change the ∆ Tmin in the new Target result to a different value
5. Repeat for required number of different ∆ Tmin values
Note: Additional target results can be created when an ECU (see section
11.4 Integrate Energy Conversion Units), soft streams or multiple utilities
(see section 4) are added. The workbench is composed of dockable windows
that can be moved and repositioned throughout the workbench. This allows
for an easy comparison of the results or the data, which has been entered
(see Chap. 7.4 Fig. 7.4).
The results derived from a Target Result can be analyzed using either the
OC Charts in the middle section of the Target Result dockable window or the
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OC Data grid shown at the bottom of the window (see Fig. 8.10). The charts
include the Composite Curve (CC), Grand Composite Curve (GCC), Balanced Composite Curve (BCC), Balanced Grand Composite Curve (BGCC),
Cost Curves and the Split Grand Composite Curve (Split GCC). The cost
curves include a breakdown of the annual investment cost curve into the investment cost for internal process-process heat exchangers, CU-process heat
exchangers and the HU-process heat exchangers. The targeting values listed
in the OC Data grid are summarized in the following table 9.2:
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Tab. 8.2: Results Panel Targeting Values Table

Results Panel
Values
Operating Case/
Time Slice
Time Schedule
∆ Tmin
Pinch T
Heat Recovery
Hot Util

Cold Util

Area

Nunits
Yearly Cost
Operating Cost

Total Inv. Cost

Heat Recovery
Inv. Cost

Description
The time slice in which specific streams exist at
the same time
The absolute start and end time of an operating
case or time slice
The vertical distance between the hot and the
cold composite curve at the closest point
The pinch temperature represented by the closest
approach of the hot and the cold composite curve
The amount of heat exchange between
process-process or internal utility-process streams
The minimum amount of hot utility needed for
heating based on the specified ∆ Tmin for the
given composite curves
The minimum amount of cold utility needed for
cooling based on the specified ∆ Tmin for the
given composite curves
The amount of heat exchanger area calculated
based on the given composite curves and ∆ Tmin
assuming vertical heat transfer for the
spaghetti network [12]
The total number of units calculated based on
the given composite curve and ∆ Tmin
The total annual cost for the given composite
curve and ∆ Tmin
The total annual operating cost for the given
composite curve and ∆ Tmin (Utility, ECU and
Site Electricity, maintenance and personnel)
The total cost of the required heat exchanger
area plus any remaining ECU investment cost
(e.g. compressor cost)
The heat exchanger investment cost
associated with process-process or internal
utility-process streams heat exchange

Units

hour
K
°C

kW
kW

kW

m2

[-]
CHF/
year
CHF/
year
CHF

CHF
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Continuation of table:
Results Panel
Values
HU Inv. cost

Description

Units

The heat exchanger investment cost
CHF
only associated with the default hot utilityprocess heat exchange
CU Inv. cost
The heat exchanger investment cost
CHF
only associated with the default cold utilityprocess heat exchange
ECUs Remaining Inv cost for ECUs not including the heat
CHF
Inv. Cost
exchanger investment costs for ECUs.
(Note: ECU heat exchanger investment
costs are included directly in the Energy
Recovery Investment cost calculation)
Note: Only heat flow values are shown in the Target Result. To see the energy
values the Energy Target Analysis feature will have to be used.
Adding and Sizing Internal Utilities:
The default utilities (both hot and cold) must always be added to a Target
Group. This ensures that the energy balance for each associated Target Result
can be completed and the proper cost can be calculated. In order to include
multiple “internal” utilities, additional hot and cold utilities can be added to
the Utility Stream Table and assigned to the Target Group along with the
default hot and cold utilities. These internal utilities can then be sized. The
heat flow of each internal utility must be specifically set and can be typically
derived from the GCC.
As by single continuous processes, internal utilities can be added and used
to optimize the energy supply. When internal utilities are added to a Target
Group two rows are shown in the OC Data - one for the regular composite
curve (CC) using only the default utilities and one for the balanced composite
curve which includes the internal utilities.
How to Size Internal Utilities:
1. Create a Target Result as described above.
2. Add an additional utility stream to the Utility Stream Table.
3. Assign the newly added utility stream to the Target Group.
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4. Add a new Separate Design Target Result.
5. Right click on the CC row within the OC Data or TS data grid and select
Size Utilities. Optionally, the properties window tab can be first selected
and then the CC or BCC row selected to display the Cold Utility/Hot
Utility Sizing text entry boxes.
6. Enter a heat flow value for the internal utility in the associated text entry
box. The balanced composite curve will update accordingly (the composite
curve only contains the default utilities so it will not change).
The calculation of Target Results for energy and cost optimization involving MOC processes is more complex then by single continuous processes. In
particular there are more operating cases that exist using many of the same
streams or different operating states of the same streams (i.e. shared) over
the course of an entire year. The question arises in how to minimize total cost
of the underlying heat exchanger network (HEN) to ensure the reuse of heat
exchanger area is maximized leading to lower investment cost. As a result,
PinCH provides three different calculation methods to provide target results
that can be compared. When all three types are calculated together in the
same Target Result this is called Combined Supertargeting.

8.5.1

Separate Design Target Results

The separate design calculation is based on the assumption of complete separation of each OC from all other OCs. Simply put each OC is assumed to
have it’s own heat exchanger network and each would have to be built separately. This target represents the most expensive option and provides an
upper bound on the total investment cost. Its calculation is exactly as described in the section for Single Continuous processes but applied to each OC
separately. The cost curve is simply used to optimize each ∆ Tmin separately
with no consideration for reusing heat exchanger area.

8.5.2

Conventional and Resequence Design Target Results

Conventional and resequence design heat exchanger network design types
calculate new targets that account for the time dependent behaviour involved
in multiple operating cases or batch processes. In such processes direct heat
transfer can be optimized to account for the overlapping common area of heat
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exchangers that transfer heat between the same streams but at different states
and different time periods. Conventional and resequence design types provide
additional flexibility in HEN design and can be incorporated into early design
stage. Both design types aid in ensuring the maximum amount of common
heat exchange area is used to reduce investment cost. The optimization is
based on relatively straightforward linear program formulations with the goal
to determine a minimum capital cost HEN that is valid in all MOCs or time
slices at the Targeting stage. Please see Appendix A.9 for more information.
How to Calculate a Combined Supertargeting Result:
1. Create a Target Result as described for a single continuous process in
section 7.3, but select processes that create multiple operating cases
2. Right click on the same Results node and select Calculate Target Result with... and then Combined SuperTargeting (Advanced) to create a
second target result. A new Target Result visualizer component will
be added to a dockable window and positioned in the center of the
workbench
3. All the nodes can be renamed after pressing F2
4. Select the radio button on the header of the OC Data grid to switch
the results between Separate, Conventional and Resequence design and
compare the values for the same set of ∆ Tmin values automatically
created based on the Separate design cost curves (see figure 8.10)
5. Select the Conventional design radio button
6. Press the Optimize Button to calculate a new set of ∆ Tmin values based
on the Conventional design constraint
7. Repeat for the Resequence design constraint
8. Select the lock icon next to the Separate, Conventional and Resequence
summary row to unlock the value displayed (All unlocked results will
update automatically based on select design type and its associated
∆ Tmin values)
Both conventional and resequence design types calculate the total heat exchanger network (HEN) area and the number of units as there is in principle
only one HEN. Therefore, OC specific areas and number of units are not
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calculated.Only the separate design can calculate individual values for each
OC as, per definition, each OC is separate.
As discussed in section 8.2.2 a multiple operating case analysis can consist of
many small operating cases created by the overlap of semi-continuous processes. Due to non-synchronization of the different semi-continuous processes,
composite OCs can be created that contain the same set of streams but differ slightly in their duration. Nevertheless, PinCH automatically accounts for
these slight differences and calculates a total Target Result for each distinct
OC and adjusts the total net operation time accordingly. As a result, the
composite OCs are not shown on the OC Data grid, only the distinct OCs.
Note: MOC/Batch Supertargeting are calculated only with default hot and
cold utility.

8.6

Multiple Operating Cases – Analysis Support
Tools

Several tools presently exist to support the analysis of multiple operating
cases Target Results. First is the use of Perspectives to allow the user to
quickly focus on the important information during the analysis of a Target
Result. As seen in figure 8.10 a combobox is displayed in the header of the
dockable window with the following options:
 Orientation
 Optimization
 Analyzing

The Orientation perspective shows the following charts:
 Overall Gantt Chart
 OC Gantt Chart

The Optimization perspective is the most often used as it shows the following
charts:
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 Composite Curve CC
 Grand Composite Curve GCC
 Balanced Composite Curve CC
 Balanced Grand Composite Curve GCC
 Cost Curve CC
 Split Grand Composite Curve

Finally, the Analyze perspective shows the OC Data grid with the targeting
results of each OC.
A second tool is the OC Selector that is per default shown on the right side
of the Target Result visualizer (see figure 8.10). The selector provides the
ability to display or not display any particular OC in the OC Charts shown
in the Optimization perspective. This tool is very useful to help focus on the
critical OCs to be analyzed.
The third is the Split Grand Composite Curve (Fig. 9.4). This graphic allows
the display of two separate grand composite curves in operating cases (OCs)
from the same or or even other Target Groups and Target Results. This
functionality provides the ability to investigate the possibility of integrating
the two processes using for example intermediate loops. In addition, it can be
used to assess indirect heat integration between time slices of a single batch
process.
Note: The second selected grand composite curve is mirrored relative to the
other grand composite curve.
The split GCC can be accessed by the OC Charts selector in the header of
the OC Charts group box. All distinct OCs in any other Target Group and
Target Result can be selected as the extracted process giving total flexibility
in the desired configuration.
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Fig. 8.11: Split Grand Composite Curve
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Chapter 9
Analyzing Single Product Batch
Processes - Direct Heat Recovery
9.1

Introduction

Batch processes are prevalent in industry and account for a major portion
of all industrial processes. They are typically used in the following circumstances:
 when there are very slow conversions (long residence times)
 when only a small quantity of a product is produced but with a high
profit margin
 when a flexible manufacturing process and/or change to the product is
important (multi-product plants or multi-purpose equipment)
 when a continuous process is too technically difficult to realize

A batch consists of a single process with differing stream existence times.
This results in multiple time slices, each of which has its own composite
curve. Analysis becomes complex as opportunities for energy recovery become
bounded due to time constraints and it can not be assumed that each stream
can potentially exchange energy with all other streams of opposite hot or
cold designation at all times. Nevertheless, increasing direct heat transfer in
a batch process is an important economic and energetic consideration.

102

9. Analyzing Single Product Batch Processes - Direct Heat Recovery

9.2

How to Schedule a Batch Process

Single product batch processes are a common form of production used in
industry to produce special products that are constrained by high quality
standards, low quantity, flexibility requirements or reaction times. As a result,
the schedule of a batch process is characterized by the time dependence of
the streams. The time period of existence for each stream can be different
from that of other streams. The structure of the time schedule of each stream
can be clearly seen in a Gantt chart. PinCH supports the scheduling of single
product batch streams through the Process Stream Table and Operating
Cases Schedule.
PinCH provides real world scheduling capability to model most of the process types encountered in industry. In section 3.3.6 it is shown how a single
product batch can be scheduled.

9.2.1

Scheduling Stream Existence Times (Process Stream
Table)

The use and defining of streams in the Process Stream Table is given in
section 4.3. The key parameters to include for a batch stream are the tStart
and tStop times. These parameters define the absolute existence time within
the single batch itself. These parameters ensure that the relative timing of
the streams and the associated heating or cooling demands are maintained
in comparison to the other streams. This model assumes the existence times
are fixed and repeated in a cyclical manner. A time slice model (TSM) can
then be easily created and analyzed.

9.2.2

Scheduling the Single Batch Process (Operating Cases
Schedules)

The scheduling of a single product batch process is characterized by two main
forms:
 Scheduling of the single product batch
 Scheduling of a single product batch that overlaps with itself
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The first form is the standard configuration of a batch process as it must be
repeated a certain number of times over the duration of, for example, one
year. This is done easily by setting directly the number of weeks (# Weeks)
and the number of batches (# Batches) and indirectly by setting in which
calendar week the batch process starts (CW Start) as shown in Fig. 9.1.

Fig. 9.1: Semi-Continuous process schedule compared to continuous and batch process scheduling.

The second form is characterized by scheduling a single batch process to
overlap with itself. This is often the case in industry as production must
be maximized and idle equipment from a previous batch can and should be
put into operation by simply starting a new batch before the previous batch
is complete. In the PinCH software this can be done be setting the Batch
Cycle Duration (BCD) to be less than the Batch Process Duration (BPD) to
indicate that the batch starts sooner. Both of these parameters are available
in the operating case schedule for batch processes (see Fig. 9.1 and Table 9.1)
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Tab. 9.1: Continuous Process, Operating Cases, Scheduling and Data Grid Values
Table

Scheduling
Grid Values
Process

Description

Units

The name of each process to be scheduled as
defined in the project explorer.
Timebase
The time frame for which a batch process
operates (Batch Daily, Batch Weekly or Batch
Yearly)
Mo
Monday - Selected day of the week on which the
first batch process begins.
Tu
Tuesday - Selected day of the week on which the
first batch process begins.
We
Wednesday - Selected day of the week on which
the first batch process begins.
Th
Thursday - Selected day of the week on which the
first batch process begins.
Fr
Friday - Selected day of the week on which the
first batch process begins.
Sa
Saturday - Selected day of the week on which the
first batch process begins.
Su
Sunday - Selected day of the week on which the
first batch process begins.
Daytime Start The actual start time in the selected week
hh:mm
hh:mm
given in hours and minutes of the day.
CW Start
The calendar week of the year in which the
process starts.
No. Weeks
The number of weeks a batch process is in
operation.
BCD
Batch Cycle Duration – Time of duration
h
between the start of one batch and the beginning
of the next batch.
No. Batches
Number of batches occurring within the chosen
time base (daily weekly or yearly)
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Continuation of table:
Scheduling Grid Description
Values
BPD,BSD
Batch Cycle Duration – Time duration of
equipment repeat operation period (EROP),
which includes pre and post processing times.
Batch Stream Duration – Time duration of
(EROP) considering only the stream start and
stop times
Prod. Campaign The calculated absolute start time in the year
Start
for the selected process.
Prod. Campaign The calculated absolute end time in the year
End
for the selected process.
Gross Op. Time The calculated time difference between the
absolute start and end time over the year.
Net Op. Time
The actual operation time of the selected
process over the year.

Units
h

h
h
h/a
h/a

Additional information on the scheduling of overlapping batches can be found
in Appendix A.10.

9.3

How to Create and Prepare a Target Group

To create a new Target Group commands on the Target Explorer tree must
be used. The target explorer encapsulates all the necessary functionality used
in configuring and calculating the dynamic information used in analysis. The
first step is to create a grouping of processes that are to be analyzed within a
Target Group. However, for the specific energy and cost target analysis (re.
Target Result section ) of single batch process and its associated time slice
(TS) model it is required that only the batch process be added to the Target
Group. No support is given for overlapping of different batch processes as
this is still a subject of fundamental research. However, the Energy Targeting
Analysis functionality (section 9.4) can be used to analyze the Time Average
Model (TAM) of the overlapping processes.
Note: Duplicate streams are not allowed in different processes that are added
to the same targeting group.
To create a Target Group:
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1. Select and highlight the BaseCase node in the Target Explorer
2. Right click on the BaseCase node to view the context menu and select
Add Target Group
3. Select the newly created target group listed under the BaseCase node and
press F2
4. Rename the node as required

9.4

Simplify Energy Targets - Energy Target Analysis

As noted in the introduction, industrial processes often consist of single product batch processes for the production of special products. Often the heat
integration of such processes is ignored as the focus is on low-quantity highquality specialty products. Nevertheless, there is great potential for improving
the energy efficiency of such processes given this traditional lack of interest
in the energy efficiency.
The Energy Target Analysis (ETA) provides a powerful set of tools to analyze
the batch process Gantt or time slice model (TSM) and look for the best
opportunities for direct heat transfer within the TSs. Simplification of the
TSM is also possible in order to focus in on the best possible direct heat
transfer possibilities. In addition, support is given through the Time Average
Model (TAM), Split GCC and the GCC based ISSP to assess the potential
for indirect heat transfer using heat storages. Figure 9.2 shows the entire
ETA visualizer with the different analysis objects.
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Fig. 9.2: ETA Single Product Batch visualizer showing the different analysis objects - OC Gantt Chart, Equipment Repeated Operation Period Gantt,
TS Data grid and the TS Charts. Not displayed or hidden are the TAM
charts, Heat Integration Comparison Charts, the split GCC Chart and
the GCC based ISSP Chart.

9.5

How to Create and Analyze Target Results

PinCH provides the ability to easily view and compare the results in each time
slice, which helps in the search for new opportunities for improved process
integration.
To Create a Target Result for a Batch:
1. Create a Target Group
2. Select and highlight the Target Group node in the Target Explorer
3. Right click on the Target Group node to view the context menu and select
Reassign Operating Cases Schedule and re-assign a schedule as needed.
4. Right click on the Target Group node to view the context menu and select
Reassign Economic Data; re-assign the economic data as needed.
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5. Right click on the Processes node and select a batch process to be used
in the analysis. (Ensure that tstart and tstop have been included for each
stream in the Process Stream Table beforehand as defined in section 4.3).
6. Right click on the Utilities node and select a default hot and a default
cold utility (see note given below)
7. Right click on the Results node and select Separate Design Tool to create
the target result
8. All the nodes can be renamed after pressing F2
In this case, there are two tools available for analysis - Separate Design Tool
and Combined Supertargeting Tool. The separate design tool analyzes the
absolute stream existence times and decomposes the data into separate time
slices or operating cases. Each slice is independent of the other and can be
analyzed on its own. The combined supertargeting tool uses the conventional
and resequence design types to calculate the optimum HEX area when common or reused area of HEX on the same streams in different TSs is accounted
for. Please see Appendix A.9 and section 9.5.2 for more information.
Note: It is critical to have created at least one hot and one cold stream in
the Utility Stream Table. Please be certain to ensure the respective temperature ranges of these utilities provide enough driving force for the given
process streams. These two utilities will need to be assigned as the default
hot and cold utility in order to allow the internal energy balance to be closed.
This is particularly important in the case of adding multiple utilities used in
optimizing such systems.
After completing the above steps a window will be created and anchored on
the workbench with a tab. This window encapsulates the entire targeting
result for the selected tool (in this case either the Separate Design Tool or
Time Average Model). Fig. 9.3 shows the result for a Separate Design Tool
target result for a single batch process.
By selecting check boxes on the filter panel, the composite curve, grand
composite curve, balance composite curve, balanced grand composite curve,
cost curve as well as the gantt chart can be selected for viewing. Each will be
displayed automatically in the upper portion of the dockable window while
the results for a given process ∆ Tmin (entered on the Main Control Panel)
will be shown on the Results Panel data grid at the bottom of the window.
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Fig. 9.3: Batch Process Separate Design Tool Target Result

The specific results for each time slice can be viewed on the Results Panel data
grid. Both the results for the composite curve (only includes the default hot
and cold utility) and the balanced composite curve (includes the default hot
and cold utility as well as the additional internal sized utilities) are shown.
Any multiple operating cases or time slices will also be listed in the data
grids each row representing the targeting result for the particular slice. Table
9.2 provides descriptions of the different columns that appear in the Results
Panel.
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Tab. 9.2: Results Panel Targeting Values Table

Results Panel
Values
Operating Case/
Time Slice
Time Schedule
∆ Tmin
Pinch T
Heat Recovery
Hot Util

Cold Util

Area

Nunits
Yearly Cost
Operating Cost

Total Inv. Cost

Heat Recovery
Inv. Cost

Description
The time slice in which specific streams exist at
the same time
The absolute start and end time of an operating
case or time slice
The vertical distance between the hot and the
cold composite curve at the closest point
The pinch temperature represented by the closest
approach of the hot and the cold composite curve
The amount of heat exchange between
process-process or internal utility-process streams
The minimum amount of hot utility needed for
heating based on the specified ∆ Tmin for the
given composite curves
The minimum amount of cold utility needed for
cooling based on the specified ∆ Tmin for the
given composite curves
The amount of heat exchanger area calculated
based on the given composite curves and ∆ Tmin
assuming vertical heat transfer for the
spaghetti network [12]
The total number of units calculated based on
the given composite curve and ∆ Tmin
The total annual cost for the given composite
curve and ∆ Tmin
The total annual operating cost for the given
composite curve and ∆ Tmin (Utility, ECU and
Site Electricity, maintenance and personnel)
The total cost of the required heat exchanger
area plus any remaining ECU investment cost
(e.g. compressor cost)
The heat exchanger investment cost
associated with process-process or internal
utility-process streams heat exchange

Units

hour
K
°C

kW
kW

kW

m2

[-]
CHF/
year
CHF/
year
CHF

CHF
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Continuation of table:
Results Panel
Values
HU Inv. cost

Description

Units

The heat exchanger investment cost
CHF
only associated with the default hot utilityprocess heat exchange
CU Inv. cost
The heat exchanger investment cost
CHF
only associated with the default cold utilityprocess heat exchange
ECUs Remaining Inv cost for ECUs not including the heat
CHF
Inv. Cost
exchanger investment costs for ECUs.
(Note: ECU heat exchanger investment
costs are included directly in the Energy
Recovery Investment cost calculation)
The specific results for each time slice can be viewed on the Results Panel
data grid. Both the results for the composite curve (only includes the default
hot and cold utility) and the balanced composite curve (includes the default
hot and cold utility as well as the additional internal sized utilities) are shown.
Any multiple operating cases or time slices will also be listed in the data grids
with each row representing the targeting result for that particular slice.

9.5.1

Separate Design Target Results

The separate design calculation is based on the assumption of complete separation of each TS from all other TSs. Simply put each TS is assumed to
have its own heat exchanger network and each would have to be built separately. This target represents the most expensive option and provides an
upper bound on the total investment cost. Its calculation is exactly as described in the section for Single Continuous processes but applied to each TS
separately. The cost curve is simply used to optimize each ∆ Tmin separately
with no consideration for reusing heat exchanger area.

9.5.2

Conventional and Resequence Design Target Results

Conventional and resequence design heat exchanger network design types calculate new targets that account for the time dependent behaviour involved
in multiple operating cases or batch processes. In such processes direct heat
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transfer can be optimized to account for the overlapping common area of
heat exchangers that transfer heat between the same streams but at different
states and different time periods. Conventional and resequence design types
provide additional flexibility in HEN design and can be incorporated into an
early design stage. Both design types aid in ensuring the maximum amount
of common heat exchange area is used to reduce investment cost. The optimization is based on relatively straightforward linear program formulations
with the goal to determine a minimum capital cost HEN that is valid in all
MOCs or time slices at the Targeting stage. Please see Appendix A.9 for
more information.
How to Calculate a Combined Supertargeting Result:
1. Create a Target Group as described in section 9.3 for a single product
batch process
2. Right click on the same Results node and select Calculate Target Result with... and then Combined SuperTargeting (Advanced) to create a
second target result. A new Target Result visualizer component will
be added to a dockable window and positioned in the center of the
workbench
3. All the nodes can be renamed after pressing F2
4. Select the radio button on the header of the TS Data grid to switch
the results between Separate, Conventional and Resequence design and
compare the values for the same set of ∆ Tmin values automatically
created based on the Separate design cost curves (see figure 8.10)
5. Select the Conventional design radio button
6. Press the Optimize Button to calculate a new set of ∆ Tmin values based
on the Conventional design constraint
7. Repeat for the Resequence design constraint
8. Select the lock icon next to the Separate, Conventional and Resequence
summary row to unlock the value displayed (All unlocked results will
update automatically based on select design type and its associated
∆ Tmin values)
Both conventional and resequence design types calculate the total heat exchanger network (HEN) area and the number of units as there is in principle
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only one HEN. Therefore, TS specific areas and number of units are not calculated. Only the separate design can calculate individual values for each TS
as, per definition, each TS is separate.
Note: MOC/Batch Supertargeting are calculated only with default hot and
cold utility.

9.6

Single Product Batch Process Analysis Support Tools

Several tools presently exist to support the analysis of time slices (TSs) of a
single batch process Target Result. First is the use of Perspectives to allow
the user to quickly focus on the important information during the analysis of
a Target Result. As seen in figure 8.10 a combobox is displayed in the header
of the dockable window itself with the following options:
 Orientation
 Optimization
 Analyzing

The Orientation perspective shows the following charts:
 Overall Gantt Chart
 OC Gantt Chart

The Optimization perspective is the most often used as it shows the following
charts:
 Composite Curve CC
 Grand Composite Curve GCC
 Balanced Composite Curve CC
 Balanced Grand Composite Curve GCC
 Cost Curve CC
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 Split Grand Composite Curve

Finally, the Analyze perspective shows the TS Data grid with the targeting
results of each TS.
A second tool is the TS Selector that is per default shown on the right side
of the Target Result visualizer (see figure 8.10). The selector provides the
ability to display or not display any particular TS in the TS Charts shown
in the Optimization perspective. This tool is very useful to help focus on the
critical TSs to be analyzed.
Another tool is the Split Grand Composite Curve (Fig. 9.4). This graphic
allows the display of two separate grand composite curves from consecutive
TSs. This functionality provides the ability to investigate the possibility of
integrating the two TSs using for example intermediate loops with heat storage. This helps to assess indirect heat integration between time slices of a
single batch process.
Note: The second selected grand composite curve is mirrored relative to the
other grand composite curve.
The split GCC can be accessed by the TS Charts selector in the header of
the TS Charts group box. All distinct TSs in any other Target Group and
Target result can be selected as the extracted process giving total flexibility
in the desired configuration.
Note: Please see section 12.6 for information related to exporting area matrices for target results of each time slice.

9.6 Single Product Batch Process Analysis Support Tools

Fig. 9.4: Split Grand Composite Curve
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Chapter 10
Analyzing Single Product Batch
Processes - Indirect Heat Recovery
10.1

Introduction

Direct heat recovery (HR) by the means of a Heat Exchanger Network (HEN)
has been successfully applied to continuous processes, yet has limited potential for the intra- or inter-integration of non-continuous processes. In such
processes, direct HR can be applied within time intervals where both hot
and cold process streams occur simultaneously, but any variability in the
schedule directly affects the achieved HR of a particular HEN design. Therefore, in order to achieve a more flexible and much less schedule sensitive HR
process design, a combined Heat Exchanger and Storage Network (HESN)
can be used to absorb schedule variation in addition to allowing the heat
transfer from earlier time intervals to later ones. Non continuous processes
are batch or semi-continuous processes commonly found in the pharmaceutical, food and biochemistry industry at temperature levels low enough to
allow cost effective sensible heat thermal energy storage (TES) using water
as the storage medium. If the temperature levels are above the applicability
level of water, thermal oil is used instead?
Indirect heat recovery is achieved using intermediate loops (IL) and heat
storages (HS) (i.e. there is no direct heat transfer between any of the streams
involved in the pinch analysis). This allows the full energy content of a stream
to be captured and potentially used for heat recovery, regardless of when the
stream occurs in time. The graphical method used in the design of TES
systems is the Indirect Source and Sink Profile (ISSP) in order to determine
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the indirect heat recovery potential of a batch process. This functionality
provides a third component as a basis of the PinCH software as shown in
Fig. 10.1 in the lower right. More information is given in Appendix A.11 and
in references [19 - 21].

Process
Requirements

Costs

PinCH Software

Direct Heat
Recovery

Utility System

Indirect Heat
Integration
(Thermal
Energy
Storage)

Fig. 10.1: PinCH Software main components highlighting the indirect heat recovery beside the direct heat recovery and utility system components that
together form the foundation of the software.

10.2

How to Create and Prepare a Target Group

The calculation of indirect heat recovery using thermal energy storage is
based on a single product batch process. For information on how to create a
batch process please see section 9.2. In addition, information related to the
preparation of a target group using the same batch process is given in section
9.3.
Note: The use of simplified target groups created in the energy target analysis
(ETA) as well as softstreams are not presently supported in the creation
of indirect heat recovery target results. This means that segments of batch
streams cannot be ignored (as is possible in the ETA) resulting in the entire
stream always being used!

10.3 How to Create and Analyze Target Results
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How to Create and Analyze Target Results

PinCH provides the ability to easily view and modify the indirect heat recovery results in order to develop a cost effective conceptual design.
To Create an Indirect Heat Recovery Target Result for a Batch:
1. Create a Target Group
2. Select and highlight the Target Group node in the Target Explorer
3. Right click on the Target Group node to view the context menu and select
Reassign Operating Cases Schedule and re-assign a schedule as needed.
4. Right click on the Target Group node to view the context menu and select
Reassign Economic Data; re-assign the economic data as needed.
5. Right click on the Processes node and select a batch process to be used
in the analysis. (Ensure that tstart and tstop have been included for each
stream in the Process Stream Table beforehand as defined in section 4.3).
6. Right click on the Utilities node and select a default hot and a default
cold utility (see note given below)
7. Right click on the Results node and select Indirect Heat Recovery to
create the target result
8. All the nodes can be renamed after pressing F2
After completing the above steps a window will be created and anchored on
the workbench with a tab. This window encapsulates the entire targeting
result for the indirect heat recovery result. Fig. 10.2 shows an example target
result for an indirect heat recovery analysis.
Graphics will be displayed automatically in the upper portion of the dockable
window. Specific configuration information or calculated results is shown on
the lower part of the dockable window in data table grids. Details of the
specific charts and data grid information is presented in the next section
10.3.1. The specific grouping on tabs of graphics and data grid information
is shown in section 10.4
Note: It is critical to have created at least one hot and one cold stream in the
Utility Stream Table. Please be certain to ensure the respective temperature
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Fig. 10.2: Indirect heat recovery target result dockable window showing the main
ISSP and Required # of ILs vs. HR charts and the Sources and Sinks
table data grid.

ranges of these utilities provide enough driving force for the given process
streams. These two utilities will need to be assigned as the default hot and
cold utility in order to allow the internal energy balance to be closed. For the
case of indirect heat recovery result only a single hot and single cold utility
are supported (i.e. multiple utilities are not supported).

10.3.1

Indirect Heat Recovery Target Results

The indirect heat recovery target result consists of several key charts and
result tables. In the following points are listed the main charts and tables
with specific information related to each.
Indirect Source and Sink Profile Chart:
The Indirect Source and Sink Profile (ISSP) is used to determine the indirect
heat recovery potential of a batch process. Indirect heat recovery is achieved
using intermediate loops (IL) and heat storages (HS) (i.e. there is no direct
heat transfer between any of the streams involved in the pinch analysis). This
allows the full energy content of a stream to be captured and potentially used
for heat recovery, regardless of when the stream occurs in time. An example
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ISSP with a disconnected storage system (i.e. the two IL/HSs system has been
separated into, for example, two different stratified tanks to allow setting the
Thigh and Tlow values of each tank independently of each other) in the
PinCH software is shown in Fig. 10.3.

Fig. 10.3: Indirect Source and Sink Profile chart for a disconnected thermal energy
storage system.

The ISSP is based on the time average model (TAM) originally defined to
provide an absolute upper limit to the achievable HR in batch processes by
simply averaging the flows over the period of the batch. This role of the
TAM was later extended to include graphical conceptual design by applying
the ”vertical heat transfer model” to define enthalpy intervals in which heat
is recovered from the hot streams to the cold streams through an IL/HS
system. The ”vertical model” is defined as pure counter-current heat exchange
within the enthalpy interval. However, when integrating batch processes, the
simultaneity of the hot and cold streams can not be guaranteed, so that the
vertical model is applied to the individual streams rather than for the entire
composite within the enthalpy interval. This means the heat exchangers are
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placed in parallel on the IL/HS side as shown on the HESN in section 10.3.2
- Fig. 10.10. More detailed information in how to calculate the ISSP is shown
in Appendix A.11
Note: When 50 or more streams are included in the ISSP then the source
and sink profiles are defaulted to have no overlap. This behavior improves
performance in first creating the ISSP and when opening a saved result.
Finally, as shown on Fig. 10.3 the individual streams can be shown (as horizontal lines) on the graph to indicate the temperature range of their supply
and target temperatures. This can be activated on the properties window as
discussed later in this section.
Sources and Sinks Table:
The sources and sink table lists process requirements for the batch process
used in creating the ISSP. The calculated shifted temperatures and amount
of available heat are shown in green. This allows the user to assess the effectiveness of each stream for HR in the storage system. For example, a stream
with a low heat content relative to the others could be removed from the
analysis to reduce complexity. This is simply done by deselecting the check
box next to the stream name as shown in Fig. 10.4.

Fig. 10.4: Sources and Sinks table to allow the selection of streams to be excluded
from the ISSP analysis. In addition, the calculated ∆ Tmin,s can be manually set to change each streams priority for heat recovery.

The default ∆ Tmin,s values (see Appendix A.11) are also displayed and can be
edited manually to essentially shift the priority of each stream for HR relative
to the other streams as needed or to ensure a large enough temperature
driving force between the stream and IL is available.
Finally, the Info column displays key information related to which streams
create new assignment zones in effect acting as constraints in either temperature or enthalpy. Those stream that cause a high degree of complexity in the
IL/HS systems (through the creation of additional assignment zones) can also
be easily excluded from the ISSP. The Info box also notes if a stream contains
segments. This information is important to check if the particular segment
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is causing an assignment zone to be created and to decide if it is necessary.
The PinCH software considers all ”convex” segments in the calculation of
the assignment zones leading to a conservative design.
Required # of IL/HSs vs. HR chart and Payback Chart:
To provide a quick overview of the IL/HS system design and the profitability,
a chart showing the minimum number of IL/HSs for a given HR is available
(Fig. 10.5). This value is calculated internally based on automatic placement
of the Thigh and Tlow within the associated assignment zones assuming a
connected IL/HS system over the entire HR range. These value are only
defaults and are not necessarily the lowest cost, but are good immediate
indication of the effectiveness of the design and which HR value to select.
Note: The initialization algorithm tries to place the Thigh and Tlow in the
middle of the dynamic assignment zone shown in green. If unable to do so
then simple criteria (such as 20% of the vertical distance to the zone boundary
when only a vertical line assignment zone) are used.
In addition, the associated simple payback is calculated based on the total
investment costs and the total utility savings. It serves as a rough indicator
of the heat storage system’s profitability and the optimal HR-value. The grey
payback line on the chart is based on the automated initial placement of ILs
as noted above. The investment costs and hence the payback, given a specific
HR, can usually be significantly decreased by adequately changing temperatures and HR-values of the ILs (in the Heat Recovery, Loops & Storages
tab). The pink line in the graph indicates the payback of the heat storage
system with adapted values on the secondary y-axis. Further information on
the creation of the assignment zones is in [19 - 21].
Note: Increasing the heat recovery also decreases the investment costs for
HU and CU HEXs. This decrease is not taken into account with the payback
calculation described above. It is therefore assumed that a) the heat recovery
system is installed in an existing system and all HU and CU HEXs are already
installed (and already paid for) OR despite of the heat recovery system, all
HU and CU HEXs will have to be installed in any case (i.e. for securing
operation in case the heat storage system runs empty). In case HU and
CU HEXs can be abdicated in a new plant, the payback indicated in the
graph is overestimated and the correct calculation would need to include the
investment cost for the HU and CU heat exchangers.
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Fig. 10.5: Chart showing the minimum number of required intermediate loops and
heat storages (IL/HSs) versus the amount of potential heat recovery. In
addition the calculated simple payback versus the amount of potential
heat recovery is shown on the second y-axis.

Loading / Unloading Chart:
The minimum storage capacity needed for the IL/HS system depends on the
order of charging and discharging the stores from streams. This order is determined from the stream existence times defining the batch Gantt as well as
the Batch Cycle Duration BCD.The result is the determination of the loading
/ unloading thermocline profile based on one stream repeat operation period
(SROP). Using the ISSP, the direct allocation of stream to each IL/HS together with the sequence of streams during the repetition period allows the
computing of the profile. For a stratified tank the ideal thermocline between
each layer is shown (Fig. 10.6). Where for a FTVM each separate tank temperature is shown as individual lines. In both cases the profiles start and end
at the same level since the proposed design is a over a repetition period.
Note: The loading / unloading profile represents ideal thermal energy storage
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with no losses. To account for additional investment cost, a Safety Factor can
be applied to the total volume by entering the percentage on the properties
window of the ISSP target result. In practice this area will belong to one
(or more) layer or, in the worst case, to a transition layer, depending on the
initial conditions.

Fig. 10.6: Loading and unloading profile chart showing a single intermediate
loop/heat storage system (i.e. with two temperature levels) for the given
single batch stream repeat operation period (SROP). In addition, the
green line shows the user supplied capacity limitation and the blackline
shows the resulting restricted loading and unloading profile.
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Capacity Limitation Analysis Chart:
The capacity limitation analysis chart shows the relation between the amount
of potential heat recovery for a specified amount of storage volume. The chart
is shown next to the loading and unloading chart when selecting the Next
button on the Loading/Unloading tab. The analysis is limited presently to a
single intermediate loop/heat storage (IL/HS).
Ignoring Streams in a Time Slice: To help improve the heat recovery potential in batch processes using capacity limitation, ignoring an stream in a
particular time slice would be a way to control overflow in a storage to help
minimize the required capacity. However, presently PinCH only supports the
selecting / deselecting of an entire stream and not (as regards ISSP) at the
time slice level. A workaround if needed is to modify the tstart / tstop in the
stream table or use multiple instances of the same stream in different time
slices.
Note: Simultaneous loading and unloading leads to Heat Recovery without
requiring a storage. In the graph Capacity Limitation Analysis, the HR vs.
Capacity line can therefore cross the y-axis at HR-values > 0. However, the
stream table is usually simplified (e.g. averaged values over a given duration,
assumed periodic operation) and the simultaneity of streams might not be
given in practice. Hence, at least for buffering small scale variations of the
temporal model, and furthermore to allow some flexibility in operation, a
storage is almost always necessary.
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Fig. 10.7: Capacity limitation analysis chart showing the relation between the
amount of heat recovery possible and the selected amount of storage volume (for a single intermediate loop/heat storage system). The amount
of synchronized heat recovery possible (i.e. not needed to be stored) is
shown in the yellow region.

Specification and Savings/Costs Tables:
The Specification table is important for modifying the design of the IL/HS
system in order to systematically reduce the costs and complexity using the
given key parameters that can be modified. Setting the overall HR given
by the overlap of the source and sink profiles, results in the calculation of
the necessary assignment zones. These zones represent the set of HESN designs which guarantee feasible heat transfer at all time of the SROP while
minimizing the number of IL/HSs (see Appendix A.11).
Note: The implementation of the assignment zone algorithm in PinCH differ-

128

10. Analyzing Single Product Batch Processes - Indirect Heat Recovery

entiates between two types: 1) most restricted zones based on the intersection
of possible assignment zones where temperature placement is always feasible,
independent of the other enthalpy placements and 2) extended zones based
on the union of possible assignment zones where the temperature placement
within a zone is conditionally feasible and depends on the other enthalpy
placements.
In the Specification table the user can change the amount of HR, Tlow and
Thigh of each IL directly, but bounded by the calculated assignment zones.
Finally, the IL/HS system can be disconnected by simply deselecting the
check box in the Connected column for a particular IL as shown in Fig. 10.8.
An example disconnected ISSP is shown in Fig. 10.3.

Fig. 10.8: ISSP system Specification and Savings/Cost data tables. The Specification table allows the direct configuration of the thermal energy storage
system (i.e. Thigh or Tlow of each heat storage, amount of heat recovery for each heat storage, storage type, media type and connected or
disconnected storages).

Shown in Fig. 10.8 is also the Savings/Costs table for the heat storage system
only. The total investment cost based on the total heat exchanger area, mass
of required media and the storage volume is calculated and displayed. Given
the direct savings in hot and cold utility the simple payback can be calculated
using the cost data entered on the Economic Data dialog as shown on Fig.
6.3.
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The properties window of the indirect heat recovery target result can be
used to modify the calculation and display of associated charts and data
tables. Fig. 10.9 shows the parameters that can be selected. Of particular
note is the ability to toggle the display of the streams shown on the chart
(as shown on Fig. 10.3) and to change the default Initial Storage Type and
Initial Media that is used when recalculating the ISSP when, for example,
stream are included/excluded on the Sources and Sinks table (Fig. 10.8).

Fig. 10.9: Indirect heat recovery target result properties window showing the default settings.

The storage volume for each volume storage unit (VSU, i.e. Temperature
level in a stratified tank or a single FTVM tank) is simply scaled according
to the entered Safety factor %. This factor allows the user to quickly adjust
the volume to provide a safety margin in the design as typically needed in
TES design.
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Heat Exchanger and Storage Network Schema

Based on the configuration result of the ISSP and the associated setting of the
degrees of freedom (e.g. the number of IL/HSs, HR of each HS, temperature
levels and overall heat recovery), the heat exchanger and storage network can
be created. Given the assumption of vertical heat transfer in the ISSP the
HESN design is given immediately. An example is shown in Fig. 10.10

Fig. 10.10: Heat exchanger and storage network (HESN) for a disconnected system.

To View the Heat Exchanger and Storage Network (HESN):
1. Create an Indirect Heat Recovery target result as noted in section 10.3.
2. Right click on the newly added Indirect Heat Recover node and select
Show HESN Schema to display the HESN result
3. All the nodes can be renamed after pressing F2
The HESN is readonly and is dynamically bound to the associated ISSP and
the configured IL/HS system given in the Specification table. However, the
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properties window of the HESN can be used to modify the display of the
HESN. Fig. 10.11 shows the parameters that can be selected. Of particular
note is the ability to toggle the display of the mass flow rate on each branch
IL.

Fig. 10.11: Heat exchanger and storage network (HESN) chart properties window
showing the default settings. Of particular note is the ability to show
massflow on the intermediate loop branches.

10.3.3

Special Considerations with Shared Equipment

The increase in number of pieces of equipment that result from the overlap of
consecutive batch processes (as defined by the Batch Cycle Duration (BCD),
see section 9.2 and Appendix A.9) are handled in a special manner. The
first important consideration is the calculation of the volume storage unit
(VSU) (i.e. Temperature layer for a stratified tank or an FTVM tank) that
includes the energy content of each piece of equipment from their associated
streams. As the number of pieces of equipment increases then the amount of
energy input and output must increase accordingly. As a result, the amount
of energy transferred is the total amount shown on the HESN. In addition,
as the total amount of energy is used in the calculation of the volumes and
loading/unloading profiles.
However, another consideration is the handling of the display of the streams
on the HESN. To save space and avoid showing too many streams, the following conditions are applied:
- If streams in the shared piece of equipment have the same temperatures,
then only the stream with the largest HEX area is shown as a single stream
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on the HESN. This approach also promotes the design idea to reuse a heat
exchanger if possible.
- If the streams have different temperatures then they are all shown on the
HESN regardless if they are in the same piece of equipment.
Note: Streams within the same equipment but having different Tin and Tout
values are calculated and displayed separately (i.e. each stream is treated separately in its own equipment and heat exchanger). However, in practice, heat
exchangers containing streams within the same IL and defined in the same
equipment should, when ever possible during detailed design, be considered
for reuse despite their differences in temperatures. The other area values are
displayed on the HESN when placing the mouse over a heat exchanger to
show the tooltip.
Finally, streams in a shared equipment that have isothermal phase change
(PC) segments have to be handled in a special manner. Internally, this means
that an algorithm uses a pseudo quality to proportion the amount of heat
a particular PC segment transfers to a particular intermediate loop to the
total amount of heat in the curve segment made up of the shared stream
segments with phase change. This proportion is now used in calculating for
each segment (in the shared equipment) the area required. The largest area
is then displayed with the other areas shown in a tooltip. This algorithm
design automatically handles the case of 2 IL/HSs that have a middle VSU
temperature that divides up the phase change region defined by streams in
a shared equipment on the ISSP curve. The pseudo quality at the middle
temperature heat value for the IL is used to calculate a quality used in each
stream segment as noted above.
It must be noted that in the case of multiple shared equipments with the same
isothermal phase change segment temperatures, they each must be handled
separately. This means a small delta is automatically applied of 0.1 K to
each shared equipment temperatures with phase change and the algorithm
applied as noted above for each individual shared equipment.

10.4

Indirect Heat Recovery Analysis Support
Tools

To allow the user to quickly focus on the important information during the
analysis of an indirect heat recovery Target Result, two workflow buttons
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have been implemented. As seen in Fig. 10.2 a Previous and Next button are
displayed in the header of the dockable window itself.
The Previous button shows the following charts and data grids:
 ISSP Chart
 Required # of IL/HS vs. HR Chart
 Sources and Sinks Tables

The Next button shows the following charts and data grids:
 ISSP Chart
 Loading and Unloading Profile Chart
 Capacity Limitation Chart
 Specification Data Grid
 Heat Storage Only Savings/Costs Data Grid

Note: Different combinations of charts and data grids can be arranged by
selecting directly on the associated visualizer tabs. The sizing of each item
can be changed by repositioning the window dividers. However, to quickly
and conveniently return to the default setting simply select Previous or Next
buttons.
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Chapter 11
Integrate Energy Conversion Units
11.1

Introduction

An energy conversion unit (ECU) is a technique for transforming energy
from a lower quality to a higher quality (i.e. temperature) to improve energy
efficiency. This transformation allows better integration of waste heat into
a process and is an effective investment opportunity when properly placed
based on the pinch analysis method.
An ECU must be applied on the target result level. These ECUs allow the
investigation of integrating such unit operations into the stream population
for a given Target Result. In each case either one or more streams are inserted
directly as new streams to be included in the target calculation. Starting with
PinCH 3.0 is the ability to add an ECU to each operating case or time slice
of an individual target result. However, only one type of ECU can be applied
to each operating case/time slice.

11.2

Economic Calculations

Economic calculations for each ECU use a standard cost versus capacity
equation expressed as a power law of the capacity. Each ECU has its own
unique base quantity parameter given as follows:
 Heat Pump – Compressor Electricity
 Internal Combustion Engine – Generated Electricity
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 Mechanical Vapour Recompression – Compressor Electricity
 Thermal Vapour Recompression – Total Mass Flow of Steam
 Organic Rankine Cycle – Generated Electricity

For the heat pump (HP), mechanical vapour recompression (MVR) and thermal vapour recompression (TVR) the calculated investment costs simply contain the remaining costs not including the heat exchanger costs as these are
handled directly in the target area calculations. The following tables list the
economic parameters and their values [14].
Tab. 11.1: ECU Materials of Construction Economic Factors Table

fm Materials of Construction
Carbon steel (default)
Aluminium
Stainless steel (low grades)
Stainless steel (high grades)
Hastelloy C
Monel
Nickel and inconel
Titanium

Value
1.0
1.3
2.4
3.4
3.6
4.1
4.4
5.8

Tab. 11.2: ECU Economic Pressure Factors Table

fp pressure
Value
0.01 bar
2.0
0.1 bar
1.3
0.5 to 7 bar (default) 1.0
50 bar
1.5
100 bar
1.9
Tab. 11.3: ECU Economic Temperature Factors Table

ft Temperature
0 to 100°C (default)
300°C
500°C

Value
1.0
1.6
2.1

For the internal combustion engine, a module cost factor has been fitted based
on the data given in [15] for a standard CHP unit using natural gas. This
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module cost data already includes an installation factor for transport, installation and startup. The materials of construction, pressure and temperature
dependency factor shown above are not applied.
The default specific cost factors for each ECU are shown in the figures within
the following sections.

11.3

ECU Types

The main ECUs include the heat pump, mechanical vapour recompression,
thermal vapour recompression and the organic rankine cycle. Although not
strictly an ECU, the internal combustion engine has also been included in
this section.

11.3.1

Heat Pump

The heat pump models a standard heat pump cycle that includes a regenerator heat exchanger as shown in Appendix A.2. After setting the correct
parameters for the heat pump, two streams are created and inserted into
the target result stream population - a condenser stream and an evaporator
stream (see Figure 11.1). Changes to the parameters automatically update
the Target Result immediately unless an infeasible value is entered resulting in non-convergence results (e.g. entered condensation temperature above
critical temperature).
Grand Composite Curve:
To aid in the sizing of a heat pump ECU, different forms of the Grand
Composite Curve (GCC) have been included in the Heat Pump Optimization
group box. The different forms of the GCC include the following:
1. Process-Streams only
2. Process- and ECU-Streams w/o own Streams
3. Process- and all ECU-Streams
Option 1 is used to quickly see the original GCC before any ECU streams
have been included.
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Option 2 shows the GCC when all other ECU streams have been included
and the ECU of the present heat pump are not included (this GCC is most
effective for setting the temperature and power levels of the present heat
pump).
Option 3 displays the GCC with all ECU streams included to see how the
GCC of the associated target result operating case or time slice looks.
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Fig. 11.1: Heat Pump ECU Dialog

The input parameters of the heat pump are described in Table 11.4.
The coefficient of performance has been added to display the calculated COP
of the heat pump based on the thermodynamic cycle.
Note: Please see chapter 14.1 for information regarding the economic data
parameters. The base quantity for the heat pump is the compressor electrical
power.
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Tab. 11.4: Heat Pump Input Parameters
Heat Pump Parameters

Description
Refrigerant used in the thermodynamic cycle
calculation
Evaporation Temperature
Temperature in the evaporator at which
the refrigerant evaporates
Maximum Heat Rate at
The heat rate measured from the GCC
Evaporation Temperature
of the original composite curve before the
ECU is added at the given evaporation
temperature
Condensation Temperature
Temperature in the condenser at which the
refrigerant condenses
Maximum Heat Rate at
The heat rate measured from the GCC of
Condensation Temperature
the original composite curve before the
ECU is added at the given condensation
temperature
Evaporation or Condensation Flag to set if either the evaporation or
Duty is Entered
condensation duty is entered (Given this
value the other is calculated)
Evaporation Duty
The duty of the heat transferred in the
evaporator
Condensation Duty
The duty of the heat transferred in the
condenser
Isentropic Efficiency
Isentropic efficiency of compressor process
Drive Efficiency
Efficiency which includes mechanical
and electrical losses
COP
Overall efficiency of the heat pump
Pel - Compressor Electricity Total electrical requirement to operate
the compressor
Investment Cost Excluding
Total investment cost for heat pump
Heat Exchangers
components not including the heat
exchanger costs
Electricity Costs
Costs of electricity based on the price
set in the global economic dialog

Type of Refrigerant

Units
–
°C

kW

°C

kW

–
kW
kW
–
–
–
kW
CHF

CHF/
year
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Internal Combustion Engine

The internal combustion engine calculation is used for assessing the heat integration potential of a combined heat and power unit (CHP). Details related
to the algorithm and other calculation aspects are reviewed in Appendix A.3.
After setting the correct parameters for the engine, three streams are created
and inserted into the target result stream population - a water stream, an oil
stream and an exhaust air stream (see Fig. 11.2). Changes to the parameters
automatically update the target result immediately unless an infeasible value
is entered or non-convergence results.

Fig. 11.2: Internal Combustion Engine ECU Parameter Dialog. Module based economic parameters are used for the Economic Data [15].

The parameters of the engine are described in Table 11.5. The key parameter
is the desired electrical power generation (Pel) expected from the internal
combustion engine. This value is typically used by manufactures to specify
the capacity of the chosen engine.
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Note: Please see Chapter 14.1 for information regarding the economic data
parameters. The base quantity for the internal combustion engine is the generated electrical power Pel.
Tab. 11.5: Internal Combustion Engine Parameters

Engine Parameters
Pel
Exhaust Gas
temperature range
Water temperature
range
Oil temperature
range
Water heat
duty load ratio

Description
Generated electrical power of the engine
Start and end temperature of the
exhaust gas stream
Start and end temperature of the water
stream
Start and end temperature of the oil
stream
Heat duty load ratio used to calculate
the energy that can be derived from the
created water stream
Oil heat
Heat duty load ratio used to calculate
duty load ratio
the energy that can be derived from the
created oil stream
Exhaust Gas stream Heat recovery for the exhaust gas stream
heat recovery
based on flame temperature calculation
Water stream
Heat recovery approximated
heat recovery
for the water stream
Oil stream
Heat recovery approximated
heat recovery
for the oil stream
Fuel mass flow
Flow of the gas fuel
Air Factor
Ratio of air to fuel flow rate
Fuel Composition
Mole fractions of methane, ethane,
propane and butane in the fuel feed
Module Investment Total investment cost for the engine
Cost
components outside the combustion
gas exchanger cost

Units
kW
°C
°C
°C

–

–

kW
kW
kW
kg/s
–
mole/
mole
CHF

Note: The mass flow rate of the combustion gas is calculated and displayed
on a dry basis as is the norm in engineering calculations involving humid air
streams such as combustion gas.
The investment cost for the internal combustion engine is based on the module cost given in [15]. Given this module cost basis the weighting factors for
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temperature, pressure and materials of construction have been disabled. The
cost for internal heat exchangers are included in the module cost and only
those costs for heat exchangers to handle additional cooling for the exhaust
gas, water and oil can be handled separately in targeting or in detailed HEN
design.

11.3.3

Mechanical Vapour Recompression

The mechanical vapour recompression (MVR) models a standard compression cycle as shown in Appendix A.4. After setting the correct parameters
for the MVR and selecting a water vapour stream to be upgraded in the
compressor, two new streams are created and inserted into the target result
stream population (upgraded and reduced). The originally selected stream is
removed (see Fig. 11.3) from the stream population. Changes to the parameters automatically update the target result immediately unless an infeasible
value is entered or non-convergence results.
Grand Composite Curve:
To aid in the sizing of a MVR ECU different forms of the Grand Composite
Curve (GCC) have been included in the MVR Optimization group box. The
different forms of the GCC include the following:
1. Process-Streams only
2. Process- and ECU-Streams w/o own Streams
3. Process- and all ECU-Streams
Option 1 is used to quickly see the original GCC before any ECU streams
have been included.
Option 2 shows the GCC when all other ECU streams have been included and
the ECU of the present MVR are not included (this GCC is most effective
for setting the temperature and power levels of the present MVR).
Option 3 displays the GCC with all ECU streams included to see how the
GCC of the associated target result operating case or time slice looks.
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Note: The water vapour stream to be upgraded must be defined as
R718 fluid which uses the equation of state given in [4].

Fig. 11.3: Mechanical Vapour Recompression ECU Parameter Dialog
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The parameters of the MVR dialog are described in the following table.
Note: Please see Chapter 14.1 for information regarding the economic data
parameters. If the selected Vapour Stream to Upgrade exists in multiple
pieces of equipment the investment and operating costs& # will be increased
proportionally due to the greater Pel necessary for each equipment. The base
quantity for the MVR is the compressor electrical power.
Mechanical Vapour
Recompression Parameters

Description

Units

Vapour Stream to Upgrade Water vapour stream to be upgraded by

Condensation Temperature Upgraded Vapour
Maximum Heat Rate at
Condensation Temperature

Heat Rate of Selected
Waste Heat stream
Mass Flow Rate of
Selected Waste Heat Stream
Isentropic Efficiency
Drive Efficiency
Investment Cost Excluding
Heat Exchangers
Electricity Cost

passing through the compressor (limited
to refrigerant R718 water fluid)
Temperature at which the upgraded
vapour stream it to condense at
The heat rate measured from the GCC
of the original composite curve before
the ECU is added at the given condensation
temperature
The heat rate taken directly from the
selected waste heat stream
Flow rate portion of the waste heat stream
to be upgraded in the compressor
Isentropic efficiency of the compressor
process
Efficiency which includes mechanical and
electrical losses
Total investment cost for MVR components
not including the heat exchanger costs
Cost of electricity based on the price set in
the global economic dialog

–

°C

kW

kW
kg/s
–
–
CHF
CHF/
year
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Thermal Vapour Recompression

The thermal vapour recompression (TVR) models a standard ejector as
shown in Appendix A.5. After setting the correct parameters for the TVR
and selecting the water vapour stream to be upgraded by steam injection, two
new streams are created and inserted into the target result stream population
(upgraded and reduced). The originally selected stream is removed (see Fig.
11.4) from the stream population. Changes to the parameters automatically
update the target result immediately unless an infeasible value is entered or
non-convergence results.
Grand Composite Curve:
To aid in the sizing of a TVR ECU different forms of the Grand Composite
Curve (GCC) have been included in the TVR Optimization group box. The
different forms of the GCC include the following:
1. Process-Streams only
2. Process- and ECU-Streams w/o own Streams
3. Process- and all ECU-Streams
Option 1. is used to quickly see the original GCC before any ECU streams
have been included.
Option 2. shows the GCC when all other ECU streams have been included
and the ECU of the present TVR are not included (this GCC is most effective
for the temperature and power levels of the present TVR).
Option 3. displays the GCC with all ECU streams included to see how the
GCC of the associated target result operating case or time slice looks.
Note: The water vapour stream to be upgrade must be defined as R718
(Water) fluid which uses the equation of state given in [4].
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Fig. 11.4: Thermal Vapour Recompression ECU Parameter Dialog

The parameters of the TVR are described in the following table.
Note: Please see section 14.1 for information regarding the economic data
parameters. If the selected Vapour Stream to Upgrade exists in multiple
pieces of equipment the investment and operating costs will be increased
proportionally due to the greater steam rate necessary for each equipment.
The base quantity for the TVR is the total steam mass flow rate.
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Thermal Vapour
Recompression Parameters

Required Mass Flow of

11. Integrate Energy Conversion Units
Description

Water vapour stream to be upgraded
by passing through the TVR (limited
to refrigerant R718 water fluid)
Condensation
Temperature at which the upgraded
temperature
vapour stream is to condense
Steam Pressure
Pressure of saturated steam used to
upgrade the water vapour stream to the
required condensation temperature
Maximum Heat Rate at
The heat rate measured from the GCC
Condensation Temperature of the original composite curve before
the ECU is added at the given
condensation temperature
Heat Rate of Selected
The heat rate taken directly from the
Waste Heat Stream
selected waste heat vapour stream
Required Mass Flow Rate of Flow rate of waste heat vapour stream
Vapour Stream To Upgrade to be upgraded in the compressor
Expansion Efficiency
Efficiency of the expansion process
Drive Efficiency
Efficiency which includes mechanical
and electrical losses
Steam Mass Flow Rate
Calculated mass flow rate of required
steam to upgrade the waste heat stream
to the required condensation
temperature
Investment Cost Excluding Total investment cost for TVR
Heat Exchangers
components not including the heat
exchanger costs

Units
kg/s

Vapour Stream to Upgrade

°C

bar

kW

kW
kg/s
–
–
kg/s

CHF
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11.3.5

Organic Rankine Cycle

There are two common variations of the Organic Rankine Cycle (ORC) that
can be modeled. They are the “basic ORC” (Figure 11.5 (a)) and the “regenerative ORC”(Figure 11.5 (b)). In PinCH at present only the basic ORC
type is modelled and it is assumed that an intermediate loop (IL) will be
used to transfer heat from the process to the evaporator. This assumption
of an IL decouples the investment cost of the ORC from the HEN grid area
calculation allowing a module cost to be used directly.
Once the correct parameters for the ORC have been set, one stream will
be created and inserted into the target result stream population. The stream
modeled in PinCH is the evaporator stream of the IL. Changes to the parameters automatically update the Target Result immediately unless an infeasible
value is entered resulting in non-convergence results.
(a)

(b)

4

3

G

G

2

5
4

3
2

1
Heat Exchangers:

6

1

Heat Input to ORC
Heat Output from ORC
Regeneration

Fig. 11.5: Basic and Regenerative ORCs showing the main streams and associated
heat exchangers.

Grand Composite Curve:
To aid in the sizing of a ORC ECU, different forms of the Grand Composite
Curve (GCC) have been included in the ORC Optimization group box. The
different forms of the GCC include the following:

150

11. Integrate Energy Conversion Units

1. Process-Streams only
2. Process- and ECU-Streams w/o own Streams
3. Process- and all ECU-Streams
Option 1 is used to quickly see the original GCC before any ECU streams
have been included.
Option 2 shows the GCC when all other ECU streams have been included
and the ECU of the present heat pump are not included (this GCC is most
effective for setting the temperature and power levels of the present heat
pump).
Option 3 displays the GCC with all ECU streams included to see how the
GCC of the associated target result operating case or time slice looks.
Note: In the PinCH software only the values for the white fields need to be
entered; green fields will be calculated automatically (Figure 11.6).
Displayed on this background process GCC of the PinCH ORC ECU dialog
are the IL stream and ORC evaporation stream. This helps to check if
the ORC is properly integrated relative to the process GCC. The IL on the
process side is the key stream that is modeled in PinCH and included in
the target result and HEN design. Each has been shifted according to the
process ∆ Tmin . All the other streams are also calculated internally in the
thermodynamic cycle calculation. More information is given in Appendix
A.6 and how to integrate the ORC ECU in a target result is in Section 11.4.
Note: Presently, only the IL stream and evaporation stream are displayed on
the GCC of the PinCH ORC ECU dialog. Also, the ability to set a separate
ORC ∆ Tmin is not yet available.
The input parameters of the ORC are described in Table 11.4. Please see
Chapter 14 “List of Symbols” for information regarding the economic data
parameters. The base quantity for the ORC is the net amount of generated
electricity.

11.3 ECU Types

151

Fig. 11.6: Organic Rankine Cycle ECU dialog showing the placement of the intermediate loop (IL) stream and the associated refrigerant evaporation on
the GCC as well as key process information and economic data.
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Tab. 11.6: ORC Input and Calculated Parameters
ORC Parameters

Description
Heat Input
The heat flow removed from the process and
used in the ORC
Cold Temperature IL
The evaporator inlet temperature of the IL
Hot Temperature IL
The evaporator outlet temperature of the IL
Working Fluid
The organic fluid used for the ORC
Minimum Temperature
The minimum temperature difference to be
Difference ORC
used in the ORC is defined by the user
Condensation Temperature Temperature during condensation of the organic
working medium in the condenser of the ORC
Condensation Pressure
Pressure in the condenser of the ORC during
condensation
Evaporation Temperature
Temperature during evaporation of the organic
working medium in the evaporator of the ORC
Evaporation Pressure
Pressure in the evaporator of the ORC during
evaporation
Drive Efficiency Pump
Efficiency of the pump including mechanical
and electrical losses
Isentropic Efficiency Pump
Isentropic efficiency of the pump
Drive Efficiency Turbine
Efficiency of the turbine including mechanical
and electrical losses
Isentropic Efficiency Turbine Isentropic efficiency of the turbine
Heat Output Condenser
The heat output over the condenser of the ORC
Power Input Pump
The electrical power Pel, pump required to
operate the pump
Power Output Turbine
The electrical power Pel, turb output by the
turbine
Net Power Output ORC
The absolute value of the turbine output power
Pel, turb less the absolute value of the power
input to the pump Pel, pump
Overall Efficiency
The ratio of the net power output by the ORC
to the heat input Qin into the ORC

Units
kW
°C
°C

–
K
°C

bar(a)
°C

bar(a)
–
–
–
–
kW
kW
kW
kW

–
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How to Integrate an ECU

In order to integrate an ECU a target result has to be first created as shown
in chapter 7.3. An ECU belongs to a particular target result and is dependent
on the associated set of streams assigned when selecting the processes for the
particular target group. If a target result contains multiple operating cases
or is a single product batch process with multiple time slices then an ECU
can be selected for each operating case or time slice. However, only a single
instance of a particular ECU type can be added per operating case or time
slice (e.g. only one heat pump instance per operating case or time slice).
To integrate an ECU:
1. Select and highlight the particular Target Result node in the Target Explorer
2. Right click on the Target Result node to view the context menu and select
Add Energy Conversion Unit... > Add Heat Pump... > <OC1...OCn>
Note: either operating cases (OCs) or batch process time slices (TSs) can
be selected.
3. Enter the appropriate process information on the ECU mask to configure
the ECU according to the desired sizing
Note: Presently PinCH 3.2 does not yet fully support the integration of
ECUs when a MOC Group has been defined with semi-continuous processes
Therefore, it is recommended to model each operating case separately in this
case and not use the MOC group.
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Chapter 12
Turn Saving Opportunities into
HENs
12.1

Introduction

Following the calculation of a Target Result as discussed in section 7, a detailed heat exchanger network (HEN) design can be developed. This last
step (step 10 - section 3.1) of the PinCH process requires substantial effort
as there can be many possible solutions that need to be evaluated and compared. Also, in the case of retrofitting an existing process, the user will be
required to balance the need to derive a network that achieves the calculated
energy and cost targets with the realities and constraints of existing capital
expenditure. It is a difficult process; however, the HEN design capabilities
of PinCH provide an easy framework to rapidly develop new designs and to
compare them. In PinCH there are three main types of HEN grids:
1. MER HEN Grid
2. Relaxed HEN Grid
3. HEN Grid which Includes Soft Stream Parts
In all cases can either a fully balanced HEN grid, which includes all intermediate utilities, or a grid with just default hot and cold utilities be created.
In order to create a heat exchanger network with maximum energy recovery
(MER), the network is divided into two separate parts by the pinch temperature (a part that is entirely above the pinch line and a part that is entirely

156

12. Turn Saving Opportunities into HENs

below as shown in Fig. 12.1. This figure highlights many of the key user
interface graphical components available on the PinCH HEN grid before beginning to build the network. As can be seen in the figure, two completely
independent thermodynamic systems are formed that can be evaluated independently from each other (one above the pinch temperature and one below
the pinch temperature). This division aids in reducing the complexity of the
design problem and maintains one of the key pinch design rules of ensuring not to transfer heat across the pinch. The theory and documentation
of the pinch design rules are not covered in this manual and the reader is
recommended to review references [1 - 2],[5 - 10] and [14].
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CPout → out means:
Energy flows away
from the pinch

Hot Utility (no heating
possible under pinch)

Subsystem above the pinch

CPin → in means: Energy
flows into the pinch

Temperature
value [°C]

Heat Duty [kW]

Subsystem under the pinch

∆Tmin, opt = 40K

CPin

CPout

Temperature of hot
composite curve at pinch
Pinch temperature of 60°C

Fig. 12.1: Heat Exchanger Network Grid Parts

Cold Utility (no cooling
possible above pinch)
Temperature of cold
composite curve at pinch
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How to Create a HEN Grid

A HEN grid is bound to a particular Target Result and its corresponding
∆ Tmin for the given composite curve. Therefore, upon creating a HEN grid
the pinch temperature and the associated utility values and streams are
used to initialize the streams on the HEN grid.
To Create a MER HEN Grid:
1. Create a Target Result (see section 6).
2. Right click on the node of the created Target Result and select Add HEN
-> Add MER HEN.
Note: If multiple utilities have been included in the Target Result a message
box will appear asking if you would like to create either a balanced grid,
which includes all the internal utilities, or a standard MER HEN grid where
only the default Hot and Cold Utility are included.
A Relaxed HEN Grid allows the evaluation and analysis of an existing or
retrofit network in order to compare with the MER HEN grid designs. Cross
pinch heat transfer is represented by a diagonal line connecting a hot and cold
stream heat exchanger (whereas non-cross pinch heat transfer is always shown
with horizontally placed heat exchangers). In addition, ∆ Tmin is allowed to
be not be respected permitting heat exchanger connection to be made where
this value is less than that specified in the Target Result.
To create a Relaxed HEN Grid:
1. Create a Target Result (see section 7).
2. Right click on the node of the created Target Result and select Add HEN
> Add Relaxed HEN.
A HEN Grid with Soft Stream Parts allows the design of HEN grids which
include the soft stream parts that were excluded in the Targeting calculation
(see sections 4 and 7). The soft energy that was excluded is shown in a
Soft Pool graphical object which allows the exceeding of the calculated MER
values for the hot and cold utilities. This ensures the HEN grid energy balance
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can be completed, yet provides the flexibility for the user to create HEN
designs that use the soft parts when necessary.
Note: This functionality is only recommended for expert users as a considerable amount of knowledge and experience is necessary in order to make the
correct decision when to violate the MER design and use such soft streams
directly.

12.3

Adding an Heat Exchanger

Heat exchanger matches can be easily added to the HEN grid using drag and
drop functionality. The connection of two streams is limited by several key
rules:
 Only a hot and a cold stream can be matched together
 Temperature crosses are not allowed
 The process ∆ Tmin must be respected (except for a Relaxed HEN Grid)
 The energy balance must be maintained

Fig. 12.2 illustrates an heat exchanger network grid with several heat exchangers added to a MER HEN design.
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Depiction of an Heat Exchanger
in PinCH

Depiction of a Split in PinCH

Fig. 12.2: Depiction of Heat Exchangers and Stream Split on HEN Grid

Note: PinCH will allow an HEX to exceed its energy balance limitation, but
will mark the heat exchanger in red.
How to Add an Heat Exchanger:
1. Create a HEN Grid
2. Left click on a hot stream to add a stream part
3. Left click on a cold stream to add a stream part (Note: Ensure the M Cp
rule based on the Pinch Design Method is maintained - M Cp of a stream
going in a direction away from the pinch is greater than the M Cp of a
stream going towards the pinch)
4. Left click on one of the newly added stream parts and hold and drag to
the other stream part (ensure both stream parts are on the same vertical
row as diagonal placement is not allowed for cross pinch heat exchange)
5. Release the left mouse button to create the match.
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6. Double click in the HEX duty box to tick-off the entire duty of one of the
stream (Note: According to the Pinch Design Method, it is recommended
to always use the entire duty of one of the streams in a match)
7. Optionally, the temperature coming out of the stream parts can be directly
specified
Note: PinCH will automatically check for the pinch design rules and ensure
the energy balance is maintained. If the pinch design rules are not met then
matching stream parts will be disabled. In addition, if an exchanger becomes
pinched internally PinCH will only tick-off the duty up to the point of maintaining the ∆ Tmin .

12.4

Splitting and Merging

The ability to split a stream is very important in order to be able to completing a HEN design and not be limited by the M Cp values of the streams
above and below the pinch. The rules of when to split a stream are not covered in this document. However, the user is encourage to review the following
references for more information [1 - 2],[5] and [10].
How to Split a Stream:
1. Create a MER HEN Grid
2. Left click on either a hot stream or a cold stream and select Split Stream
3. Select the M Cp box associated with one of the branches and enter a new
M Cp value
Note: PinCH will automatically update the other MCp value and adjust the
energy duties in each branch. Connections to other appropriate streams can
now be made (see Fig. 12.3).
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Fig. 12.3: Completed MER HEN Design Showing a Split

Merging is limited to single streams that were originally split. The merge
must be isothermal and require the placing of a stream part on each split
branch before merging.
How to Merge Stream Branches:
1. Create a MER HEN Grid
2. Split a stream
3. Add a stream part to each created stream branch
4. Left click on either branch and select Merge Branches
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5. Select the MCp box associated with one of the branches and enter a new
MCp value as required

Fig. 12.4: HEN Grid With a Stream Merge

Note: Heat exchanger parts will be automatically added to each branch if
a merge is made to a split that does not contain any manually added heat
exchanger parts.
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Analyzing Results

There are several graphical objects that can be used to analyze the results
of a HEN grid design. The first is the HEN Table. This table displays upon
initialization the Targeting Result data. The data is conveniently broken out
into energy recovery values and utility values. As heat exchangers are added
to the HEN grid then the design values are automatically added to the Design
row in the table. This provides a convenient layout for comparing the design
with targets in helping determine if the design is appropriate or not. Fig.
12.5 shows the completed result for the HEN design given previously in Fig.
12.3 and shows how close the target and design values are.

Fig. 12.5: HEN Table for Completed HEN Design

A second method of analyzing results is to use the HEX table (see Fig.
12.6). On this table is displayed the specific information for each placed
HEX on the HEN Grid. The information includes the hot and cold streams
properties and well as the HEX area, LMTD, k-value, cost, profitability and
type selected. This data grid conveniently allows the analysis and comparison
of each exchanger with the others.
How to Open the HEX Table:
1. Create a MER HEN Grid
2. Add an Heat Exchanger
3. Select the line joining the two heat exchanger part (Note: the line should
be highlighted in black)
4. Double click the black highlighted line to open the HEX Table.
Finally, the HEX can easily be used to calculate the total real cost of the
design by adding up the cost column values. This can be simply accomplished
by copy and paste of data grid information into a spread sheet program such
Microsoft Excel.
The individual HEXs are calculated by default assuming counter current heat
exchange. However, it is possible to change the form factor used in the UA
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Fig. 12.6: HEX Table for Complete HEN Design

calculation to better represent a non-ideal situation in a real plant setting.
Fig. 12.7 shows the options available for changing the parameters that affect
the area and cost calculation of the individual heat exchanger. The film heat
transfer coefficient (α) values are initialized from the stream table; however,
they can be overwritten in the Heat Transfer Coefficient boxes. The same is
true for the Heat Exchanger Cost parameters. Finally the calculated form
factor correlations are derived from [11].

Fig. 12.7: HEN Sizing Options Dialog
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HEN Design Support Tools

Two tools presently exist to support the analysis of heat exchanger networks
and heat exchangers. The first is the Driving Force Plot (see Fig. 12.8).

Fig. 12.8: Enthalpy versus Temperature Plot and Driving Force Plot

This graphic is useful for assessing how well a particular heat exchanger approximates the vertical heat transfer model. The plot is created by calculating
the differences in terminal temperatures of a counter-current heat exchanger
versus the Driving Force Plot derived from the composite curve. The driving force plot is simply the temperature difference at the inflection points
of the composite curve versus the cold temperature at the same point. The
application and analysis of the driving force plot is reviewed in [1].
The second support tool is the Enthalpy versus Temperature Plot (HT Plot
- see Fig. 12.8). This plot provides an effective means of checking the driving
force of the selected heat exchanger relative to the given ∆ Tmin . This plot is
very effective at quickly visualizing the driving forces within a heat exchanger,
in particular the LMTD which has a significant impact on the required area.
In addition, an internal heat exchanger pinch can be identified if multiple
segments are used that result in a point within the heat exchanger where the
∆ Tmin occurs (and not at the end of the exchanger).
Given that the HEN grids can become quite large for stream populations
greater than ca. 15 streams, the user can zoom on the HEN grid to focus on
specific regions of the design. This is done by first positioning the cursor over
the region to focus on and then using the mouse wheel to zoom in on this
region.
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The order of the streams in the HEN Grid are initialized directly from the
order of the streams in the working stream table. The order of the streams
in the working stream table can be simply changed before adding the HEN
by selecting Alt + up/down arrow keys (same as for the process stream table
itself). However, the order of the streams on the HEN grid itself can be
shifted directly by clicking on the name of a stream and dragging left or
right.
Another effective functionality to help in building a HEN design is the ability
to add rows within the middle of the HEN grid before or after previously
placed HEXs. This action prevents the overlap of HEXs on the same row and
can be done by moving the cursor over the HEN gird to the location where a
new row should be inserted. A light grey bar is shown to indicate a row can
be inserted. Simply clicking at this location inserts the new row.
Finally, detailed stream information can be viewed directly on the HEN
grid by positioning the mouse cursor directly over the blue or red line
representing either the cold or hot stream. A tooltip is automatically
displayed to show the stream name and the specific segment data such as
Tin, Tout, CP and total enthalpy change.
Note: The Area-Temperature tool does not presently support segmented
streams. Also when Tin Tout is set on the same stream then a simple
iteration algorithm is used to get the correct LMTD for the given area and
duty.
Exporting Targeting Information for Multiple OCs/TSs HEN Design:
For Separate Design target results, a feature is available to allow the
exporting of the area matrices internally calculated for each multiple
operating case (OC) or batch time slice (TS).
To Export Area Matrices:
1. Create a Target Result (see section 7).
2. Right click on the node of the created Separate Design Target Result and
select Export Area Match Matrices.
3. On the Export Area Match-Matrices dialog select the OC/TS of interest.
4. Set the starting and ending ∆ Tmin values and step size to be used in
creating the set of Area Match-Matrices.
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5. Select Export to generate the matrices.
6. Save the generated csv file to an appropriate location.
For Combined Supertargeting target results, it is possible to export the internally calculated Conventional Design matrices. This includes the following:
 Candidate Match Matrix (in conventional design only one match (called
a candidate match) can be re-used on each process stream. This matrix
is results from the conventional design supertargeting LP optimization
and highlights the matches that must be placed to reach the targets
[16] and [17])
 Maximum Area Matrix (per Operating Case or Time Slice the maximum area that can be installed between each possible match between
an equipment with a hot stream and an equipment with a cold stream)
 Pinch Match Matrix (describes all the possible matches at the pinch
and merged together for all OCs or TSs)

More information is given in Appendix A.9.
To Export Conventional Design Matrices:
1. Create a Combined Supertargeting Target Result (see section 8).
2. Right click on the node of the created Target Result and select Export
Conventional Design Matrices.
3. Select either i. To Clipboard or ii. To *.csv.
4. Save the generated csv file to an appropriate location.
5. Either paste the data directly into a calculation program directly (e.g. MS
Excel or Google Sheets) or open the *.csv directly.
Multiple OC/TS HEN Design Support Tools:
The general strategy of HEN design for multiple OCs or TSs is based on the
pinch design method used in creating the HEN. However, given the goal of
reusing heat exchangers the method is extended to handle this reuse. The
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method again starts first where the problem is most constrained at the pinch
(design philosophy: do the most difficult task first). But priority is given to
common pinch matches that reuse HEXs otherwise, if placed later, there
is less scope for optimising the use of area because of HEN structural constraints. For these selected key matches vertical heat transfer is used for their
design. However, for the remaining non-key matches criss-cross heat transfer
may have to be used to maximize the area reuse. The result is several of these
non-key HEXs could violate the ∆ Tmin and may even extend from one side
of the pinch to the other. Nevertheless, minimising total cost by minimising
the number of units (i.e. tick-off matches) is first priority, while minimisation
of area is only second priority (i.e. under the normal assumption that the
number of HEX matches has a larger effect on investment cost than the area).
Two main HEN design support tools are available that together with
the area matrices and conventional design matrices noted above can be used
to help the user design a flexible overall HEN. The details of how to do such
design is in Appendix A.9.
To help easily and quickly identify common matches in different OCs or TS,
the Mini-map tool is available. It is shown on the top edge of the HEN grid
whenever multiple OCs or TSs are present (see Fig. 12.9)
The map simply shows the connections between pieces of equipment (typically a pipe with a stream flowing in it, but could be a batch reactor). The
first match between the same two pieces of equipment are shown as a dashed
line. When a second match between the same two pieces of equipment is
added to another OC or TS then the lines are shown solid. The match with
largest area is shown in bold to easily identify the key match. Fig. 12.10 show
TS 2 to compare with the TS 1 shown in Fig. 12.9.
To be able to calculate the effects of criss-cross heat transfer the AreaTemperature support tool is available. It allows the quick calculation of
different combinations of temperature for a given area.
How to Use the Area-Temperature Tool:
1. Create a Combined Supertargeting Target Result (see section 8) or Batch
Process Target Result
2. Right click on the node of the created Target Result and select Add HEN...
-> Add MER HEN
3. Left click on a hot stream to add a stream part
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Fig. 12.9: Heat exchanger Mini-map Tool displaying at top edge of HEN grid when
multiple OCs or TSs exist. TS1 is shown with the largest area at 52
m2 between equipment p1.1 and p3. A dashed line is shown between
equipment p4 and Reactor as it is the only HEX in all TSs.

4. Left click on a cold stream to add a stream part (Note: Ensure the M Cp
rule based on the Pinch Design Method is maintained - M Cp of a stream
going in a direction away from the pinch is greater than the M Cp of a
stream going towards the pinch)
5. Left click on one of the newly added stream parts and hold and drag to
the other stream part (ensure both stream parts are on the same vertical
row as diagonal placement is not allowed for cross pinch heat transfer)
6. Release the left mouse button to create the match.
7. Double click in the HEX duty box to tick-off the entire duty of one of the
streams (Note: According to the Pinch Design Method, it is recommended
to always use the entire duty of one of the streams in a match)

12.6 HEN Design Support Tools
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Fig. 12.10: Heat exchanger Mini-map Tool displaying at top edge of HEN grid for
TS 2 illustrating the easy comparison with TS 1 and identification of
key HEX with largest area.

8. Right click on either the HEX stream parts and select Display AreaTemperature Tool (The dialog as shown in Fig. 12.11 is shown)
9. Select two of the four temperature check boxes to force calculation of the
other two temperatures as required
10. Enter an area as required to see the effects of reusing a greater value (e.g.
from the key HEX in another OC or TS)
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Fig. 12.11: Area-Temperature Tool showing the effect of using a larger area

Note: The Area-Temperature Tool is a separate dialog for checking the effects
of HEX area on the terminal temperatures. The results are only shown in
the dialog and not reflected in the original HEN grid.
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Chapter 13
Menu Items, Keyboard Shortcuts
and the Workbench
13.1

Menus Items and Keyboard Shortcuts

PinCH includes many menu items to allow the user to do actions such as
manage the project and its settings, customize the layout, import and export
data and access help online information. In addition, the PinCH menus display equivalent keyboard shortcuts next to many of the menu commands, so
the user can execute commands directly from the keyboard.
It should be noted that the menu items are not always available and depend
on the state of the program or action being executed. An example is the
Save menu item as it will be disabled when no changes have been made to a
project. If a change has been made then this menu item is enabled and the
program title is appended with “*” to indicate that changes have been made
and must be saved or they will be lost. Upon closing you will be asked to
confirm if you would like to save your changes.
The following tables list the commands presently available in PinCH and any
associated keyboard shortcut that exists.
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Tab. 13.1: File Menu Items

File Menu Items
New Project
Open Project
Close Project
Save Project
Save Project As...
Import Stream Table
Export Stream Table
Settings
Exit

Keyboard Shortcut
Ctrl + N
Ctrl + O
Ctrl + S

Tab. 13.2: Edit Menu Items

Edit Menu Items
Undo
Redo
Copy
Paste

Keyboard Shortcut
Ctrl + Z
Ctrl + Y
Ctrl + C
Ctrl + V

Tab. 13.3: View Menu Items

View Menu Items
Save Custom Layout
Load Custom Layout
Restore Initial Layout
Process Stream Table
Utility Stream Table
Project Explorer
Target Explorer
Properties
Help
Results Output

Keyboard Shortcut

13.1 Menus Items and Keyboard Shortcuts
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Tab. 13.4: Help Menu Items

Help Menu Items
PinCH Process Survey
PinCH Home
Help
About

Keyboard Shortcut

F1

Note: PinCH 2.0 can be opened with PinCH 3.2 for backward compatibility.
PinCH will automatically convert a PinCH 2.0 file to the new compressed
forward and save the file with the same name but with the .PinCH extension.
the original .xml file is still available. However, files created in the PinCH
3.2 format cannot be read by PinCH 2.0.
The function of most of the menu items can be understood from the menu
item name. Several of the more important menu items are listed and explained
next.
 Settings

After selecting the Settings menu item a new settings dialog is displayed
in the details docking position in the center of the workbench. This
dialog allows the user to change the display of the help information,
change the engineering unit set and change the currency. The engineering unit sets are the combinations of either kW/kWh, MW/MWh and
kW/MWh (the default). The currency is limited to CHF (the default),
USD and Euro whereby the a conversion rate base on CHF must be
supplied to calculate USD or Euro accordingly.
To configure the project settings:
1. Select the menu item File then Settings
2. The User Interface tab can be selected to choose different user
interface display types to be shown or hidden.
3. The Units tab to change to different engineering unit sets to be
shown in the results.
4. The Currencies tab allows different currencies to be selected to
be shown in the results (e.g. Euro oder US Dollar). If you wish
to use a different currency as CHF, then the currency conversion
rate must be given.
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5. The General tab contain a collection of defaults used for calculations (e.g. ambient temperature used in calculating the Carnot
factor).
6. The Licensing tab allows activation and management of the software license. Most importantly, on this tab the name of the licensing server (in the case of using a network license) can be simply
entered and activated. In addition, time period licenses can be requested for an update by selecting to open the Trial/Activation
dialog and then using the Request License Update button (note:
this functionality is not applicable for the trial version of the software). See PinCH 3.2 Installation User Manual.pdf for more information.
It is recommended to change all the settings before beginning the pinch
analysis.
Note: The unit sets are in almost all cases only for changing the display
values shown in data grids or on charts. Heat flow values are always
readonly in kW. However, in the indirect heat recovery target result
the energy value can be entered in either kWh or MWh, as well as the
currencies can be entered in chosen currency set.
 Import and Export Data

Several options exist to import or export data from PinCH. The menu
item Import Stream Table and Export Stream Table can be used to
easily transfer data from Excel (see section 4.7 for an example). In
addition, each data grid used for displaying results can be copied and
pasted directly into applications such as Excel or Word.
Additional features are available to allow the exporting of key targeting
information. For separate design targeting results, the area matrices
internally calculated for each multiple operating case (OC) or batch
time slice (TS) can be exported. In addition, for Conventional Design
supertargeting, the Candidate Match Matrix, PinCH Match Matrix and
Maximum Area Matrices can be easily exported to external programs
such as MS Excel or Google Sheets. Please see section 12.6 for more
information.

13.2 Keyboard Shortcuts - Stream Table

13.2
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Keyboard Shortcuts - Stream Table

Several keyboard shortcuts are available within PinCH to enable commands
to be executed when working with the stream table.
How to Change the Order of Streams:
1. Select a stream in the stream table.
2. Press and hold down the Alt key.
3. Select the Up or Down arrow key to move the stream to a different position
in the table.
Note: The order of the stream in the working stream table can also be reordered independently from the main stream table. Conveniently, the order
of the streams in the working stream table are used to initialize the stream
order of the HEN grid when first created. The user can control the HEN grid
stream order by placing at the top of the working stream table the streams to
be placed starting on the left ht side in the HEN grid as initialization. However, the streams can then be easily be reordered directly on the HEN
Grid by clicking on the stream name and dragging left or right!
How to Assign Multiple Rows to a Process:
In section 6.3 it was shown how to assign a single stream to a process. The
following illustrates how to assign multiple streams.
1. Press and hold the Ctrl key.
2. Select specific rows in the Stream Table to highlight.
3. Assign the selected streams to the working stream table.
Note: Consecutive rows of streams can be selected by pressing and holding
the Shift key and then selecting a stream at another location in the stream
table. All the streams between the two selected streams will be highlighted
and can the be assigned to the working streams table.
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Keyboard Shortcuts - HEN Grid

Several keyboard shortcuts are available within PinCH to enable commands
to be executed when working with the HEN Grid.
How to Insert an Empty Row in the HEN Grid:
A HEN Grid design is built starting from the pinch temperature and working
away from the pinch. To give the flexibility to place heat exchangers (HEX)
at specific vertical locations (e.g. to avoid overlap of HEXs) an empty row in
the HEN Grid can be inserted at any vertical position.
1. Create a HEN Grid (see section 12.2).
2. Position the mouse cursor over the HEN Grid at the vertical location you
wish to add a new row for a HEX (note: a light grey horizontal line will
be shown).
3. Click the left mouse button.
4. An empty row will be placed immediately at the selected location.
How to Zoom and Pan on the HEN Grid: (ctrl and mouse wheel)
1. Open a previously created HEN Grid.
2. Ensure the mouse cursor is positioned over the HEN grid.
3. Zoom in or out by using a mouse wheel or equivalent.
4. Press the Ctrl button while zooming will pan directly to a specific point
on the HEN Grid.

13.4

Workbench

13.4.1

Dockable Windows

The workbench is composed of dockable windows that can be moved and
repositioned to any docking position on the workbench. In addition, the dockable window can be left in a floating position to be displayed , for example,

13.4 Workbench
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on a second computer screen. Both of these options allow easy comparison
of results or data that has been entered (i.e. Chap. 7.4 Fig. 7.3).
However, the situation may arise whereby you want to automatically return
to a simpler default layout of the windows. As shown above for the View
commands (Tab. 13.3) it is possible to restore the original default layout (i.e.
Restore Initial Layout menu) used when first installing PinCH. In addition
you can restore a custom layout that you can save at any time that maintains
your desired dockable window arrangement (i.e. Save Customer Layout/Load
Customer Layout).

13.4.2

Properties Window

On the properties window the user can see specific data related to any object
selected in the PinCH user interface. For example, selecting a stream in the
stream table will display in the properties window the stream name and the
equipment that has been assigned. These values can be changed as needed.
Other important objects that display data in the Properties Window includes
the Equipment and the individual OC/TS Target Result, ISSP, HEN Grid
and HESN Schema.

13.4.3

Explorer Nodes

In the Project and Target Explorer, data is presented in a tree node structure.
All automatically added nodes based on a command (e.g. Add Target Result)
use a standardized numerical naming process. These names can be changed
at any time by pressing F2 when highlighted. In addition, these automatically
added nodes can be conveniently shifted by drag and drop using the mouse.
This gives the user the ability to reorder the nodes as needed.
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Chapter 14
List of Symbols And Acronyms
14.1
A
Amin
Amin, L
a
C
Cb
Cp
CP
fm
fp
ft
fi
H
∆Ḣ
Index
L
Ni
NE
NHL
NCL
Qb
Q(i,j)
∆T
X

Symbols
Heat exchanger surface area
Minimum area target for an entire network
Minimum area contribution of exchanger specification
Fixed investment cost component
Investment Cost
Base Cost
Specific heat capacity (at constant pressure)
Heat capacity flow (at constant pressure)
Materials of construction factor
Pressure factor
Temperature factor
Installation faction
Heat/Energy
Heat flow/Enthalpy flow
Cost Index (e.g. default values CE Plant Cost Index)
Exchanger specification
Number of enthalpy intervals
Number of different exchanger specification
Number of hot streams with exchanger specification L
Number of cold streams with exchanger specification L
ECU cost base quantity for an ECU
Heat rate between hot stream i and cold stream j
Minimum temperature difference
Humidity ratio

m2
m2
m2
CHF
CHF
CHF
kJ/kg K
kW/K
[-]
[-]
[-]
[-]
kWh
kW
[-]
[-]
[-]
[-]
[-]
[-]
kW, kg/s
W
K
kg H2O / kg Dry Air
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x0, x1
α
hF
hmix
hT
i
j
k
k
mT
mF
ξT r
ξT
ηD
ηE
φ

14. List of Symbols And Acronyms

Quality (bubble point, dew point)
Film heat transfer coefficient
Specific enthalpy waste heat vapour stream
Specific enthalpy mixture
Specific enthalpy steam stream (Treibstoff)
Hot stream
Cold stream
Enthalpy interval
Overall heat transfer coefficient
Mass flow steam stream (Treibstoff)
Mass flow waste heat vapour stream (Forderstrom)
Entrainment (reversible)
Entrainment (irreversible)
Diffusor efficiency
Expander efficiency
Relative humidity

[-]
W/m2 K
kJ/kg
kJ/kg
kJ/kg
[-]
[-]
[-]
W/m2 K
kg/s
kg/s
[-]
[-]
[-]
[-]
[%]
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14.2

Acronyms

BCC
BGCC
CC
csv
CU
DHR
ECU
el
EM
ETA
GCC
HVAC
HEX
HEN
HP
HS
HU
IDE
IHR
IL
ISSP (GCC)
ISSP (Stream)
max
mech
min
MER
MOC
MVR
P
PA
PI
png
Split GCC
TAM
TS
TSM
TVR
VSU

Balanced Composite Curve
Balanced Grand Composite Curve
Composite Curve
Comma Separated Values format
Cold Utility
Direct Heat Recovery
Energy Conversion Unit
Electrical
E-Module
Energy Target Analysis
Grand Composite Curve
Heating Ventilation Air Conditioning
Heat Exchanger
Heat Exchanger Network
Heat Pump
Heat Storage
Hot Utility
Integrated Development Environment
Indirect Heat Recovery
Intermediate Loop
Indirect Source Sink Profile (GCC Based)
Indirect Source Sink Profile (Stream Based)
Maximum
Mechanical
Minimum
Minimum Energy Requirement, Maximum Energy Recovery
Multiple Operating Cases
Mechanical Vapour Recompression
Power
Pinch Analysis
Process Integration
Portable Network Graphics file
Split Grand Composite Curve
Time Average Model
Time Slice
Time Slice Model
Thermal Vapour Recompression
Volume Storage Unit (i.e. Temperature level in stratified tank)
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A. Appendix

Area And Number Of Units

The internal calculations used for targeting are based on the approach published in [12]. This approach extends the traditional Uniform Bath formula
to give the flexibility to apply different heat exchanger cost formulas for a
given stream. In PinCH different cost formulas can be defined for either hot
or cold utility exchangers or for process-process heat exchangers. In order to
accomplish this differentiation in heat exchanger type, the area calculation is
changed to provide a matchwise area distribution. The reader is encouraged
to read the original paper for details for more information on the derivation
of the following formula.

Amin L =

Ni
X
k=1



N
HL N
CL
X
X
1
1
1
Q(i,j) k,L
+
LM T D, k i=1 j=1
αi,j αj,i

Given an area distribution for each heat exchanger match, it becomes imperative to establish the number of units that can be attributed to each type of
heat exchanger specification. Like the area distribution, it is insufficient to assume an equal distribution as done in early targeting calculations; therefore,
a unit distribution must be calculated. The chosen method for calculating a
unit distribution is to start with the known number of matches above and
below the pinch temperature assuming the “spaghetti” design vertical heat
transfer model. Next, for each heat exchanger specification the number of
matches above and below the process pinch can also be determined. These
values can then be used to weight the number of units calculated in a standard
manner to provide the number of units for a specific exchanger specification
as shown in the following equation.
N unit, L = (N a − 1)

V b, L
V a, L
+ (N b − 1)
Va
Vb
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Heat Pump Energy Conversion Unit

The heat pump energy conversion unit model provides a simplified representation of a heat pump with an internal regenerator. This model provides
the heat integration streams representing the heat flow into the evaporator
and out of the condenser. These process requirement streams are automatically included into the stream population for a particular targeting result
operating case or time slice.
The required heat loads and temperatures for both the condenser and the
evaporator are ideally sized using the grand composite curve for the original
targeting result operating case or time slice and must be properly placed
relative to the pinch. The user must supply the evaporator and condenser
temperature as well as the power in either the condenser or the evaporator.
Once this information is set the thermodynamic cycle can be solved.
The key calculation for the heat pump thermodynamic cycle is the isentropic calculation across the compressor. An isentropic efficiency entered on
the heat pump dialog is used to simply calculate the actual enthalpy requirement across the compressor. The calculation uses an internal fluid phase flash
calculation based on the equation of state in [4] to calculate the specific enthalpy exiting the compressor. Once this state is known an energy balance
around the regenerator can be solved. The key assumptions in this balance
equation are bubble point conditions at the outlet of the condenser, dew
point conditions at the outlet of the evaporator and 5 K superheating over
of the regenerator. The necessary flash calculations based on [4] are used to
determine the required state data. The schemas of the heat pump as well
as the thermal cycle illustrating the thermodynamic cycle are shown in the
following figures.
Note: The Mechanical Vapour Recompression (MVR) ECU uses the same
compressor calculation as the heat pump.
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Fig. A.1: Heat Pump Energy Conversion Unit with Regenerator
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Fig. A.2: T, s-diagram of Heat Pump Cycle
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A5

Internal Combustion Engine Energy Conversion Unit

The Engine calculation is used for assessing the energy integration effects of
including a combined heat and power unit (CHP). The engine ECU incorporates a standard combustion calculation as well as heat load ratios. The
result is the creation of three separate streams that are used as additional
process streams and are automatically included in the stream population on
the level of the Target Result. They are as follows:
1. Water flow stream
2. Engine oil stream
3. Exhaust Gas stream
The first two streams are calculated using a simple engine heat load calculation based on the factors already displayed on the engine dialog. These
factors are based on standard ratios of waste heat energy to mechanical power
generated. These ratios can be edited as needed.
The displayed Exhaust Gas heat flow does not use a load factor. The actual
amount of exhaust gas waste heat is calculated internally based on a standard
combustion calculation as listed in the following steps:
1. An air stream at 50% humidity and a temperature ∆T 15°C is assumed to
be mixed and burned using a fuel with the given composition as entered
on the Engine Dialog.
2. The mole fractions of N2 , O2 and H2 O in the air stream are calculated.
3. The ratio for moles of Air/moles of fuel and moles of exhaust air/moles
of fuel are calculated based on the stoichiometric quantities and the given
air to fuel ratio.
4. The moles of O2 , N2 , CO2 , H2 O / mole of fuel are calculated.
5. The mole fractions of N2 , O2 , CO2 and H2 O in exhaust gas are calculated.
6. The mass fractions N2 , O2 , CO2 and H2 O in exhaust gas van than be
calculated.
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7. The mass fractions N2 , O2 , CO2 and H2 O in exhaust gas on a dry basis
are calculated
8. The dry basis mass fractions are then used to calculate enthalpies at inlet
and outlet conditions by simply summing the enthalpy contributions of
each exhaust gas component over the given cooling temperature range.
The water enthalpy contribution is handled in a similar manner with the
addition of the heat of condensation.
9. Given the inlet and outlet enthalpy data calculated in step 8, the stream
segments are then calculated assuming an average Cp per segment temperature range based on a dry basis for the combustion gas mass flow.
Note: The mass flow rate of the combustion gas is calculated and displayed
on a dry basis as is the norm in engineering calculations involving humid air
streams such as combustion gas.

A.4 Mechanical Vapour Recompression Energy Conversion Unit
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A7

Mechanical Vapour Recompression Energy
Conversion Unit

The mechanical vapour recompression energy conversion unit operates with
the similar goal as the thermal vapour recompression unit. However, this
unit utilizes a compressor to achieve the temperature lift necessary to reach
the required condensation temperature. The MVR is also in principle a heat
pump, yet is an open system that takes an existing stream and upgrades
it to a higher pressure and condensation temperature. The following figure
illustrates the operation of an MVR.
Note: The selection of the water vapour stream is limited to the fluid R718
(water) based on the equation of state given in [4].
Superheated Vapor
1 bar(a) 105°C
∆TS = 5 K
p1,TS,L
Feed

2 bar(a)
105°C

p2

Heating Steam
pHD = p2
TK ,HD =TK ,B

Condensation
temperature 120°C

Concentrate

Fig. A.3: Simple Evaporator Unit

Condensate
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Superheated Vapor
1 bar(a) 105°C
∆TS = 5 K
p1,TS,L

Reduced

P

Feed

2 bar(a)
105°C

p2

Heating Steam
pHD = p2
TK ,HD =TK ,B

Condensation
temperature 120°C

Concentrate

Condensate

Fig. A.4: Simple Evaporator Unit with a Mechanical Vapour Recompression
(MVR) Energy Conversion Unit

The stream selected is limited to a water vapour stream that is subcooled.
The amount of this stream to upgrade is set in the MVR dialog allowing the
same compressor calculation as listed in Appendix A.2 for the heat pump
ECU to determine the state at the outlet of the compressor. The electrical
power requirements, incorporating isentropic and drive efficiencies, can then
be calculated and used in the cost calculation for the compressor.

A.5 Thermal Vapour Recompression Energy Conversion Unit
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Thermal Vapour Recompression Energy Conversion Unit

The thermal vapour recompression (TVR) energy conversion unit (ECU)
operates with the similar goal as the mechanical vapour recompression unit.
However, this unit utilizes medium to high pressure steam to achieve the
temperature lift necessary to reach the required condensation temperature.
The TVR is also in principle a heat pump, yet is an open system that takes
an existing stream and upgrades it to a higher pressure and condensation
temperature. The following figure illustrates the principle of a TVR.
Note: The selection of the water vapour stream is limited to the fluid R718
(water) based on the equation of state given in [4].

Superheated Vapor
1 bar(a) 105°C
∆TS = 5 K
p1,TS,L
Feed

2 bar(a)
105°C

p2

Heating Steam
pHD = p2
TK ,HD =TK ,B

Condensation
temperature 120°C

Concentrate

Fig. A.5: Simple Evaporator Unit

Condensate
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Superheated Vapor
1 bar(a) 105°C
∆TS = 5 K
p1,TS,L

Reduced

High Pressure
Steam

Feed

2 bar(a)
p2

105°C

Heating Steam
pHD = p2
TK ,HD =TK ,B

Condensation
temperature 120°C

Concentrate

Condensate

Fig. A.6: Simple Evaporator Unit With A Thermal Vapour Recompression Energy
Conversion Unit

The calculation of the amount of steam mT required to upgrade the selected
waste heat stream mF is the main calculation for the ECU. Inefficiencies in
the nozzle are handled internally to account for the irreversible nature of the
expansion and diffusion process that occur with in the nozzle. The following
equation is based on the overall energy balance around the nozzle assuming
reversible expansion and diffusion processes [13]:

ξT r =

mT
mT + mF


=
r

hF − hmix
hF − hT

In order to account for the irreversible nature of the processes in the diffuser
and the expansion sections, specific diffusor and expansion efficiencies can
be entered on the TVR dialog. They are used in the following equation to
determine the amount of steam, mT , necessary to achieve the increase in
condensation temperature of the water vapour.
s
ξT =

ξT r
ηD ηE

The amount of steam required in the irreversible case can be easily calculated
using the following equation:
ξT =

mT
mT + mF
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A.6

Organic Rankine Cycle Energy Conversion
Unit

The basic Organic Rankine Cycle (ORC) works on a similar principle as
the standard Rankine Cycle. The main difference being that the ORC uses
an organic heat transfer medium and not water as the working medium.
Therefore, the purpose of the ORC is to take heat as input, and convert it
to a useful work output, in the form of shaft-work. The shaft-work can then
be used to produce electricity.
An advantage of the ORC is that the organic working fluids have a lower
boiling temperature at ambient pressure than water, i.e. the organic working
fluids evaporate at lower temperature levels than water. This is important for
pinch analysis as the ORC can take advantage of the lower temperature level
excess heat under the pinch point, with the benefits of generating shaft-work
and reducing the required cold utility. (Note: There also exists the possibility
to remove heat from a pocket (in the GCC), but this is not discussed here.)
Table A.1 lists the organic fluids that are modeled in PinCH with some important characteristics. The critical temperature and pressure represent the
upper bounds for sub-critical operating conditions.
Tab. A.1: ORG Organic Fluids Modeled in PinCH

Organic Fluid
R134a
R245ca
R245fa
n-Butane
(R600)
Isobutane
(R600a)
n-Pentane
(R601)
Ethanol
Octamethyltrisiloxan (MDM)
Toluene

Boiling Temp– Critical Temp– Critical Pressure
erature* (°C)
erature (°C)
(bar(a))
-26.1
101.1
40.6
25.0
178.4
38.6
15.1
154.01
36.5
-0.5
152.0
37.94

Group**
isentropic
dry
dry
isentropic

-11.7

134.7

36.4

isentropic

36.1

196.6

33.7

dry

78.4
152.5

241.6
290.9

62.7
14.2

wet
dry

110.6

318.6

41.3

dry
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*Boiling temperature at normal conditions
**Group Explanation:
Isentropic

The dew-point curve of these organic fluids appears isentropically (i.e. vertical) in the T, s diagram
The dew-point curve of these organic fluids has a positive
slope in the T, s diagram
The dew-point curve of these organic fluids has a negative
slope in the T, s diagram

Dry
Wet

The two main variations of an ORC are the basic ORC, displayed in Figure A.7 (a), and the ORC with regeneration shown in Figure A.7 (b). Both
the process flow diagram and the corresponding T, s diagram are shown for
each variation.
4

3

G

G

2

5
4

3
2

1

6

1
(a)

(b)
T

T

2a

3a

3

4

3

4

5

2

2

1

1

4a

6
6a

s
Heat Exchangers:
Heat Input to ORC
Heat Output from ORC
Regeneration

Fig. A.7: Basic (left) and Regenerative (right) ORCs and main streams.

s
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The difference between the two variations is that the Regenerative ORC
has an in-process heat exchanger for heat recovery. This has the effect of
increasing the efficiency of the ORC by reducing the amount of required heat
input over the evaporator most commonly used with dry organic fluids. The
work produced by the turbine is the same for both cycles.
The part of the ORC that is of interest with respect to PinCH is the heat
transfer between states 2 – 3 for the basic cycle and states 3 – 4 for the
regenerative cycle, i.e. the heat input to the evaporator. However, the stream
that will be modeled and using in PinCH target result is an assumed intermediate loop (IL) (yet very commonly used) to transfer heat from the
process streams to the evaporator. The values defining the IL (heat flow input to evaporator , high (inlet) and low (return) temperatures of the IL) are
entered by the user directly. These along with the condensation and evaporation temperatures allow the calculation of the remaining IL stream values
and ORC thermodynamic state information for the ORC to be calculated
directly. The calculations are for the ORC without the regenerator as only
this type has been implemented in PinCH, i.e. states 1 - 4a in Fig. A.7a (a
regenerative ORC is planned for the future).
Once all the required values are known and with the help of the Grand Composite Curve, the IL can be determined and displayed on the GCC to check
for proper integration. It should be noted that the use of an IL decouples
the investment cost of the ORC from the HEN grid area calculation allowing
an ORC module cost to be used directly. Figure A.8 shows the placement
of an IL and ORC evaporator and condenser streams relative to the GCC
of the background process. The blue stream (IL on process side) is the key
stream that will is modeled in PinCH and included in the target result and
HEN design. All the other streams are also calculated internally but are
independent from the process itself. Each has been shifted according to the
process ∆ Tmin . The ability to set a separate ORC ∆ Tmin is not yet available.
Note: Presently, only the IL stream and evaporation stream are displayed on the GCC of the PinCH ORC ECU dialog.
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Shifted Temperature

IL on process side
IL on ORC side
Heating & Evaporation of Working Fluid
Condensation of Working Fluid

Net Heat Rate
Fig. A.8: Placement of IL and ORC evaporator and condenser flows on the GCC
of the background process. Each stream has been shifted based on the
process DTmin.
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Add-In Functions and Excel “What-IfAnalysis” and “Solver” Tools

A.7.1

PinCH Add-In Functions

The three tables in this section list the currently available Add-In functions
and the required inputs and calculated outputs. These functions act as an
interface between PinCH and Excel. Table A.2 lists the different inputs and
outputs of the functions, Table A.4 displays the available Steam Table AddIn functions and Table A.3 shows the Add-In functions available for Humid
Air.
Note: It is imperative that close attention be paid to the units of the different
inputs and outputs as the units are not displayed in Excel.
Tab. A.2: Input and Output Variables used in the Add-In Functions

Designation
p
t
x
h
s
hl
Xw
ts/tsat
ps/psat
phi
pl
Rho

Variable Name
Pressure
Temperature
Vapor Quality*
Specific Enthalpy
Specific Entropy
Specific Enthalpy
Humidity Ratio
Saturation Temperature**
Saturation Pressure
Relative Humidity
Partial Pressure Air
Density Humid Air

Units
bar(a)
°C
–
kJ/kg
kJ/kg/K
kJ/kg dry air
–
°C
bar(a)
%
bar(a)
kg/m3

* Vapor fraction in the two phase region
** E.g. Dew point in °C at a given p [bar(a)] and X [g h2o /kg dry air ]

A16

A. Appendix

Tab. A.3: Humid Air Add-In Functions

To Be Calculated
Specific Enthalpy Air (dry)
Saturation Temperature
Saturation Pressure Water
Temperature
Humidity Ratio
Relative Humidity
Partial Pressure Air
Density Humid Air

Function Name
PinCH HumidAir
PinCH HumidAir
PinCH HumidAir
PinCH HumidAir
PinCH HumidAir
PinCH HumidAir
PinCH HumidAir
PinCH HumidAir

Input
hl ptXw p, t, Xw
ts pXw
p, Xw
ps pt
p, t
t phlXw p, hl, Xw
Xw ptphi p, t, phi
phi ptXw p, t, Xw
pl ptXw p, t, Xw
Rho ptXw p, t, Xw

Result
hl
ts
ps
t
Xw
phi
pl
Rho

Tab. A.4: Pure Fluid Table Add-In Functions Based on CoolProp Fluid Database

To Be Calculated
Specific Heat Capacity
Specific Heat Capacity
Specific Heat Capacity
Enthalpy
Enthalpy
Enthalpy
Saturation Pressure
Entropy
Temperature
Temperature
Saturation Temperature
Quality

Function Name
PinCH PureFluid
PinCH PureFluid
PinCH PureFluid
PinCH PureFluid
PinCH PureFluid
PinCH PureFluid
PinCH PureFluid
PinCH PureFluid
PinCH PureFluid
PinCH PureFluid
PinCH PureFluid
PinCH PureFluid

cp pt
cp px
cp tx
h pt
h px
h tx
psat t
s ph
t hs
t ph
tsat p
x hs

Input
p, t
p, x
t, x
p, t
p, x
t, x
t
p, h
h, s
p, h
p
h, s

Result
cp
cp
cp
h
h
h
psat
s
t
t
tsat
x

To have direct access to the standard CoolProp PropsSI function using the
PinCH Addin, the following general function has been provided:
Tab. A.5: CoolProp Pure Fluid General Add-In Function

To Be Calculated
Any Fluid Property

Function Name
PinCH CoolPropSI

Input
Result
<Prop1>, <Prop2>, <Property>
<Fluid Name>

A.7 Add-In Functions and Excel “What-If-Analysis” and “Solver” Tools

A17

This function wraps the standard PropsSI CoolProp function to allow easy
and simple access to all pure fluid calculations. The function provides a convenient approach to calculate a desired property from almost any combination
of two input property variables.
e.g. PinCH CoolPropSI(”H”;”P”;30000;”T”;350;”R744”) = 551692.4 J/kg.
(Where P is in Pa and T is in K).
Please check the CoolProp Documentation for details about the different
properties and their associated engineering units as well as the proper alias
naming convention for each fluid (see www.coolprop.org).
Results for Wrong Input Values
Error Shown in Cell:
Error Shown in Cell:

< M aximumV alue >
#W ert!

Incorrect or Out of Range Input Value
Incorrect number of parameters in macro
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Excel “What-If-Analysis” and “Solver” Tools

In general, a thermal system can be defined by a given (determinable) number
of input parameters. Between all parameters in a process, the user can choose
which parameters he wants to use as input parameters. The rest of the system
can be calculated.
In an E-Module the input parameters (blue cells) represent values that are
easy to measure or are usually available in the process control system. It
may occur that the user has other input parameters available than the ones
specified in the modules.
If this occurs there are several possibilities. Firstly, you can completely change
the calculations in order to define a different parameter as an input parameter, however, this is a long and difficult way. As an alternative an iterative
solution can be quickly obtained using the “What-If-Analysis” or the “Solver”
tools which are integrated in Excel.
If a defined input parameter (blue cell) is unknown and should be defined by
another parameter (green cell), the following example shows a step-by-step
proceeding that is to be followed. It is required that the “old” input parameter
(blue cell) is directly or indirectly linked to the “new” input parameter (green
cell).
The E-Module used in the example is the “Thermal Vapour Recompression”,
shown in Figure A.9. This process mixes a high pressure steam (motive steam)
with a low pressure steam (entrained vapor), in order to obtain a medium
pressure steam (discharge mixture). The mixing is done in a nozzle which
creates a vacuum to aspire the entrained vapor.
This kind of system can, for example, be used when exhaust vapor of a process
is at a pressure level (temperature) which is too low to allow re-using it in
another part of the process. By using thermal vapor recompression, the low
pressure exhaust vapor can be revalorized by mixing it with high pressure
steam, producing a medium pressure steam.
As can be seen in Figure A.9, the mixing of the three streams is defined using
the six following input parameters:
 Motive steam: pressure and temperature
 Entrained vapour: pressure and temperature
 Discharge mixture: pressure and mass flow
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Fig. A.9: Thermal Vapor Recompression E-Module

The mass flows of the motive steam and the entrained vapour, as well as
the temperature of the discharge mixture are all determined by the six input
parameters (using an empirical formula).
Let’s now consider that the mass flow of the entrained vapour (the exhaust
vapour which we want to re-use) is known in a process, as well as its pressure
and temperature. We know as well the temperature and pressure of the motive steam (fresh steam in the utility system) and we estimate which pressure
level a medium pressure steam (discharge mixture) must have to be usable
in the process.
Now it would be useful to calculate how much medium pressure steam we
can produce, using all the exhaust vapor which is available. But the input
parameters we have do not fit with the input parameters defined in the PEM.
In fact we want to define the mass flow of the entrained vapour instead of
the mass flow of the discharge mixture.
This can be easily done without changing the calculations by using the
“What-If-Analysis” (German: Was-wäre-wenn-Analyse | French: Analyse scenarios) which is integrated in Excel. The following steps explain how to use
this tool in the example. We assume that the mass flow of the entrained
vapour, which we want to use as input parameter, is 700 kg/h. The rest of
the parameters will stay the same.
1. On the menu go to:
Data → Data Tools → What-If-Analysis → Goal Seek
2. Within the Goal Seek Box the three following parameters are to be
defined:
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Fig. A.10: What-If-Analysis

(a) “Set cell”(German: Zielzelle | French: Cellule à definir): The cell we
want to use as input cell, but contains a formula. In the example
the “set cell” is the mass flow of the entrained vapour, of which we
have a measured value of 700 kg/h.
(b) “To value” (German: Zielwert | French: Valeur à atteindre): The
form “to value” is actually the value we want to attain in the “set
cell”. In the example, we enter 700 (kg/h).
(c) “Changing cell” (German: Veränderbare Zellel | French: Cellule
à modifier): The cell which represents the input we don’t have.
In the example it corresponds to the mass flow of the discharge
mixture.
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Fig. A.11: Goal Seek

3. By pressing the Ok button, Excel iterates the value in the “changing
cell” until the value in the “set cell” reaches the target value in the “To
value” cell.
As a result of the example we obtain a mass flow of the discharge mixture of
1850 kg/h. We found that at the given conditions we can produce this amount
of medium pressure steam when 700 kg/h exhaust vapour are available.
Instead of using the “What-If-Analysis” it is also possible to use the solver
(shown in Figure A.12). The solver must first be enabled under:
File → Options → Add-Ins → Manage Excel Add-Ins
Once enabled, it can be found under:
Data → Analysis Tools → Solver
The solver works basically the same way as the “What-If-Analysis”, but allows
some additional possibilities such as finding minimum & maximum values or
specifying a range of values for the input cell.
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Fig. A.12: Excel “Solver” Tool
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Developing Own E-Modules

It is possible for third party users to develop their own E-Modules (EM),
which can be used in their PinCH projects. They can also make the EM they
developed available to other PinCH users who in turn can use it in their own
PinCH projects. For this reason it is important to maintain a high level of
standardization throughout all EMs. Thus, this chapter contains guidelines
for the development of new EMs as well as an explanation of the standards
which have to be considered.

A.8.1

Preliminary to E-Module Development

When developing a new module, one should always keep in mind the aim
of the energy related modelling, which is to obtain the definition of cold
and hot streams in a process, with sufficient accuracy to perform the heat
integration. Clearly, assumptions have to be made in order to facilitate the
calculations and speed up the modelling, but the developer should be aware
of the influence of the assumptions he makes and record them in the header
of the module.
The aim is to obtain a solid and simple model out of a probably very
detailed process. It is advisable to split up large processes into smaller subprocesses in order to guarantee their legibility.
When building a new module with the purpose to complete the database, it
should be checked whether the module will also be useful for other users:
 Are there general process modifications possible before a Pinch Analysis
is performed? Do these modifications make a Pinch Analysis obsolete?
(E.g. minimize the evaporation rate by placing floating balls on the
water surface or minimize the hood air flow in order to decrease the air
velocity on the water surface etc.)
 Does the process have at least one hot/cold stream that can usually
only be determined by energy and mass balances?
 Is there an existing EM that covers the process or that requires only a
few changes to do so?
 In which other industries can the process be used?
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 Is the process general enough to build a module? What is the multiplication potential?
 Does the description cover all different kinds of energetically identical
processes or is a specific naming needed?
 Is the process or sub-process small enough, so that it allows future users
to understand the calculations within a reasonable time? If not, split
the process into sub-processes.
 Is there reasonable knowledge and documentation/data on the considered process available?

Once these points are confirmed, we can start to build a new module from
scratch. In the following example we will have a look at the evaporation which
occurs at the surface of a hot pool (represented in the EM“pool evaporation”).
This process represents for example a treatment bath for metal pieces. The
fluid which evaporates at the surface of the pool is captured in a hood and
expelled to the atmosphere. Because the pool is open to the room, ambient
air is aspired as well.
The losses in the pool due to evaporation are constantly replaced by a refilling mechanism. To assure the desired temperature in the pool, a heating
system is installed. There are systems with either direct or indirect heating,
which means there is either a heat exchanger placed in the pool (usually
electric heating) or the fluid in the pool is pumped through an external heat
exchanger.
In the example, the pool represents the process, which interlinks several cold
and hot streams, as shown in Figure A.13. It is useful to draw a sketch of the
process, in order to gain an overview of the parameters to define.
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Fig. A.13: Example of a Useful Sketch of a Pool Process

Once the streams are chosen, we complete the sketch with some energyrelated information and ideas:
 Definition of the system boundary for the mass and enthalpy balance
of the process.
 Is it technically possible (and useful) to preheat the streams entering
the process?
 Can energy recovery be done with streams leaving the process?
 Which is the best way to fulfil the heating and cooling requirements of
the process?
 Are empirical formulas required?

Before starting to model the process in Excel, we spend some time to think
about the input parameters we want to use by comparing it with different
plants.
 Is the process always done this way, are there other alternatives?
 Which of the alternatives is the most representative? Or better? Is there
a way the EM can be defined in order to cover various alternatives (e.g.
with some optional streams)?
 Will the EM be useful for a different application in another industry?
If so, general and yet understanding naming is essential.
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 What are the parameters that are usually available? (e.g. use productrelevant parameters which are measured by the process control system
and therefore quickly available)
 Are the parameters available in all processes the energetic model is
used for or are other common values available? If so, describe in the
module header how the “what-if-analysis” or the “solver” should be used
in order to use the module in different directions.
 Which parameters are easy to obtain/measure (e.g. the bath temperature is easier to measure than the exhaust air flow)? If possible, use
these easy parameters as input.
 Can the energy and mass balances be closed with the available parameters?
 What were the assumptions and simplifications made when calculating
the modules the way we planned it?
 Do these assumptions hold in most cases?
 What are the most sensitive parameters?
 What are the uncertainties of these parameters?
 Can I determine the energy and mass balance with reasonable accuracy? (Remember, the EMs should not represent an engineering tool
for plant layout, but help the engineer to quickly and roughly determine
energy flows.)
 Are there other ways to model the stream table which might prove
beneficial from a process integration perspective? Can, for example,
two streams be combined into one stream in order to save heat exchanger costs?

After having checked the questions above, it should be possible to define
which will be the input parameters and how the calculated values will be
determined (e.g. using thermodynamic laws or empirical formulas). The next
step will be to build the EM in Excel, respecting the standardization rules
of the EMs.
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Standardized Design

The standardization aims at:
 Simplifying and speeding-up the development and the maintenance of
documentation and of software code.
 Ensuring a uniform philosophy and look of the modules to ease the
understanding, the application and possibly the modification by the
end user.
 Maximizing the applicability range of modules for a given set of basic
modules.
 Allowing end-users to develop modules by means of a simple yet comprehensive supporting documentation and the use of a standard software environment.

Let us now start to build the module in Excel. Create a new Excel sheet and
draw the process (here the pool). The process is usually represented as a box
with black frame. In the example, we replaced the top frame by a waved line
in order to visualize the water surface (see Figure A.14).
The next step is to represent the streams. In the example, the required
streams are the pool refill, the air leaving the system and the external heating
system. The aspired ambient air is not really a stream here, because it is not
ducted.
To build the streams, copy them from the standard blocks into the new EM.
As shown in Figure A.14, we copy a water stream for the pool refill, a wet air
stream for the waste air and again a water stream for the heating system. For
the specification of the ambient air, we put an empty box. After copying the
streams, we copy from the standard blocks the predefined mass and enthalpy
balance.
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Fig. A.14: Sketch of Pool Process

Now, we can start to define the calculations and interlink the streams. Because a preliminary analysis has been done as described in section A.8.1, we
know which values are available and which parameters can be calculated.
We can start to calculate values out of the available input parameters and
interlink the streams between each other. When interlinking the streams it
is important to do this indirectly using the mass and enthalpy balance, this
avoids long calculations in single cells. To be able to calculate all input and
output streams, we also need to estimate the evaporation rate at the pool
surface. To do so, we use an empirical formula, of which we place the necessary
parameters directly in the box representing the pool. To make the formula
available to the user of the EM we will later on make a quotation in the
header of the module.
The finished model of the process is shown in Figure A.15. Where required,
it is possible to add extra information to the model, using the predefined
information box in the standard blocks. When the elements defined in the
standard blocks are not sufficient, it is possible to use self-designed blocks or
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boxes, however, ensure to adhere to the standard colour code.

Fig. A.15: Finished Model

In the example, we added an extra enthalpy balance for the heater. For the
exhaust air stream we added an information box indicating the dew point
temperature for the given humidity and temperature of the air. The red frame
indicates that the cell contains information which is not permanently visible.
In the example, a warning appears when the temperature of the air is below
the dew point temperature and condensation occurs (visible in Figure A.16).
When the air temperature is above the dew point temperature, the warning
disappears and the red frame indicates that the cell should not be deleted or
overwritten.
Last but not least, we add the following elements, as shown in Figure A.16:
– The header, which describes the module and helps the user to under-

A30

A. Appendix

stand the process and the calculations. Further information of what
must be mentioned in the header can be found in section A.8.4.
– The legend should not be missing, thus the user can quickly understand
the meaning of the colouring. This can be copied from the standard
blocks.
– The stream table summarizes hot and cold streams and prepares the
data to be copied into PinCH (see section A.8.8. It should also help
the user to understand how a stream is correctly modeled for heat
integration. In the example, the heater is represented as an external
heat exchanger, which elevates the temperature of the fluid in the pool
to a given target temperature. The cold stream to be heated up is
therefore the fluid in the pool. The appropriate heat source to do so
is defined later in the process of heat integration. The exhaust air is
finally defined as a hot soft stream, as it can be used for energy recovery,
however, it does not have to be cooled down from a process perspective.
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Fig. A.16: Finished PEM
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Development Procedure

The most important points concerning the development of a EM in Excel are
summarized next:
Main steps for building E-Module in Excel
 Respect steps preliminary to module development
 Module GUI layout and structure (respect standardization rules)
 Module specific documentation (respect standardization rules)
 Quality check

Standardization rules for building an E-Module
 Manageable size – this allows for quick understanding
 Use standard blocks wherever possible
 Respect the coloring defined for the standard blocks
 Necessary elements of an EM:
 Use the predefined quality checklist to ensure that the modules respect
the standards

Figure A.17 shows the standard procedure to follow when developing a new
EM. There are some important steps to be considered before and after the
actual development and calculations in Excel in order to assure the quality
of the module.
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Start

At least one hot or cold
stream which requires an
energy and mass balance?

no

The process is too small
and it can be modelled by
a simple stream

yes

Use/adapt existing
EModule

yes

Is the process or a part of it
already covered by an
EModule?
no

Multiplication potential?
General enough to be used
in other industries?

Split up into
subprocesses

Very specific process
no

yes

Process small enough to be
understandable within
reasonable time?

no

yes

Knowledge /
documentation / data
available on site or in the
literature?

no

yes

Modelling, respecting the
standards

Redesign
no

Sensitivity check: are the
most sensitive parameters
available at reasonable
accuracy?
yes

Quality check
not succesful

Quality check using
checklist
Quality check succesful

Validation by two different
instances

Update database

Fig. A.17: Standard Procedure

A.8.4

Standard Elements

Standard Blocks
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The standard blocks contain the required elements to build an EM. The most
important elements are the predefined hot and cold streams (represented by
a heat exchanger).
Every stream is defined in all possible directions and with different dimensions
in order to facilitate the construction of new modules. There are four different
kinds of standard streams defined. These are:
 Product (a mixture of any product with a certain amount of water)
 Single product (a product without water content)
 Humid Air (air with a certain water content)
 Water and steam (the solid/liquid/vapour state is automatically calculated).

In the standard blocks it is assumed that the mixture of the products is ideal
if not otherwise mentioned and pressure drops through the heat exchanger
are neglected.
In addition, the standard blocks also contain predefined designs for the following elements:
 An empty header
 The legend, explaining the colouring and types of streams
 Information box (to represent additional information for a stream)
 Text box to indicate critical values and hidden formulas
 Enthalpy and mass balance for continuous process
 Time dependent representation of batch streams
 Predefined stream table

The standard blocks should be used wherever possible in order to keep the
design of the EMs uniform (see Standard blocks and symbols.xlsx and blank
module.xlsx). This will help the user to get started with a module.
If a required element is not available in the standard blocks, the developer can
create a new block in the style of the existing design and standard colours.
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Header
The header represents an important element of the EM. It should be designed
with care as it is the key to making the module understandable for future
users. The header consists of the elements shown in Table A.6:
Tab. A.6: E-Module Header
Name
Type
Fields of applicaion
Products
Process overview
Version
Printing format
Reference
Process description
Assumptions
Calculation principles
Running the
module
Energy integration
Comments

Short and clear name, used to identify the module in the
database. Avoid long phrases or descriptions
Type of the module: continuous or batch.
Possible industries in which the module could be useful. The
idea is to expand this library continuously
Products that result in the process which the module covers
Short description of the process. The process overview is the
description that is used in database.
Version number of the module. The same number should be
mentioned in the file name.
Paper size and
orientation
All external formulas must be quoted here with a source, so
that the calculations are transparent to the user.
Detailed description of what happens in the equipment and
how. If batch operated, describe the different process stages
Major assumption made due to simplifying the process for the
E-Module are given here.
Gives idea of how the different elements in a module are calculated (important calculation principles explained here).
Guides the user through the module and explains the order the
input values should be entered, how to use implemented macros
and which values must be modified when using the solver.
Hints and common techniques for energy integration in the
specific process.
Any additional comments from the developer.
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Legend
The legend should be present in every EM. It describes the coloring and the
different types of streams. It can be copied from the standard blocks.
Description of Stages (Batch Only)
For batch processes, the names of the different stages in the process are
defined in a separate box. To do so, a predefined box is available in the
standard blocks (Description of stages). It allows the user to enter a name for
every stage in the batch process. The names should be copied automatically
to the corresponding streams further down in the batch process.
The reason to place this box is to have the names of all stages close to the
graphical representation of the batch process (see for example the E.Module
Reaction tank).

A.8.5

Standard Appearance

Colors
Use the colors which are defined in the standard blocks and shown in Table A.7 & A.8. Once you have copied the legend or a standard block into the
new module, the easiest way is to use the format painter to transfer colors
from one cell to the another:
Home → Clipboard → Format Painter
To increase the legibility, the background is completely white (no cells visible). Use:
Home → Font → Borders – set all the borders to white

A37

A.8 Developing Own E-Modules

Tab. A.7: Cell Colors and Types

Required field
Optional modification
Calculated value
Balance result & Titles
Constants
Tab. A.8: Cell Colors RGB Codes

Standard Colors for EMs:

R
G
B

153
201
255

218
150
148

153
204
0

255
192
0

Types of Streams
Use the predefined lines for different types of streams as defined in the standard blocks and shown in Table A.9. A product stream represents either a
wet or dry product. It stands for the main good to be treated in a process.
Tab. A.9: Types of Streams

Product
Humid air
Steam/Water
Design of the Process
The assembly of a continuous process and its streams should be similar to the
representation in a flow sheet, so that the user quickly understands what the
module represents. The predefined streams in the standard blocks should be
used. The process itself is represented by a black frame, containing at least
one cell for specifying the name of the process. If required, add additional
information directly inside the black frame or by using an information box
as shown in Figure A.18.

217
217
217
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Fig. A.18: Representing a Process

Symbols
Some symbols are defined in the standard blocks such as heat exchangers,
evaporation and losses. Where required define new symbols, try to choose
them as self-explaining as possible.
Font
The font used in EMs is Arial with a font size of 10. Text that is highlighted
uses the same font and size and should be in bold (e.g. for names, titles, etc.).
Cell Size
All cells, except for the descriptions in the header should have a width of 53
pixels (or a value of 6.86) and a height of 18 pixels (13.5). Where necessary,
the cell format can be larger (e.g. to display large numbers or long names).
Number Format
The standard number format is defined in the streams of the standard blocks.
If a different number format is required then the designer is free to change
it. Remember that the EMs are not exact simulations, therefore, too many
decimal places will give the user a wrong feeling of precision.
Merged Cells
There should not be any merged cells except for in the header. This is because
copying or moving merged cells is not always possible.
Information Boxes
The information box can be added from the standard blocks either to define
additional information, which is often required, or to represent an intermediate calculation step (i.e. if putting the entire calculation in a single cell would
be too complicated).
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Standard Naming

Numbering of States and Stages
Ensure that states and stages are numbered correctly and in a comprehensible
order. For standard blocks a state is always defined by a number in a grey cell.
As the temperature is the main characterisation of a state in Pinch Analysis,
the state-numbering is always next to the temperature field.

Fig. A.19: Numbering Stages

Naming Cells
In most cases, the units defined in the standard blocks should be sufficient to
describe the value in the cell. Where necessary, add an additional cell which
describes the unit. For an overview of the used units and their abbreviations,
see table A.2.

Fig. A.20: Naming Cells

Standard Names of Streams
General – The names of streams should describe the stream in such a manner
that the user understands the stream’s purpose. Unique names for the streams
should be used as they will be used in PinCH to distinguish the streams.
Standard names are defined in Table A.10 below and should be used wherever
possible. However, if required, other names than the standard names can be
defined.
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Tab. A.10: Name and Description of Standard Streams

Stream Name
Product Inlet

Description
Stream which represents the product entering a continuous process.
Product Outlet
Stream which represents the product leaving a continuous process.
Inlet Air
Air entering the process from the environment.
Exhaust Air
Air leaving the process, usually loaded with water
vapour or particles.
Exhaust Gas
Combustion product leaving the process.
Exhaust Vapours
Vapour produced in the process, possibly polluted.
Combustion Products Gas after combustion, intermediate state before
leaving the system.
Fuel
Fuel entering the process.
Product Feed
Stream which represents the product entering a
batch process.
Product Discharge
Stream which represents the product leaving a
batch process.
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Standard Calculations

Mass and Enthalpy Balance
Balances within processes should always be done in the corresponding mass
and enthalpy balance box, which is defined in the standard blocks. It should
be avoided passing values directly from one stream to another because this
leads to long formulas which are difficult to unscramble. Figure A.21 shows
how the information flow should be (blue) and how it should not be (red).
Exception: merging/mixing of streams.
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Fig. A.21: EM Data Flow

Formulas
Be aware that formulas in Excel can become difficult to understand. Assure
that the formulas are comprehensible for the end user. Avoid long formulas
and define, if necessary, intermediate steps in an information box.
Assumptions
Any major assumption must be recorded in the header. This helps the user to
understand the calculations and to evaluate if the assumptions are reasonable
for his process.
Warnings
The modules are not meant to be fool-proof. Nevertheless, the most common
entry mistakes should be covered by a warning. To do so, a warning cell is
defined for each critical value and marked by a red frame. At the same time
as the warning occurs, the cell turns red (use conditional formatting, Home
→ Styles → Conditional Formatting.
Example (Figure A.22 & A.23): Condensation occurs because the outlet temperature after the heat exchanger is below the dew point (10°C while the
dew point is at 11.8°C). The warning Condensation! occurs and the cells
containing the dew point and the vapor mass flow turn red.
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Fig. A.22: Representation of a Warning

When increasing the temperature to 30°C, the warning disappears and the
cells returns back to their original colour. In order to mark the cell with the
formula containing the warning, a red frame appears. The red frame and an
example of a warning are defined in the standard blocks.

Fig. A.23: Representation of a Hidden Formula

Absolute references
Always use relative references and avoid absolute references (i.e. avoid $A$5)
in order to make copy-paste into other sheets possible at any time. Use “find
and replace (ctrl + h)” to easily remove all $ signs if any were added during
development.
Overwrite estimations
Overwriting of suggested values by an entry of the user: the suggested value
should disappear when overwritten, so that it is clear which value is used in
calculations as shown in Figure A.24.
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Fig. A.24: Overwriting Estimations

Circular references
In some processes, it is not possible to avoid circular references in the calculations. Either there is a recirculated fluid (closed loop) or there is not enough
(measurable) input data available. The workaround is to use the solver. To
facilitate the handling of modules, it should be possible to run the solver via
a script, which is activated by a button as shown in Figure A.25. The Delta
represents the balance difference of a circular reference. The macro closes the
balance by adapting a specific parameter (e.g. the inlet air flow).

Fig. A.25: Script Button

A.8.8

Standard Stream Table

The stream table gathers the information which is required for the PinchAnalysis. A predefined stream table can be found in the standard blocks. It
has the format as shown in Figure A.26.

Fig. A.26: Stream Table

The stream table is composed as shown below. The data should be automatically copied from the corresponding stream (except for the blue cells). It is
not necessary that all the cells in the stream table contain values. For more
information about necessary parameters in the stream table, see chapter 4.
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 Name: the name of the stream is automatically copied from the process
model.
 Segment: Numbering of a segment, only necessary if the segmentation
of a simple stream is required (see e.g. module Evaporator). It is left
empty in case of non-segmented streams or in the case of predefined
fluids (e.g. Water, Humid Air) as PinCH segments these streams automatically.
 Hot/Cold: defines if the stream is hot or cold. Adapt the definition to
the corresponding stream. For streams which can be hot or cold, define
a formula.
 Tin: stream inlet temperature.
 Tout: stream outlet temperature.
 Flow: mass flow of the stream in kg/s.
 Cp: specific heat of the fluid. The Cp is required if the fluid is specificed
as simple (see below under Fluid).
 Phase Change: specific heat of the fluid when changing phase. Only
required for simple fluids which change phase. For fluids which are predefined in PinCH, the phase change is calculated automatically based
on temperature and pressure.
 Alpha: heat transfer coefficient, depending on the fluid.
 Pressure: required when other values have to be calculated automatically, i.e. for steam or wet air. Not required for simple fluids.
 Fluid: Simple fluid means that the fluid is defined by Cp, temperatures
and mass flow. Other fluids such as Water or Humid Air will be automatically completed in PinCH using an internal properties library. See
PinCH for further explanation regarding the available fluids.
 Humidity Ratio: absolute humidity for humid air, in kg water per kg
dry air. Required when for humid air only.
 Soft: indicates if a stream is a soft stream or not. A soft stream is a
stream which does not require cooling or heating from a process point
of view, but can be cooled/heated for the purpose of energy recovery.
A soft stream is, for example, hot air which leaves the process to the
atmosphere.
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 TStart: time at which a stream starts, used for batch processes.
Scheduling of continuous processes can be done after import into
PinCH.
 TStop: ending time of a stream.
 To be used in PinCH: indicates whether a stream must be copied into
PinCH or not. Sometimes, several streams in a module are unused (flow
rate is zero) and therefore does not have to be copied into PinCH. The
definition of this cell must be adapted to the corresponding stream.
(Note: This column should not appear in the E-Module stream table,
it is only a reference for the Excel stream table.)

A.8.9

Protection

Cell Protection
To be defined as needed.
Unlock Key
To be defined as needed.

A.8.10

Files and Printing

Filename
The filename must be the same as the name of the module which is specified
in the header. The filename is followed by the version number (e.g. nameofthemodule 1.2.xlsx).
Printing
The printing area should be defined so that the entire worksheet is printed.
Paper size should be large enough so that the print is readable.
Header and footer
The header is empty while the footer contains the path, filename, date and
page number.
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Quality Management

In order to assure the quality of finalized EMs a detailed quality checklist
has been established. It serves to check a finished EM step by step. Once
the module is finished, the developer should ensure whether the new EM
respects all the points mentioned in the quality checklist and accomplish the
tests defined. Nevertheless, the quality checklist can be useful during design
and development of a EM, to assure that the standards are followed.
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Quality Checklist
Module Header
Name
Clear and short?
Type
Defined (continuous or batch)?
Fields of Ap- Are all possible fields of application mentioned?
plication
Products
Are the most important products of the module’s process(es) listed?
Process
Is the overview short enough, so that the user can read through several
Overview
process overviews when searching a module? Is the overview accurate
enough, so that the user finds the correct module covering his process?
Version and
Is the tracking up to date?
Changes
Printing For- Is the printing format defined correctly? Are header and footer demat
fined? Check paper size, orientation and printing area.
Reference
Do all essential formulas used in the calculations have a reference?
Process
Is the description clear enough to provide a comprehensive picture
Description
of what happens in the process and which data is required for the
calculation?
Assumptions Are all assumptions and simplifications explained?
Calculation
Are the closing of energy and mass balances explained (correctly)?
Principles
Running the Is the order of entering data explained? What are the sensitive paModule
rameters and how do they influence the result? Are the most common
alternatives to run the module explained ( e.g. calculating the inlet air
mass flow using the solver if the exhaust air temperature is known)?
Energy Inte- Are the alternative stream models used in the stream table explained
gration
(e.g. Combine all inlet air streams into one stream and define the
maximum common temperature as the target temperature. Define the
remaining stream parts as streams.)? Are the most common ways to
decrease the energy consumption independently of the EM explained?
Comments
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Legend
Legends,
signs &
symbols

Are all the types of lines explained? (e.g. product stream, water etc.)

Description
of stages
(batch only)

Is the standard box for describing stages available? Are the entered
names automatically transferred to each stage?
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Appearance
Font

The standard font is Arial with size 10. Select all cells (ctrl+a) and
set the correct font and size.

Cells

Do all cells within the process have a width of 53 pixels (or a value
of 6.86)and a height of 18 pixels (13.5)? Where necessary, the cell
format can be larger (e.g. to display big numbers)

Header and
The page header is to let empty, the footer contains path and filename,
footer of page current date and page numbering.
Process

Does a look on the entire process give the user an idea of what the
process does and which streams have to be defined?

Colouring

Are the correct colours used for each cell? Especially blue cells must
not contain any formulas, because they will be overwritten by the
user.

Types of
streams

Are streams represented correctly? (product/air/water/steam)

Symbols

Do the symbols have the correct ratio?
or

Number For- Does the number format make sense (i.e. 4.3 kg/h instead of
mat
4.29534555 kg/h)? The standard number format is defined in the
standard blocks. Remember that the EMs are not exact simulations,
thus, too many decimal places will give the user a wrong feeling of
precision.
Merged cells

There should not be any merged cells except for the header. This is
because copying merged cells causes troubles.

Absolute ref- Use relative references always and avoid absolute references (i.e.
erences
$A$5) in order to make copy-paste possible any time. Use “find and
replace (ctrl + h)” to easily remove all $ signs.
Overwrite
Overwriting of values: The suggested value should disappear when
estimations – overwritten so that it is clear which value is used in the calculations.
depending on
process
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Naming
Numbering
Are the states and stages numbered correctly and in a comprehensible
of states and order?
stages

Naming cells

Are cells named correctly (units are defined in the standard blocks)?
Are the units clearly defined (i.e. Nm3/h instead of m3/h, bara instead of bar)? If the unit does not provide enough information then
add a short text/name.

Naming of
blocks /
streams

Is the name meaningful? Does it correspond to the standard?

Standard Names of Streams
General

The names of streams should describe the stream, so that the user
understands the purpose of the stream. Unique names for the streams
should be used they will be needed in PinCH to distinguish the
streams. Standard names are defined below and should be used wherever possible. However, if more adequate, other names than the standard names can be defined.

Product inlet Stream which represents the product entering a continuous process.
Product out- Stream which represents the product leaving a continuous process.
let
Inlet air

Air entering the process from the environment.

Exhaust air

Air leaving the process, usually loaded with water vapor or particles.

Exhaust gas

Combustion product leaving the process

Exhaust
vapors

Vapor produced in the process, possibly polluted

Combustion
products

Gas after combustion, intermediate state before leaving the system.

Fuel

Fuel entering the process

Product feed

Stream which represents the product entering a batch process.

Product dis- Stream which represents the product leaving a batch process.
charge
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Calculations
Mass and
enthalpy
balances

Are the mass and enthalpy balances used as they should be?
Balances within processes should always be done in the corresponding box and values should not be given directly from
one stream to another. Exception: merging or mixing of streams.

Units

Are the calculations made using the correct units?

Formulas

Are the formulas comprehensible? Are all variable parameters within
a formula accessible by an entry cell? No hidden values! If formulas are
too long, an intermediate step (additional cell) can help to understand
the calculation more easily.

Assumptions

If any assumptions or simplifications are made, are they mentioned
in the header?

Warnings

Is the user being warned when a calculation is out of range? E.g.
user forgets to run the script after having modified values and the
humidity is more than 100%.
Pay-attention: The modules are not meant to be fool-proof. Nevertheless, are the most common entry mistakes covered with a warning?
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Stream Table
Values

Are the correct values copied into the stream table?

Hot/Cold

Correct definition? Does the definition change automatically if the
stream can be either hot or cold?

Empty fields

Do all the fields which are not used to defined the stream contain a
zero?

Fluid

When a fluid other than simple is defined, are all the necessary parameters copied into the stream table?

Soft streams

Correct definition?

To be used in Is the definition correct?
PinCH
Import test

Ensure that the stream table can be imported into PinCH, by copying
it into a .csv file and importing the .csv file into PinCH.

Stream definition in
PinCH

Compare the values in the imported stream table with the values in
the original stream table. Is the definition still complete? (i.e. mass
flow)

Protection
Cell

Are the cells that must be modified by the user unprotected?

Unlock key

Is the correct unlock key available and documented?

File
Filename

Does the filename correspond to the name of the module defined in
the header? Does the filename contain the same version number as
defined in the header?

Folder

Is the module available in the corresponding folder?

Data Base
Complete?

Has the module been added to the database?

Updated?

Are the version number and the description in the database up to
date?
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Multiple Operating Cases and Batch Supertargeting

Multiple operating case (MOC) and batch supertargeting is done to optimize the direct heat transfer possibilities between different operating cases
(OCs) or batch time slices (TSs). Thanks to the direct analogy between OCs
and batch TSs, the presented method of supertargeting can be used for the
optimization of direct heat transfer possibilities of either batch processes or
continuous/semi-continuous processes that form MOCs . Therefore, the term
OC and TS can be used interchangeably.
In contrast to the ”classical” pinch analysis of a single continuous process
MOC and batch supertargeting requires an extension to the method to account for the reuse of common heat exchanger area between different OCs.
The reuse of the HEX area between different OCs/TSs generates coupling
between the different OCs/TSs so their individual energy/cost tradeoff have
an influence on the overall area. The goal of MOC supertargeting is to determine the ”set” of ∆ Tmin values (1 per OC/TS), which results in the lowest
total cost (The coupling between the OCs/TSs which arises through the reuse
from HEX area makes the calculation of the ”sets” of ∆ Tmin values for n-OCs
(n-TSs) an n-dimensional problem.)
The theoretical foundation for the practical application of the MOC supertargeting was developed by P.S. Jones [16] and further elaborated in [17].
Design Types The reuse of HEX area is a complex optimization task so long
as no clear limits on the possible ”rearrangment” of HEX between the different OCs/TSs are made. Jones defined two main restricted design types Conventional Design and Resequence Design. In Figure A.27 is shown optimal HEN designs for two simple OCs to help illustrate the concept of reusing
HEXs in these ways.
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Operating
Case 1
E1

Conventional Design

E2

E3

E1

E2

Resequence Design
E1

E3

E2

E3

H1
4
120 m2

6
1

120 m2

5

100 m2

1100 m2
5

2

600 m2

120 m2

4

100 m2

1
3

2

C1 550 m

C2

1100 m2

Total Area: 2370 m2

1
1200 m2
2
1200 m2

Operating
Case 2
E1

E2

2
E3

1100 m2

H2
4

3
450 m2

2

100 m

1

3

1200 m2

550 m2
4

2
450 m2

550 m2
3

C4

C3 400 m2

Total Area: 2150 m2

Total Area: 3520 m2

Total Area: 3070 m2

Fig. A.27: Simple two operating case example illustrating HEN design for conventional and resequence design type constraints.

Conventional Design:
This design type is the variant that has the least flexibility. The HEXs in
the overall design must always maintain the same matches between the same
two streams as given in the original OCs. In addition the HEXs must be so
placed that each stream of the HEX flows in the same order as in the OCs
(see figure A.27). Based on these restrictions the condition arises that per
stream always only one HEX for all OCs can be reused.
Resequence Design:
By resequence design, as by conventional design, the HEX between the same
two streams must be maintained between the OCs. However, in contrast to
conventional design it is allowed in resequence design to have the flow in
any order for each stream. As a result, the HEX area can be placed in a
more flexible manner and the total HEX area of the overall design will be
smaller than by conventional design. For example, for OC 1 in the overall
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design shown in figure A.27 stream H1 first flow through HEX 2 and then
via bypass back to HEX 1 and then finally through HEX 3. Through the use
of several bypasses can the stream H1 be redirected in very flexible manner.
The more flexible the HEN design then the greater potential for the reuse
of HEX area between OCs, but as a result a larger investment in piping,
valves and control system needs. These costs must also be considered in the
analysis.
Calculation Of Combined Supertargeting Optimization:
Both the conventional and resequence design supertargeting use a two loop
during calculation:
 Inner Loop: Searches for the set of ∆ Tmin for each OC which results in
the lowest total cost
 Outer Loop: Searches for given set of ∆ Tmin for the maximum common
HEX area and therefore the minimal total HEX area neede for the
overall nextwork

Based on the assumption of vertical heat transfer (as assumed in the
area target calculation based on the composite curve), the amount of
common or reused HEX area can be calculated and maximized using linear
programming. In the case of resequence design, this is done based on the
shifting of heat flow (or analogously area) between HEX matches based on
loops in the networks. The linear program is able to shift the area in order
to maximize the area between each match (i.e. matrix elements shown in
figure A.28). A simpler yet similar linear programming approach is also used
for conventional design to determine the candidates for heat transfer and
the associated maximum areas for each TS/OC. With these new values the
total required area target is reduced given the greater amount of common
area now available.
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MOC 1

MOC 2

700

200

410

800

50

750

400

400

1700

initial
2010

LINEAR PROGRAMMING

550

350

510

700

200

600

300

500

1700

optimised
2010

Fig. A.28: Area matrices are optimized simultaneously to increase common area
between the operating cases resulting in total minimum area target.
This approach is based on the resequence design constraint.

Once the new conventional and resequence design target results have been
calculated (and the area matrices, the ∆ Tmin values and other parameters
are known), then design of the HEN can be done to approach the values.
In addition to area and cost targeting for both conventional and resequence
design, the pinch match matrix is also used in HEN design to determine
which HEX match exists at the pinch point for each TS/OC. These pinch
HEXs can be sized based on the area targets to use the largest area and then
reused in the other TS/OSs. Support for the design of multiple OCs or batch
TSs is included in PinCH 3.2 using the following functionality (see section
12.6):
 Multiple OC/TS Mini Map
 Area/Temperature Calculation Tool
 Export Conventional Design Matrices
 Export Separate Design Matrices
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These new functionalities together with the existing capabilities of the
PinCH MER and Relaxed HEN design support provide an effective approach to designing an overall HEN flexible enough for the multiple OCs or
TSs. For more information on the MOC supertargeting algorithm and MOC
HEN design based on the conventional and resequence HEN design types the
information given by Jones [16] and by Krummenacher [17] is recommended.
HEN Design Guidelines
There are several general guiding principles involved in MOC HEN Design.
They are as follows:
 The MOC HEN design strategy uses the PDM, in that the design starts
where the problem is most constrained (i.e. the pinch point). This approach is based on the design philosophy: do the most difficult task
first. However, an extension to the PDM is to given priority to common pinch matches (otherwise, if placed later, there is less scope for
optimising the use of area because of HEN structural constraints).
 Vertical heat transfer is used for key HEX placement; however, crisscross heat transfer will be necessary to ensure maximum area reuse.
The following relaxation considerations need to be used:

– Violation of the ∆ Tmin rule.
– Cross pinch heat transfer may be necessary in certain circumstances. However, it should be avoided if possible.
 The minimization of the total cost is accomplished by minimizing the
number of units (tick-off matches), while minimisation of area is only
second priority (since the number of matches has a larger effect on costs
than the area).

Pinch Match Matrix:
The pinch match matrix is critical in the HEN Design as it identifies
immediately the critical and most constrained matches at the process pinch.
Setting the ∆ Tmin of each OC allows the identification of which streams
exist at the pinch (either on one or both sides of the pinch). Any hot-cold
stream match that is possible at the process pinch is called a pinch match.
The pinch matches in each OC are determined and then merged into a single
overall Pinch Match Matrix (See section 12.6 on how to export the Pinch
Match Matrix for a conventional design target).

A58

A. Appendix

After Combined supertargeting for multiple OCs or batch TSs, the costoptimum slice-wise pinch ∆ Tmin , the pinch temperature and the cold and hot
utility targets are known for each time slice, allowing for the initialization of
the grid diagrams of the batch HEN (one grid diagram for each OC or TS).
MBC design guidelines aim at the optimal re-use of HEX area (units) across
time slices (i.e. the best possible way of utilising capital across time slices).
In conventional, the HEX units remain between the same two streams during
the operation of all OCs or TSs. As in the standard Pinch Design Method,
the placement of HEX matches begins at the pinch (the pinch matches, i.e.
matches present at the pinch, are the most difficult matches to place because
of the tight temperature driving forces in this region) and proceeds away. Priority should be given to HEX matches which are used in the largest number
of OCs or TSs.
The Combined supertargeting conventional design HEN design procedure
involves the following main steps [17]:
1. Identify the possible pinch matches, and select the match concerning the
largest number of time slices (build a Pinch Match Matrix ).
2. Determine the maximum possible area to be installed for this match (In
conventional design this is calculated per Operating Case or Time Slice
for maximum area that can be installed between each possible match
between an equipment with a hot stream and an equipment with a cold
stream [17]).
3. Place match on the time slice requiring the largest area (calculated assuming vertical heat transfer). In some cases, it might be beneficial to install a
largest area to form a tick-off match in order to minimize the total number
of units (either for the time slice under consideration, or for another time
slice).
4. Re-use the largest fraction of the installed area during the other time
slices, even if the maximum area calculated assuming vertical heat transfer
should be exceeded.
5. Verify the effectiveness of the placement adhering to the vertical model
by checking the driving force plot.
6. Apply the above steps for the other HEX matches, until the target temperature of every stream is satisfied during all time slices.
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7. Resort to relaxation based on loops and paths to improve the economics.Keep as much as possible the same structure across all OCs or
TSs.
When placing the matches, it is recommended to develop similar matches
structures in the different time slices in order to minimize the required number of valves and by-pass and to maximize the number of re-used matches. For
a conventional design, it is actually possible to use more than one common
match on each stream, a possibility which should be exploited[17].
The overall HEN is obtained by merging of the slice-wise HENs , and adding
the valves and by-pass to change the sequence of matches according to the
requirements of each time slice.
For a conventional design, the candidate matches should be placed in priority;
however, cases exist in which the prioritary placement of candidate matches
with both streams present at the pinch is not suitable. In these cases, the
selection of the most constrained matches is governed by the following additional priority rules (decreasing order of priority):
1. Candidate matches being pinch matches in the largest number of OCs.
2. Non candidate pinch matches.
3. Candidate matches not being pinch matches.
4. Non-candidate matches that appear (based on the analysis of the HEN
structure) to be re-useable because of similar HEN structure
5. Non-candidate non pinch matches.
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Single Batch Product Scheduling and EROP
Details

Scheduling Details
Schedules are used to configure the time dependency of either continuous or
batch processes. This step is important in ensuring the correct operational
times and the resulting operational costs are calculated.
Scheduling of Batch Processes
Batch processes that have a fixed and repeatable schedule are defined by the
time dependence of the individual streams according to their specific start
and end time. These start and end times define the existence time of each
stream relative to the other streams. A Gantt chart can be used to conveniently display the streams and see the individual time slices that are created.
These time slices represent time periods where direct heat heat recovery is
possible between the streams that are present. The following diagram illustrates the time dependence typical of a repeating single product batch
process:

Fig. A.29: Gantt chart of a single product batch showing the existence times of each
stream and the piece of equipment they are assigned to. Any equipment
pre-processing and post processing times are also shown before and after
each stream.
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The above diagram shows the relationship between the streams and there
relative position to each other in time. Of particular importance is that more
than one stream can belong to the same piece of equipment (e.g. in a reactor).
These streams are defined as non-flowing given they are contained in a single
vessel during their heating or cooling duration. Flowing streams represent
the more typical transfer of mass from one point to another such as in a
pipe. The duration of the single batch is defined based on the consideration
of the pre-processing or post-processing of the equipment items themselves.
Two types of duration are shown on the diagram and are defined as follows:
 BSD - Batch Stream Duration
 BPD - Batch Process Duration

The batch stream duration is determined by the existence times of the stream
themselves and define the time slices for direct heat integration. However, the
actual availability of each piece of equipment is limited by any pre or post
processing required for each batch giving an overall batch process duration.
The analysis of the single batch is important for heat integration; however, it
is often the case that the individual batches are overlapped to increase production. This overlap provides the possibility to transfer heat between different batches. As result, an equipment-wise repeat operation period (EROP)
can be identified representing a new set of time slices. The following diagram
illustrates a one day Base Production Cycle (BPC) consisting of four overlapping single batches and the resulting EROP that forms two times over the
1st, 2nd and 3rd stream-wise repeat operation periods (SROP). In addition,
equipment 2 is shown to be doubled (E2.1 and E2.2) due to the overlap in
time with itself based on the given BCD. This is not possible in reality and
as a result the second piece of equipment E2.2 has to be included.
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Fig. A.30: Example of the how the equipment-wise repeat operation period
(EROP) forms given a base production cycle (BPC) consisting of four
overlapping batches.

Equipment-wise Repeat Operation Period (EROP) in the PinCH Software
The PinCH software automatically calculates the EROP based on the amount
of overlap defined in the schedule. The key parameter to define the amount
of overlap is the Batch Cycle Duration (BCD), which is the time at which
the next batch starts after the previous batch has started. The following
diagram shows how a single product batch process that is overlapped in time
is visualized in the PinCH software. The equipment E2.1 is shown to have two
streams assigned to it. Given the amount of overlap of consecutive batches,
the situation arises whereby the pieces of equipment E1.1 and E2.1 overlap
with themselves in time. As a result, the software automatically increases
the number of pieces of equipment for E1.1 and E2.1 to two as would be
done in practice. The additional heat transfer area and operational costs are
accounted for automatically in targeting as the number of pieces of equipment
are increased.
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The startup and shutdown phases represent the time periods just before the
first EROP begins and just after the last EROP is complete. Since no overlap
occurs during these time periods no direct heat transfer between batches can
occur and typically hot and cold utilities would be used meet the process
requirements.
The operational costs of the startup and shutdown phases can be significant
if the number of base production cycles (BPC) are large. PinCH focuses on
just the repeated operation periods and does not account for the startup and
shutdown costs in the total cost. If the user would like to analyze the startup
and shutdown phases (i.e. time slice decomposition, composite curves, heat
recovery, cost, etc.) then each phase will have to be defined separately as a
single batch with a batch cycle time (BCD) large enough so that no overlap
occurs.
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Indirect Source and Sink Profile

The Indirect Source and Sink Profile (ISSP) is used to determine the indirect
heat recovery potential of a batch process. Indirect heat recovery is achieved
using intermediate loops (IL) and heat storages (HS) (i.e. there is no direct
heat transfer between any of the streams involved in the pinch analysis). This
allows the full energy content of a stream to be captured and potentially used
for heat recovery, regardless of when the stream occurs in time.
Unlike indirect heat transfer for continuous processes in which an intermediate loop can transfer heat between two streams, with the ISSP analysis heat
is always transferred as such:
Heat Source (Hot Stream) → Intermediate Loop → Storage → Intermediate
Loop → Heat Sink (Cold Stream)
There are several differences and considerations between the ISSP analysis
and the “classical” analysis. To provide an overview of the topic, these differences and considerations are listed next. Afterwards, each of the points will
be discussed in greater detail.
1. Time period of analysis and scheduling of the batch process
2. Representation of the ISSP in kWh
3. Formulation of the stream tables
4. Stream specific ∆Tmin s (or Time Slice CC specific ∆Tmin s )
5. Heat storage possibilities
6. Placement of the IL/HS; no HEN design required
For this section these items will be divided into the following two categories:
Constructing the ISSP and Thermal Energy Storage Design. Items one to
four will be discussed in Constructing ISSPs and five and six will be discussed
in the Thermal Energy Storage Design section. After reading the following
section, the significance of the ISSP and how they are constructed should
become clear to the reader.
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Constructing ISSPs

Time and scheduling of the batch process
The time period of interest for the ISSP analysis is normally the length of
one batch. However, there are two different approaches to constructing the
ISSP dependent on the type of scheduling of the process. The two types of
scheduling that affect the ISSP are fixed and variable scheduling:
 Fixed Schedule (the batch process strictly adhers to its schedule with
very little variation)
– The CCs are constructed for the individual time slices and these
curves are then used to construct the ISSP based on the cascade residuals derived from the GCC i.e. direct heat recovery and indirect heat
recovery are considered concurrently (see Section 9.4).
– This ISSP-GCC based graphic is not discussed in this section.
 Variable Schedule (the timing of the batch process and its streams can
change)
– All the streams involved in the analysis are included in the either the
source or sink profile.
– This ISSP-Stream based graphic is reviewed in detailed below.

Representation of the ISSP in kWh
The enthalpy content of the ISSP, like the Time Average Model (TAM),
is represented in kWh and not in kW. This is due to the streams being
represented in their entirety, regardless of the time the stream occurs, and
not for a specific moment in time.
Formulation of the stream table
The stream table for the ISSP is similar to the stream table for direct heat
transfer except with four alterations, which are listed next and can be seen
in Table A.11:
 Shifted Temperatures (T ∗ ) – The temperatures shown in the ISSP
stream table have been shifted (hot streams down and cold streams
up). This is discussed further in the section on ∆Tmin s .
 Mass – In addition to the mass flow of a given stream, the mass should
now also be shown. This can be calculated with:

ms = ṁs · (tend − tstart )

(A.1)
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ms
ṁs
tstart
tend

[kg]
[kg/h]
[h]
[h]

mass of stream s
mass flow of stream s
start time of stream s
end time of stream s

 Enthalpy Content – The enthalpy content of the stream is shown in
kWh and not in kW. This is calculated as follows:

Es = ṁs · cp, s · (Ts, end − Ts, start ) · (tend − tstart )

(A.2)

Combining A.4 and A.5
Es = ms · cp, s · (Ts, end − Ts, start )
Es
cp, s
Ts, start
Ts, end

[kWh]
[kJ/kg K]
[K]
[K]

(A.3)

energy content of stream s
specific heat capacity at constant pressure of stream s
the starting temperature of stream s
the ending temperature of stream s (As only the temperature difference is necessary, the shifted temperatures
can also be used to calculate the energy.)

 Stream specific ∆Tmin s – the last column on the right; it will be further
discussed next.

Table A.11 is an excerpt of the full stream table for the ISSP shown in Figure A.32.
Tab. A.11: ISSP Stream Table
Stream
C1
C2
H1
H2

∗
∗
Tin
Tout
m
ṁ
cp
α
tstart
[°C]
[°C]
[kg] [kg/s] [kJ/kgK] [W/(m2 K)] [h]
25.5 75.5 11’000 6.111
4.00
500
0.00
118.4 119.4 10’000 1.282
705.90
2’000
3.08
108.0 107.0 4’500 0.577
699.98
4’000
3.08
105.8 45.5 3’000 0.385
2.00
1’000
3.08

tend Energy ∆Tmin s
[h] [kWh]
[K]
0.50 611.2
15.5
5.25 1’960.8
3.4
5.25 -875.0
3.0
5.25 -100.0
4.2

Stream specific ∆Tmin s
The following discussion relates to the calculation of the stream specific
∆Tmin s .
Two important considerations regarding the temperature levels of the streams
involved in the ISSP are:
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 Each stream has been designated and shifted by a unique ∆T value
know as ∆Tmin s .
 The temperatures of the streams have been shifted by the ∆Tmin s value
either up for cold streams or down for hot streams.

Designating a specific ∆Tmin s to each stream in the analysis allows for an
objective, energetic comparison of all the streams. This is especially useful if
after the initial analysis it is decided that certain streams should be excluded
from the ISSP.
The formula for calculating ∆Tmin s is:
y

1
1
·
∆Tmin s = fp
ksk ds

(A.4)

∆Tmin s [K]
Temperature shift of stream s
fp
Constant of proportionality
ksk
[W/(m2 K)] Overall heat transfer coefficient between stream s and
IL k
ds
[h/a]
Duration of stream s within an EROP per year
y
[–]
Bandwidth exponent
The exponent y is chosen by the user and limits the range of the ∆Tmin s
values. A typical default value for y is ca. 0.9.
To calculate the constant of proportionality the following formula can be
used:
fp = M axs [(ksk · ds )y ] · ∆Tmin, ov

(A.5)

M axs [(ksk · ds )y ] The value of (ksk · ds )y is calculated for each stream. The
maximum of these values is then used to calculate fp .
∆Tmin, ov
This is the minimum ∆Tmin s value used in the ISSP. It
must be determined prior to calculating the constant of
proportionality and must be assigned to at least one stream.
The overall heat transfer coefficient k is calculated as follows (this is a simplified calculation):
1
ksk = 1
(A.6)
+ α1k
αs
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[W/(m2 K)] Heat transfer coefficient of stream s
[W/(m2 K)] Heat transfer coefficient of IL k

αs
αk

As stated previously the stream specific ∆Tmin s value allows for an objective
and energetic comparison of the streams. From Formula A.4 it can be seen
that streams with low heat transfer coefficients (low αs ) and short durations
(short ds ) will have a greater ∆Tmin s . Thus, these streams provide less heat
for IHR and therefore are of less benefit.
Constructing the ISSP
Once all the above information is known and the stream shifting has taken
place, the ISSP can be constructed. This is done analogously to constructing
the composite curves for continuous processes, however, the construction of
the ISSP takes place in the T, H diagram and not in the T, Ḣ diagram.
The combining of the hot streams makes up the Indirect Source Profile and
the combining of the cold streams makes up the Indirect Sink Profile. An
example of a constructed ISSP can be seen in Figure A.32.
Notes:
 The abscissa axis is in kWh and the ordinate axis shows the shifted
temperature.
 The ISSP is based on the Stream Repeat Operation Period (SROP)
and not the Equipment Repeat Operation Period (EROP). As a result,
the ISSP is from an energy perspective the same as the original batch
process without overlap. However, the design of the HESN schema and
associated HEX costs account for additional pieces of equipment as
shown on the HEN schema.
 The individual streams are added to the ISSP. These are indicated by
the red horizontal lines above the Indirect Source Profile and the blue
horizontal lines below the Indirect Source Profile. Each stream has been
named: For the hot streams the names are indicated by H1-H5 and for
the cold streams C1-C6.

The addition of these streams only indicate the shifted start and end
temperatures of the streams, they are in no way indicative of the energy
content of the streams.
To determine the shifted temperatures of the individual streams, simply
draw vertical lines from the end points of the arrows to the corresponding profile, i.e. hot streams to source profile and cold streams to sink
profile. An example of this can be seen in Figure A.32 for streams H5
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and C3 (see the black dashed lines). Thus, stream H5 has temperatures
∗
∗
∗
of Tin
= 64.5°C and Tout
= 14.5°C, whereas C3 has Tin
= 27.6°C and
∗
Tout = 90.6°C.
 When vertical sections of the ISSP are in contact with each other a
small minimum energy limit is assumed to avoid issues where the IL
calculation at boundaries where Ts and projections are at same enthalpy but not at same temperature (e.g. can result in HEXs shown
with HR = 0.001 kWh on HEN Schema).
T * / °C
H3
H4
H1
H2
H5

C2
C5
C6
C4
C3
C1

Energy [kWh]

Fig. A.32: Indirect Source and Sink Profile
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Thermal Energy Storage Design

Heat Storage Possibilities
As previously stated, the ISSP considers only indirect heat transfer with
thermal storages. This next part is a brief overview of the different types
of thermal storages that are available in PinCH. For storage possibilities a
distinction between two physical principles can be made:
 Latent Heat Storages – A phase change occurs in the storage medium.
Normally, solid ⇔ liquid or liquid ⇔ gas
 Sensible Heat Storages - The storage medium does not undergo a phase
change. Typically, solid or liquid mediums are used.

Pinch 3.2 allows for the integration of two types of sensible heat storages.
They are:
1. Stratified Storage (Figure A.33 (a))
2. Fixed Temperature Variable Mass (FTVM) Storage (Figure A.33 (b))
Stratified heat stores have the advantage that only one heat storage tank is
required per IL, whereas the FTVMs require 2 storage tanks per IL. This
leads to higher investment costs for the FTVM systems.
Due to technical reasons stratified storage tanks can only attain a limited
temperature difference between the top Thigh and the bottom Tlow of the
storage unit. FTVM systems can have a much greater temperature difference
between the hot tank Thigh and the cold tank Tlow than stratified tanks.
As can be seen in Figure A.33, both storage types are divided into two sides,
one for charging and one for discharging the storages. Also note that the
heat exchangers for both storages are only connected in parallel. A series
connection of the heat exchangers is normally not possible due to the nonsynchronicity of the streams in the batch process. This means that each
stream which contributes to the charging/discharging of an IL must be capable of heating the IL from Tlow to Thigh or cooling it from Thigh to Tlow .
Placement of the IL/HS; no HEN design required
The placement of the intermediate loops and heat storages takes place directly in the ISSP diagram. This eliminates the need to design a HEN, however, the placement of the ILs and HSs can still be complicated. Figure A.34
will be used to aid in the understanding of how to place the ILs and HSs.
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(a)

Thigh

Tlow

(b)

Thigh

Tlow

Fig. A.33: Sensible Heat Storages – Stratified & FTVM

The letters a-f indicate the regions in which the ILs and HSs can be placed.
The letters 1-5 indicate where the ILs and HSs in this example where actually placed. The black lines show the placement of the ILs with stratified
storage and the gray lines show the ILs with FTVM storages. In total five ILs
are required in this example. Assuming the black lines correspond to either
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stratified tanks or FTVM storages, this design results in five stratified tanks
or ten FTVM tanks (Note: It is possible to reduce the number of required
FTVM tanks i.e. the grey line, this will be discussed later).

Τ / °C
H3
H4
H1

5

f

H2
4

H5

e

3

d
2

c

1
C2
b
a

C5
C6
C4

C3
C1

Energy [kWh]
Fig. A.34: ISSP with Placed ILs and Heat Storages

The regions (a-f) can be determined based on the starting temperatures of
each stream that create temperature and enthalpy bounds. An underlying
algorithm (not described here) is used to determine regions or areas of applicability to place either a high or low temperature layer/tank (called assignment zones).The algorithm always ensures the minimum number of heat
storages are required for the given HR. The reader is referred to [19], [20]
and [21] for more information.
The placement of the ILs will first be discussed for the stratified storage
system (black lines) and then for the FTVM system (gray lines).
IL and Stratified Storage Placement:
 IL 1 – The cold temperature Tlow, 1 for IL 1 can be placed anywhere on
the vertical line of region a, i.e. region a is the temperature range in
which Tlow can be placed. The hot temperature Thigh, 1 can be placed
anywhere within the green area, which is region b. This allows the
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engineer to freely choose the energy content and Thigh, 1 , within the
constrains of region b, for IL 1.
 IL 2 – Tlow, 2 can be placed anywhere on the vertical line running
through Thigh, 1 in region b. Thigh,2 can be placed anywhere within region
c.
 IL 3 – Tlow, 3 is chosen in region c based on the same principles as Tlow, 2 .
The placement of Thigh, 3 has 0 degrees of freedom and must be placed
directly on point d.
 IL 4 – Both Tlow, 4 and Thigh, 4 have 0 degrees of freedom and are restricted to points d and e respectively.
 IL 5 – Tlow, 5 is restricted to point e. Thigh, 5 can be place anywhere on
the vertical line, which is region f .

Important: For both the stratified storages and FTVM storages, the temperatures of Tlow and Thigh for all the ILs corresponds to the actual temperatures
at which the ILs will be implemented. This is because all of the streams in
the source profile and sink profile have been shifted by ∆Tmin, s , i.e. a temperature gradient already exists between the ILs and the source or sink profiles.
This also means that the upper and lower temperature of an IL can be placed
directly on the source or sink profile and still be valid (IL 4 in Figure A.34 is
an example of this).
IL and FTVM Storage Placement:
The placement of ILs with FTVM storages follows the same stipulations as
for ILs with stratified storages. However, with the correct placement of the
upper and lower temperatures of the individual ILs, the number of required
FTVM tanks can be reduced, which also reduces the economic costs for
FTVM systems. This can be accomplished by setting the upper temperature
of an IL and the lower temperature of the next consecutive IL equal to each
other (i.e. Thigh, n−1 = Tlow, n ). In this way one FTVM tank can be shared
between two consecutive ILs and thus reduce the number of required storage
tanks.
As an example, if in Figure A.34 the upper and lower IL temperatures were
set such that Thigh, 2 = Tlow, 3 , Thigh, 3 = Tlow, 4 and Thigh, 4 = Tlow, 5 , then the
number of required FTVM tanks could be reduced from ten to six as shown
by the grey line.

